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CHAPTER 1 - ELECOSOFT POWERPROJECT AND PENNDOT 

1.0- OVERVIEW 

The purpose of this manual is to give Department staff and Business Partners specific direction on how 
the Department expects them to use the Elecosoft Powerproject Web Portal and Elecosoft Powerproject 
Client along with some basic knowledge of scheduling and utilizing Elecosoft Powerproject Client, 
Elecosoft Powerproject Web Portal, and Elecosoft Powerproject Project Comparison as a project 
management tool.  

The Elecosoft Powerproject Web Portal is a web-based collaboration portal that allows users to create, 
view, and update Elecosoft Powerproject schedules over the Web. The purpose of the Elecosoft 
Powerproject Client software is to create the actual schedule.  Elecosoft Powerproject Project Comparison 
allows users to compare two iterations of the same schedule and will easily determine what has changed 
or been modified between the two schedules and displays a report of the findings.  

This manual provides insight on what is needed to create, manage and progress a PennDOT schedule 
using the Elecosoft Powerproject Web Portal and Elecosoft Powerproject Client.  The Elecosoft 
Powerproject Web Portal and the Elecosoft Powerproject Client serves as the central entry point of data 
into the PennDOT Environment.  Each user will be responsible for their individual projects within the 
confines of PennDOT specific requirements.  It is the responsibility of all Business Partners to verify and 
keep up to date the Department’s version of Elecosoft Powerproject that is in use. 

1.1- ELECOSOFT POWERPROJECT AND PENNDOT 

The Pennsylvania Department of Transportation (PennDOT) uses Elecosoft Powerproject, a project 
management software package, to help oversee and manage its highway and bridge program. Elecosoft 
Powerproject plays a crucial role in the delivery of this program because it: 

• Enhances the ability to plan and manage highway and bridge projects 

• Supports project management and reporting at both the project and portfolio 

levels 

• Provides Historical Data Management and Analysis 

1.1.1- Design.  PennDOT maintains a standard design template to be used in the creation of a 
project design schedule.  This design template, the PennDOT Master Template, contains a master list 
of standard design activities and their required coding for PennDOT design projects. The PennDOT 
Master Template is available in the Elecosoft Powerproject Web Portal or in the template folder 
within the Elecosoft Powerproject  Client software PennDOT version.   Any design schedule created 
for PennDOT must use the PennDOT Master Template, or one of the district specific templates 
created from the PennDOT Master Template template.  In this manual, PDSMASTER and or 
PDSMASTER template will refer to the current PennDOT Master Template design template residing 
in the Elecosoft Powerproject Web Portal. 
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The ideal time for design schedules to be created is within one month of the scoping field view. 
However, since the project development process may contain factors which can generate a lag in the 
start of the major design activities, the design schedules must be developed in a timeframe 
commensurate with their complexity. Minor projects should have a design schedule developed no 
later than two months from the approved scoping form date. Major and moderate-complexity projects 
should have a design schedule developed no later than six months from the approved scoping form 
date. In all cases, the design schedule development must be completed prior to the physical start of 
any schedule activities.   

1.1.2- Pre-Bid.  PennDOT maintains a standard pre-bid template to be used in the creation of all 
Pre-bid schedules.  This template, the PennDOT Pre-bid Template, contains a list of pre-bid activities 
and also specific views. The PennDOT Pre-bid Template is available in the Elecosoft Powerproject 
Web Portal or in the template folder within the Elecosoft Powerproject Client software PennDOT 
version.   Any Pre-bid schedule created for PennDOT must use the PennDOT Pre-bid Template.   

1.1.3- Construction.  PennDOT maintains a standard construction template to be used in the 
creation of all CPM Construction schedules.  This template, the PennDOT Construction Template, 
contains a list of sample activities and also specific views pertaining to construction and monitoring. 
The PennDOT Construction Template is available in the Elecosoft Powerproject Web Portal or in the 
template folder within the Elecosoft Powerproject Client software PennDOT version.   Any 
Construction CPM schedule created for PennDOT must use the PennDOT Construction Template.   

1.2-  ELECOSOFT POWERPROJECT LICENSE 

All internal PennDOT staff will have access to an Elecosoft Powerproject license.  If Elecosoft 
Powerproject is not installed on an internal PennDOT staff’s computer, a request for the software must be 
made to the Project Schedules, Specifications, and Constructability Section in the Bureau of Project 
Delivery.  For Business Partners who do not have a licensed copy of Elecosoft Powerproject, a license 
can be requested from PennDOT.  This license will be good for 90 days, until the schedule is created, 
submitted, and accepted by the Department.  The loaned license can be renewed after the expiration 
period if deemed necessary.  See Chapter 7 for guidance on how to request and activate a loaned license.
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CHAPTER 2 - SCHEDULING BASICS 

2. 0- INTRODUCTION TO PROJECT MANAGEMENT 

The key to Project Management is to have a project be on time and within budget.  Project management 
involves organizing and scheduling tasks in a required sequence so that a project is completed in a 
specified time period.  Project Management also involves allocating resources to complete the project 
activities without exceeding a project budget.   

Project Management is the coordination of a group of activities where the manager plans, organizes, 
staffs, directs and controls to achieve an objective within constraints on time, cost, and performance of the 
end product. 

Managing a project includes identifying requirements, establishing clear and achievable objectives, 
balancing competing demands for quality, scope, time, and cost, and adapting the specifications, plans, 
and approaches to the different concerns and expectations of stakeholders. 

2.0.1-  What is a Project? 

A Project is a temporary endeavor undertaken to create a unique product, service, or result.  
Temporary means there are definite beginning and end points.  The end is reached when the 
project’s objectives are accomplished or when it becomes apparent that they will not, or 
cannot, be accomplished.  Unique means that the project produces a quantifiable product, 
either an end item or component, the capability to perform a service, or a result (such as 
knowledge). 

2.0.2-  Processes of a Project Manager 

Planning is a process to prepare and organize activities to achieve the desired goal.   

Reasons to undertake project planning: 

• Eliminating or reducing project risk, 
• Obtaining a thorough understanding of the project’s objectives, 
• Formulating a strategy to attain those objectives, and 
• Developing a monitoring framework to measure progress. 

 
Controlling is a process or management to achieve the desired result.  It is concerned with the 
metrics of the project, such as scope, time, cost and resources.   

Unanticipated problems can occur on any project. Having the tools to make informed 
adjustments for them is the key to controlling a project. A scheduling system will provide the 
project manager with adequate information to respond to problems in a timely manner. The 
CPM Process provides the manager factual information to respond in a timely manner to 
every impact to the schedule by using the network diagram and Monitoring Chart to identify 
the impact and adjust accordingly. 
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2.0.3-  What is the need for a schedule? 

Having a good schedule will ensure adequate planning and execution of the work to be 
performed.  The schedule should be prepared by the individuals who are going to be using the 
schedule. If a schedule does not involve key personnel who are going to be building the 
project it is less apt to be followed.  

The proper preparation and use of construction schedules can reduce delays, cost overruns 
and disputes. Scheduling is the determination of the timing of activities. The use of CPM 
scheduling will help to define expectations and has proven to be effective in assessing actual 
vs. planned performance. CPM Scheduling and the use of a Monitoring Chart will provide 
factual information to identify and deal with problems as they arise and will assist managers 
in making timely decisions about project completion. Understanding the CPM Schedule and 
using it as a tool to document and track performance will enable managers to analyze project 
delays, impacts of work order changes, and will help avoid delay claims. 

2.1- REVIEWING SCHEDULING TERMINOLOGY 

Network:  It is a graphical representation of a project plan, in which the project logic is the sole 
determination of the placements of the activities in the drawing.  A network diagram shows a group of 
interrelated activities. 

• The network diagram shows each activity and its relation to every other activity 
in the project, the project’s critical path, and the expected end workday for the 
project. 

 

 

2.1.1-  Schedule:  The addition of activity durations to a network and computation of start and 
finish times of activities produces a project schedule. It lists project’s milestones, activities and 
deliverables.   
2.1.2-  Activity:  A portion of a project which consumes resources and has a definite start and 
finish are incorporated in the network.  Any definable or time consuming operation, task, function, or 
time limited condition.  Establishing a time frame or duration for each task turns each into an activity. 
2.1.3-  Activity ID / Description:  A unique alphanumeric characters to identify activities and 
list its description. 
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2.1.4-  Calendar:  Defines the working days and hours during which tasks can be scheduled. 

With a known start date, the calendar consecutively numbers all days within a projects time span that 
work can be done. 

2.1.5-  Original Duration:  Total estimated time required to complete the activity. 
2.1.6-  Remaining Duration:  The required time for completion of an activity from a status date.  
2.1.7-  Milestones:  A point in time to represent the beginning or end of a project phase or to 
communicate project deliverables.  Milestones are included in schedules to mark a particular point in 
time for references or measurement.  

A milestone has a zero (0) duration and does not consume any resources.  There are three types of 
milestones: Start Milestone, Finish Milestone, and an Interim Milestone. 

2.1.8-  Relationships:  Are logic ties between project activities to depict a project plan.   

There are four types of relationship that can be used in a project schedule: 

• FS = Finish to Start (PennDOT Construction standard) 
• SS = Start to Start 
• FF = Finish to Finish 
• SF = Start to Finish 

 
Relationships between activities generates a network logic diagram to represent activities in a 
project and their logical sequence. 

Finish to Start (FS):  The successor cannot start until the predecessor is completed. 

For example, it means merely that the pour can start after the Set-up Forms is complete, not that it 
must. 

 

Start to Start (SS):  The successor cannot start until the predecessor has started. 

For example, Install New Home Air Conditioner can start when Take Vacation starts. 
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Finish to Finish (FF):  The finish of the successor depends on the finish of the predecessor. 

For example, I want the contractor to finish the installation of the new cooling system before I 
finish my vacation. 

 

Start to Finish (SF):  The successor cannot finish until the predecessor has started. 

For example, the generator cannot be turned off until the predecessor, ‘resume grid electric 
power’ has started. 

 

2.1.9-  Lag:  A delay between a task and its predecessor. 

A finish-to-start with lag means that some time must pass between the completion of the 
predecessor and the start of the successor.   

For example, after concrete is poured there is a lag time between when the forms can be removed. 

 

A finish-to-finish with lag means that some time must pass between the completion of the 
predecessor and the completion of the successor.   

 

2.1.10- Lead Time:  An overlap between a task and its predecessor.  

A finish-to-start with lead (negative lag) relates the completion date of the predecessor to the start 
date of the successor but requires an amount of overlap or ‘lead’ specified in terms of how much 
the successor overlaps the predecessor. 

For example, the start of Revise Design can overlap the completion of Review Design. 
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A finish-to-finish with lead (negative lag) relates the completion date of the predecessor to the 
finish date of the successor. 

 

 

2.1.11- Early Dates:  Early dates represents the earliest an activity can start/finish based on the 
project plan. These dates are calculated in the forward pass when a project is rescheduled. 

Early Start (ES): The earliest date an activity can start. 

Early Finish (EF): The earliest date activity can finish.  

2.1.12- Late Dates:  Late dates represent the latest dates on which an activity can start and finish 
without delaying the project plan.  These dates are calculated in the backward pass when a project is 
rescheduled. 

Late Start (LS):  The latest date an activity must start to meet the schedule completion.  

Late Finish (LF):  The latest date an activity must finish to meet the schedule 
completion.  

2.1.13- Total Float (Slack): The number of days an activity can be delayed without effecting the 
critical path. 

It is the difference between early and late start or early and late finish dates of an activity.   Total float 
is shared with the other activities along the same path through the network and does not belong to a 
single activity. 

Total Float = LF – EF = LS – ES 

2.1.14- Free Float: The number of days an activity can be delayed without affecting the subsequent 
activity.  It is the difference between the activity’s early finish time and its successor’s early start 
time.  Free float is calculated by subtracting the Early Finish date of the activity from the Early Start 
date of the successor activity. 

FF = ES of successor Activity – EF of current Activity 
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2.1.15- Critical Task: A critical task must be 
completed on time in order to complete the project on 
schedule.  Activity on the critical path or an activity with 
no float.  NOTE: Might affect an interim milestone 
without effecting the end date. 
2.1.16- Critical Path:  The project’s critical path is 
the single longest chain of activities through a schedule.  
It determines the earliest time that the project can be 
completed. 

Critical path activities will have equal early and late 
dates if no constraint dates are set on the project. 

Activities with zero total float are critical activities if 
no constraint dates are set on the project. 

If a constraint date is placed on the project, the 
critical path activities will have the least float 
(lowest positive or most negative) in the schedule. 

Activities with negative float indicates that the project is delayed (behind schedule).   
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2.1.17- Noncritical Task:  A noncritical task may be delayed to some extent without affecting the 
project’s completion date.   

 A noncritical task has positive float. 

2.1.18- Constraints:  provide an additional functionality to project plan to reflect project situations 
that is dependent on specific dates.  

Start On or After Constraint:  An activity cannot start earlier than constraint date.  

Start On Constraint:  An activity will start on the constraint date. 

Finish On or Before Constraint:  Activity cannot finish later than constraint date.  

Finish On:  An activity will finish on the constraint date.   

2.1.19- Progress Period:  A particular time slice during which progress is reported. 
2.1.20- Reschedule:  The reschedule is the progress that performs critical path calculations on the 
project to work out the logically correct position of tasks and links. 
2.1.21- Baseline:  The baseline is a snapshot of the schedule for a project used for comparison 
purposes as actual information develops and is added to the project. 
2.1.22- Redundant Relationship:  A relationship representing a link between activities that is 
also represented in a parallel path or relationship. Redundant relationships can be removed without 
impacting the logic or calculations of the schedule and may add unnecessary complexity to the 
schedule and hinder review and analysis.  
2.1.23- Resource: The labor and equipment required by an activity and needed to perform the work 
of the project.  

2.2- SCHEDULING TYPES AND METHODS 

There are three different types of methods of scheduling: 

• Arrow Diagramming Method (ADM) 
• Program Evaluation and Review Technique (PERT) 
• Precedence Diagramming Method (PDM) 

o Critical Path Method (CPM) 
 Activity on Arrow 

 
Depending on what method is used to represent schedules will determine how the schedule is calculated. 
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2.2.1- Arrow Diagramming Method (ADM):  In this method, activities are represented by 
arrows.  The ADM only indicates finish-to-start relationships.  ‘Dummy tasks’ are added to represent 
task’s dependencies.  This method is also knows as Activity on Arrow (AOA) Method. 

 

 

 

2.2.2- Program Evaluation and Review Technique (PERT):  The method provides 
statistical analysis for duration of activities using optimistic time, pessimistic time, and most likely 
time.  It calculates float and critical path from activities on a network.  This is most often used on 
research and development projects. 

 

 

 

 

 

 

 

10 

20 

40 

30 



Chapter 2: Scheduling Basics  Publication 615 

 2-9  

2.2.3- Precedence Diagramming Method (PDM):  In this method, activities are represented 
by boxes or nodes.  This method identifies critical tasks, noncritical tasks, and float values.  This 
method also allows different types of relationships between tasks.  This is the most commonly used 
method by software programs.  This method is also knows as Activity on Node (AON) Method. 

By using PDMs, users can determine the activities critical to the project schedule. This is known as 
the Critical Path Method (CPM). 

 

2.2.4- Critical Path Method (CPM):  The critical path method uses activity durations, 
relationships between activities, and an assigned calendar to calculate the schedule dates.  This 
method determines the longest continuous path of activities through the project, aka critical path.  
This is the most commonly used method to calculate project schedule and determine the minimum 
project duration. 

CPM Schedule components include: 

• Activity ID (alpha numeric values) 
• Activity Description 
• Activity Duration (in calendar days) 
• Calendar Assignment 
• Relationships 
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Uses activity durations and relationships between activities to calculate schedule dates.  

 

Activity on Arrow Diagrams can be a form of a CPM schedule that PennDOT construction personnel are 
used to dealing with.  Below is an example of what an Activity on Arrow Diagram looks like: 

 

In the past, construction schedules may have been hand drawn on paper to look like this.  In practice this 
is still acceptable to do prior to entering it into Elecosoft Powerproject or an Elecosoft Powerproject 
compatible software. 
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Calculations are done in two passes – forward and backward – through the activities in a project.  

• Forward Pass:  Sequentially adding activity durations to determine early start 
and early finish dates.   Network schedule calculation that determines the earliest 
time each activity can start and finish as well as the minimum overall project 
duration. 

• Backward Pass:  Sequentially subtracting activity durations to determine late 
start and late finish dates.   Network schedule calculation that determines the 
latest each activity can start or finish and still maintain the minimum overall 
duration of the project as calculated by the forward pass. 

Calculations are performed using the durations assigned to activities which have assigned calendars based 
on a start and end time.  

 

2.3-  SCHEDULE CALCULATIONS – TIPS 

When performing CPM calculations, make sure the activity relationships are identified.  Take note of 
activities that are not finish to start relationships and also activities with lead or lag time.  Activities with 
constraints also have to be taken into account. 

Calculations should start with the forward pass on the first activity of project schedule.  This means that 
the forward pass should progress from left to right as in start to finish of the project.  

The first activity begins on Day Zero (0). 

All calculations should be moving towards the right, in an up and down motion in strips (to avoid 
unnecessary iterations).   
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CHAPTER 3  - PROGRAM OVERVIEW 

3.0- INTRODUCTION TO PROJECT PLANNING AND SCHEDULING  

The use of Critical Path Method (CPM) scheduling and a daily update chart provides factual information 
that can be used to defend construction delay claims. The implementation of critical path planning and 
scheduling has resulted in a drastic reduction of the number and dollar value of construction claims filed 
against the Department. 

The proper preparation and use of construction schedules can reduce delays, cost overruns and disputes. 
Scheduling is the determination of the timing of activities. The use of CPM scheduling will help to define 
expectations and has proven to be effective in assessing actual vs. planned performance. CPM Scheduling 
and the use of a Monitoring Chart will provide factual information to identify and deal with problems as 
they arise and will assist managers in making timely decisions about project completion. Understanding 
the CPM Schedule and using it as a tool to document and track performance will enable managers to 
analyze project delays, impacts of work order changes, and will help avoid delay claims. 

3.0.1- Project Planning and Scheduling.  Improvements to project planning and scheduling 
have been identified as one key area where managers can improve services, manage their operations 
more effectively through improved communications, and provide factual information to resolve 
disputes and avoid legal claims. 

Project planning and scheduling involves all aspect of project development from final design up 
through the completion of construction. The process involves a coordinated effort between design and 
construction personnel to insure a timely completion of proposed improvement projects. The 
development of a Pre-bid construction schedule is initiated in the final design process and is 
completed after the plans and specifications have been finalized. The development of a Pre-bid 
schedule is a key element in the constructability review process and also is used to establish a realistic 
required completion date for the contract documents. A major benefit to the development of the Pre-
bid schedule is improved communications between design and construction personnel.  For more 
information regarding Pre-bid schedules see Chapter 5. 

Implementation of these improved project management processes will result in more realistic 
construction completion dates through the development of a Pre-bid construction schedule as part of a 
constructability review process. The improved project management process will also greatly improve 
claim avoidance during the course of construction through the effective monitoring of the contractor’s 
schedule. 

3.0.2- Project Management Defined.  Any discussion of the critical path method must start 
with an understanding of project management. Project management is a process of achieving a 
project’s objectives. Its purpose is to reach the project’s goals and objectives within the allotted time 
frame, budget constraints, and quality standards. Project management is applicable to projects with a 
fixed end date, and specific goals and objectives, such as highway/bridge projects. 

3.0.3- Project Management Functions.  Project Management is made up of four key functions: 
plan, schedule, monitor and control.  Planning must be separated from scheduling. 
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3.0.3.1- Planning.  A knowledgeable project team plans the execution of the project. They 
determine what needs to be done, by whom and how project objectives are to be met. In short, 
they establish a predetermined course of action to take within the given constraints.  Planning is a 
process that establishes the interdependencies and interrelationships between each task within the 
project. 

• Reasons to undertake project planning: 
o Eliminating or reducing project risk, 
o Obtaining a thorough understanding of the project’s objectives, 
o Formulating a strategy to attain those objectives, and 
o Developing a monitoring framework to measure progress. 

 
3.0.3.2- Scheduling.  Scheduling means to determine when a specific activity or work must 
be started and completed. The tools used to accomplish this can be as simple as a narrative 
schedule or as complex as a CPM schedule. 

 
3.0.3.3- Monitoring.  Using the project schedule as the standard for tracking daily work 
ensures that the project’s goals are being met. The monitoring process will document where 
delays take place, how long those delays may be, and what effect they may have on subsequent 
tasks. Monitoring means to track and document work activity, time, resources, and budget. 

 
3.0.3.4- Controlling.  A well-planned and executed project schedule gives the project 
manager a useful tool for making adjustments if unanticipated problems occur. The most 
important thing a project manager can do with any scheduling system is to use it to respond to 
adverse impacts. In addition, a detailed project schedule allows the project manager to anticipate 
and adjust for future impacts that may be caused by current project events. The Critical Path 
Method (CPM) allows the manager to respond to every disruption to the schedule using Elecosoft 
Powerproject and the Elecosoft Powerproject Web Portal along with the Monitoring Chart to 
identify impacts and make adjustments. 

3.0.4- Project Management Objectives.  The primary objective of any formal project 
management process is to raise the level of efficiency of each of the following project disciplines. 

3.0.4.1- Time Management.  Project managers must properly manage time to avoid 
schedule slippage and cost overruns. 

 
3.0.4.2- Resource Management.  Proper planning and scheduling of labor, material, and 
equipment will ensure that needed resources are at the project site at the correct time. If resources 
arrive too soon they will become costly to store, and if they arrive too late, they will impact the 
schedule. Resource management can provide a structured framework to analyze and balance 
resources. 
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3.0.4.3- Quality Management.  Quality levels for the completed project must meet all the 
requirements called for in the project’s contract documents, plans, and specifications. Proper 
project management will help ensure that there is enough time to perform the contracted work 
while meeting quality standards. It will provide sufficient time to procure materials and necessary 
equipment, and ensure that activities do not affect construction quality. 

 
3.0.4.4- Risk Management.  A well-defined, planned, and executed project management 
process can reduce uncertainty by helping to identify risks. Organized and disciplined daily 
updating and monitoring of the project can also provide advanced warning of potential risks. 

3.0.5- Project Management Stakeholders 

3.0.5.1- The Project Manager.  The role of project manager can be very demanding—it’s 
not difficult, but it requires constant attention to detail. The manager must be completely 
familiar with the project’s contract document, plans, specifications, and standards. The 
manager must have knowledge of construction, work sequencing, resources, capabilities, 
durations, and monitoring. 

 
The manager must establish and conduct project-scheduling meetings with the entire 
project team. The team will report on job progress to-date, review short-range and 
long-range scheduling goals, and review material delivery and approval requirements. 
 
With the help of the project team, the manager should have the ability to recognize 
impacts to the schedule beforehand, reschedule around anticipated impacts, minimize 
costs and/or delays to the project due to unavoidable impacts, and continue to monitor 
and maintain the work performance history. 

 
3.0.5.2- The Inspector.  The construction inspector is the owner’s authorized representative 

assigned to make inspections of contract performance and of material furnished for the 
project. The construction inspector has the responsibility of monitoring progress, and 
approving or disapproving each major step of the project. 

 
3.0.5.3- The Designer.  The designer is responsible to furnish all plans, specifications & 
estimates (PS&E) for the proposed project. The designer is also responsible for providing the 
project team with the information necessary to prepare a Pre-bid construction schedule to help 
evaluate the constructability of the project and to determine the required completion date of the 
project. 

 
3.0.5.4- The Legal Department.  The schedule monitoring system must provide the Legal 
Office with a clear documentation of any changes that have taken place and a clear audit trail of 
the agreed upon changes to help in the defense of construction claims. 
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3.0.5.5- The Contractor.  The contractor is responsible for the construction of the proposed 
project. The contractor is also responsible for providing a realistic construction schedule that 
identifies the resources and work activity interdependencies necessary to complete the project by 
the required completion date. 

 
3.0.5.6- The Utilities and Other Service Providers.  The utility companies and service 
providers such as transit companies and school bus providers play an important part in the 
development of the Pre-bid construction schedule. Proper and timely participation and 
coordination with the project manager and project team is necessary to successfully complete a 
realistic Pre-bid construction schedule. 

 
3.0.5.7- Consultants – Design, Management and Inspection.  The Department uses 
consultant services for project design as well as construction management and construction 
inspection on many projects. Consultants are responsible for providing the same service and 
expertise that the Department employees provide for design, management and inspection on any 
specific project. 

3.0.6- Relationships: Teamwork and Communication 

3.0.6.1- The Owner and Builder Relationship (Teamwork).  The Department is in an 
Owner/Builder relationship with the construction contractor. As the project’s owner, the 
Department’s responsibility in the relationship is to produce all necessary plans, specifications 
and estimates (PS&E) for the project. This includes but is not limited to materials, site conditions, 
and completeness of plans. 

The builder of the facility is determined by competitive bidding, usually the contractor with the 
lowest responsible bid. That contractor’s responsibility in the relationship is to supply all 
necessary resources, maintain production rates and complete the work as specified by the required 
completion date. The builder also has a responsibility to notify the owner in a timely manner of 
any and all changes to the project that impact the builder’s ability to complete the project as 
contracted. 

The owner/builder relationship must be built on teamwork and two-way communication in order 
to bring about a successful completion of the project. Teamwork underscores the need for all 
workers to understand their role in the project, and a willingness to subordinate personal 
prominence to overall efficiency. Uninterrupted communication, both vertical as well as 
horizontal, is crucial to keeping any project on track. Skillful project management requires the 
ability to document day-to-day performance both verbally and in writing, and the willingness to 
respond to problems and seek remedies as soon as they arise. 
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3.0.6.2- Communication.  Good Communications are critical to maintaining effective 
relationships. Communication is a very important link to the successful completion of any 
project.  Communication is much more than the spoken word or the skill of listening.  
Communication, especially in the owner/builder relationship, means writing letters, memos or 
Notes to document approvals, acceptance, concerns, problems, information, work performance, 
changes, instruction, directions, orders, etc. 

3.0.7- Planning and Scheduling Process.  At the beginning of most projects, all that is known 
is the project objectives and goals, and desired end-dates. In general terms, meeting those goals 
within the time allotted means establishing an effective project management process by taking the 
following steps. 

3.0.7.1- Identify Project Activities.  This step requires the aid of someone with detailed 
knowledge of what is required to accomplish the desired project goals. That person must be able 
to review the project’s plans and specifications, and be able to determine what must be done at 
each step in the project’s process to meet the goals. The result will be a list that identifies each of 
the individual project activities (tasks). 

 
3.0.7.2- Estimate Activity Durations.  An estimated duration based on the anticipated 
labor, material, and equipment, as well as expected site conditions, is assigned to each of the 
activities. These durations are used for scheduling and controlling day-to-day work. Historical 
records of projects are reliable sources of information to obtain activity durations. 

 
3.0.7.3- Develop the Project Plan.  Before the project schedule can be displayed 
graphically, it is necessary to establish the order that activities must occur in relationship to other 
activities (interdependencies). In any project, there are some activities that must be completed 
before other activities can begin. That is, the scheduler has to begin by identifying, what activity 
must be done first, what must be done next, and what can be done at the same time. The 
identification of the order that activities are to occur determines if the project can be constructed 
as designed. 

 
3.0.7.4- Schedule Project Activities.  With a project start-date and activity durations 
assigned, it’s possible to calculate and assign the required start and end date for each activity. 
Those dates, combined with each activity’s expected duration, will provide the project manager 
with an idea of where and when resources must be used. It is this schedule that will be used as a 
basis for controlling work and the allocation of resources during construction. This schedule will 
also be used to identify realistic milestone dates and the project completion date. 

 
3.0.7.5- Monitor the Schedule.  This involves monitoring and documenting all work 
activities including the identification of days worked and days not worked. This effort documents 
production delays and gains and activity start delays and gains. 
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3.1- CRITICAL PATH METHOD (CPM) 

3.1.1- CPM – A Scheduling Tool.  CPM is a complete planning and scheduling tool that uses a 
graphical display of the planned sequence of project activities to show their interrelationships and 
interdependencies.  

It is a technique that requires a breakdown of the entire project into a series of individual tasks (activities) 
and an analysis of the time duration required to perform each task. 

A project’s critical path is the longest activity path through the project that establishes the overall project 
duration. It is composed of a continuous chain of activities with no float. All activities on the critical path 
must start and finish on their planned early start and finish times – delay of a critical activity will result in 
the overall project duration being extended.  

3.1.1.1- Concept of Precedence.  The concept of precedence assumes that any succeeding 
activity cannot start until the prerequisite or preceding activity is complete. For example, you 
can’t pour the concrete for a wall until the footings are in place. Digging the footings is the 
precedent activity to pouring the concrete. Likewise, pouring the concrete is the successor to 
digging the footings. The combination of all the predecessor and successor relationships among 
the project activities forms the project network. 

 
3.1.1.2- Concurrent.  Unrelated activities can proceed concurrently and can run independent 
of each other. 

 
3.1.1.3- Multiple Successors.  An activity can have more than one successor. 

 
3.1.1.4- Multiple Predecessors.  An activity can have more than one predecessor. 

3.1.2-  CPM Monitoring and its Advantages.  A Monitoring Chart is used for daily 
monitoring of every CPM and Resource Loaded CPM Schedule by using a bar chart format to display 
the progress of each activity.  

The actual day-to-day progress of every activity is then plotted on the Monitoring Chart, with marks 
signifying each day when work is done, reasons for delays when work is not done, when the activity 
is actually completed, and any necessary adjustments for each succeeding activity. 

Making use of the Monitoring Chart as a tracking tool to monitor project status and document delays 
is a very effective tool for determining the causes and responsibilities for delays and cost overruns. If 
the chart is faithfully updated, project managers have factual information to resolve project disputes 
and contractor’s legal claims and it becomes a basis to make payments when they are justified. 
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Advantages: 

• Improved organization and display for projects with large number of activities. 
 

• Provides litigators with a graphical portrayal of the as planned comparison, to the 
as built project schedule, necessary for defense of claims. 
 

• Provides a method for making time extension decisions, when the project is 
impacted by work orders or any unforeseen changes. 
 

• Assist in the analysis of projects prior to letting to determine realistic milestone 
and project completion dates. 
 

• Helps communicate the construction plan and lets everyone know when they are 
expected to start and finish their tasks. 
 

• Establishes production goals and provides the framework for scheduling and 
planning the day-to-day work at the construction site. 
 

• Monitors and measures progress and establishes the baseline against which the 
current status of the project can be compared to determine if it is ahead or behind 
schedule. 
 

• CPM can be used to manage change by identifying the impact of an unexpected 
event or condition to allow the plan to be revised accordingly. 

3.1.3-  CPM Forensic Scheduling Overview.  The use of CPM scheduling and the Monitoring 
Chart is an important tool that will enable managers to provide construction related support needed 
for defense preparation and presentation of legal claims. The monitor/daily updated chart provides a 
graphic schedule analysis that is very understandable to the layman and very effective in the defense 
of construction claims. 

The forensic CPM analysis is an investigative tool that attempts to determine the who, what, when, 
where, and why facts concerning delays to the project completion. This information is presented in 
the graphic form of the Monitoring Chart and enables the manager to prepare a factual description of 
the comparison between the as-planned and the as-built schedule. This information can be used to 
defend against claims and/or as a basis to justify or reject a time extension to the required completion 
date and/or milestone dates. 
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CHAPTER 4 - DESIGN POLICY 

4.0- INTRODUCTION 

All project design schedules prepared for the Pennsylvania Department of Transportation (PennDOT), 
will be prepared and maintained using the project management software and release currently in use by 
PennDOT. It is the responsibility of the design firm(s) to verify the software in use. 

4.1- PURPOSE 

The purpose of this policy is to identify the requirements of how a design schedule will be prepared and 
maintained during the life of a project as to assure uniformity for PennDOT. 

A design schedule is required to plan the project scope into a time sequential process that will: 

• Deliver a complete project package for bidding within a defined time. 

• Coordinate the various design requirements to minimize delay. 

• Identify potential project issues/delays and minimize their impact. 

• Account for obstacles and scope changes during the project life and any required 
changes 
 

• Measure the progress and status of the design process during the life of the 
project. 

4.1.1- Project and Schedule Requirement.  PennDOT identifies projects as: 

• Most Complex (Major) 

• Moderately Complex 

• Non-Complex (Minor) 

For the purpose of this design schedule policy, any project that is defined as Most Complex (Major) 
or Moderately Complex is required to have a design schedule created and monitored for the life of the 
project. For those projects that are within the definition of Non-Complex (Minor), Table 4.1 specifies 
the requirements for a design schedule. 

Emergency design projects, those that may result from a natural (e.g., flood) disaster or unforeseen 
incident (e.g., vehicle crash), will not require a design schedule due to the urgent nature of repairs or 
replacement. 
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Table 4.1 – Non-Complex (Minor) – Schedule Requirements 
 

Project  Schedule 

Bridge Replacement Required 

Bridge Rehab/Repair (TIP funded) Required 

Pavement Preservation (TIP funded) Recommended 

Betterments (no ROW/no permits/no utilities) (TIP funded) Recommended 

Betterments (ROW/permits/utilities needed) (TIP funded) Required 

Transportation Alternative Projects (excluding Transit) Required  

District-Wide Program Projects (RPMs, Guide rail, Line painting, etc.) Not Required 

Grade Crossing (when not part of a highway project) Not Required 

ITS only (camera and/or VMS/DMS installation) Not Required 

Maintenance Funded Paving Projects Not Required 

Maintenance Funded Bridge Projects Recommended 

Department Force Bridge/Boxes/Culverts Recommended 

Any project that  all pre-construction phases can be completed within 4 
months 

Not Required 

HSIP Project (no ROW/no permits/no utilities) Not Required 

HSIP Project (ROW/permits/utilities needed)  Recommended 

 

It will be the discretion of the District to create and maintain a design schedule for any project 
within Table 4.1 that is tagged as Recommended or Not Required. 

The District Portfolio Manager is responsible to ensure that project schedules are created and 
maintained as defined within this policy. 

4.2- STANDARD TEMPLATE.  The Pennsylvania Department of Transportation maintains a 
master template to be used in the development of all project design schedules. The template contains the 
activities that are commonly found in the process of performing analysis, studies, and other necessary 
work required to complete a project and prepare necessary bid documents for the project. 
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The organization and nomenclature of activities within the template are not to be altered. Work that is 
required for a project that may not be identified or contained in the template may be added following the 
procedure in Section B – Non-Standard Activities.   

For the purpose of project design schedules, activities are defined as standard and non-standard activities. 

4.2.1- Standard Activities.  Standard activities are those organized and defined within the 
current PennDOT master template. These activities have specific and required descriptions and 
coding that is required and used in the preparation of reports. To maintain the integrity and 
consistency of report data, altering task descriptions or coding is not permitted. 

4.2.2-  Non-Standard Activities.  Any task added to a design schedule that is not identified in 
the current PennDOT master template is considered a non-standard task.  

Non-standard activities are to be: 

• Inserted within an appropriate task structure already identified in the template 

• Identified by an ID number consistent with the group it is placed within 

• Assign all  task level codes that are established for the project 

4.3- SCHEDULE SETUP AND DOCUMENTATION 

Schedules prepared for PennDOT require specific information for the purpose of project tracking and data 
retrieval. The following sections define those requirements. 

4.3.1- Schedule Setup.  PennDOT’s master template contains fields that require specific data 
entry. These fields are either a drop down selection box or a field capable of direct data entry. 

A project schedule shall contain all the activities that define the scope of work. During the 
development of a project schedule, all necessary parties will be consulted to identify and plan the 
work, the duration needed to complete the work requirements, and the interaction and sequencing of 
work to complete the project scope in an achievable time frame. 

4.3.2-  Schedule Access and Access Rights.  To facilitate the review of project schedules, 
PennDOT staff and business partners must be provided access to the schedule. This access is 
accommodated and controlled by users and provides a level of access rights to the project schedule. 
All project schedules must identify who has access to the schedule throughout the life of the project.  
Chapter 7 of this document identifies the process required to identify user access to individual 
schedules. 

4.3.3-  Documentation.  Schedule development and changes made to the schedule during the life 
of the project need to be identified and recorded. This project information is to be maintained and 
made available for review and archiving. The project documentation may be comprised of Notes 
attached to the schedule, to schedule activities, or electronic versioning of the project schedule. 
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4.3.4- Task Duration.  Working days will be the unit of time assigned to activities for their 
durations. 

4.3.4.1- Project Calendar.  PennDOT’s design template contains the standard project 
calendars to be used for all design projects requiring a schedule. These project calendars address 
non-working days. Any revision made to the standard calendars will be made and communicated 
to the District Offices by PennDOT’s Central Office. 

The standard PennDOT calendars shall be the only calendars associated with a design schedule. 

4.3.5- Project Constraints.  To manage the delivery of a project, date constraints shall be set for 
the project let date as well as select milestones within the project. Date constraints shall be 
coordinated with the appropriate Department(s) and the need to coordinate any intermediate target is 
necessary with appropriate Department or Agency.   The rescheduling of any specific task constrained 
date must be approved before the revision is made to the project schedule. The number of date 
constraints will be minimal to facilitate flexibility but sufficient to provide on time delivery of the 
project. 

4.3.5.1- Target Date.  A target date will be assigned to the last task of a project schedule and 
may also be assigned to the first task of the project.  
4.3.5.2- Intermediate Target Dates.  To facilitate the on time completion of a project, 
intermediate target dates may be set for document delivery or other events that are determined 
critical to the project delivery. The need to coordinate any intermediate target is necessary with 
the appropriate Department or Agency. Any change to intermediate target dates will require the 
approval of the impacted parties prior to revision. 

Intermediate targets will be facilitated by the addition of a finish milestone task.  
4.3.5.3- Delivery Date.  A target delivery date will be set for the project. This date will 
coincide with an established let date defined by PennDOT. The target date will be assigned to the 
last task (finish milestone) of the project schedule (Open Bids). 

 4.4- PROJECT IDENTIFICATION 

Project identification will be maintained at two levels; external and internal. 

4.4.1- External.  The external project identification shall be the project MPMS number and will 
be the identification method for tracking the project with the various accounting and tracking systems 
that PennDOT uses. 

4.4.2- Internal.  For the purpose of project identification, each project will be identified by a type 
and category. Project type and category are codes associated with the PennDOT’s design schedule 
template(s). The project type and category will be selected from the values available. 
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4.5- LOCAL PROJECTS 

A local project shall be defined as: 

• A municipality or agency owned/lead project that may include roadway, bridge, 
or roadway facility construction, reconstruction or maintenance. 
 

• A transportation alternative project. 

All requirements set for the preparation and updating of a project schedule apply to local projects. 
Responsibility for developing the project scope of work will be a joint effort of any local agency and 
PennDOT. 

PennDOT will provide support and guidance in the preparation of the design schedule so that the schedule 
requirements are achieved.  

The project schedule shall be progressed as defined in Section 4.12 - Schedule Monitoring, of this 
document so that the status of the project can be tracked. Any scope change identified during the life of 
the project will be immediately addressed so that any impact to the project let date can be determined. 

A baseline schedule shall be set for local projects.  PennDOT should take into consideration the delivery 
of previous local projects when setting a baseline schedule.  Any baseline schedule adjustments shall 
follow the guidance as provided in Section 4.8 - Project Baseline, of this document. 

4.6- TASK CODING 

Activities contained in the PennDOT master template are assigned codes that associate the task with 
specific PennDOT identifiers corresponding to the PennDOT: 

• Work Breakdown Structure 

• Organizational Breakdown Structure 

• Cost Structure 

Codes assigned to standard activities should not be changed. Any revision to task code assignments shall 
obtain prior approval from the Portfolio Manager. All activities within a design schedule shall have all 
code fields occupied with the appropriate code value. 

 4.7- LEVEL OF DETAIL – WORK/ACTIVITIES 

Work that is required to be performed pertaining to the design process in order for the project to be let 
should be tracked in the project schedule.  Deletion of any work / activities from the PennDOT master 
template for a project means that the work / task does not pertain to the delivery of the project; this is the 
only instance when a task is to be deleted from the project schedule.  Refer to Section 4.13.B – Decrease 
Scope of Work for further information. 

4.7.1- Project Scope Requirements.  Any time that there is a change in scope the project 
schedule will be updated to reflect the change.   
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4.7.2- Submissions/Reviews.  All submissions, reviews, re-submittals, and time for addressing 
comments are required to be included within the project schedule.  Reviews from different agencies 
and PennDOT’s Central Office require a standardized review time which is allocated in the templates.  
These durations cannot be lessened unless prior approval is given by the appropriate party responsible 
for the review. 

4.7.3- Project Reporting Activities.  To support project status reporting for various PennDOT 
Departments, specific task descriptions are required and shall be used in all design schedules. These 
specific task descriptions are provided within Appendix A – Standard Report Activities. These 
descriptions are not to be altered. 

4.8- PROJECT BASELINE 

All design project schedules require a baseline schedule to be set. 

4.8.1- Baseline Creation.  Once all of the appropriate parties have reviewed, and concurrence is 
reached of the project schedule, an initial baseline schedule shall be created for comparison purposes.  
This initial baseline schedule should always be set prior to any progress being entered into the 
schedule. For PennDOT reporting purposes, the initial baseline should not be deleted.  

4.8.2- Baseline Types.  A baseline shall be identified either as initial, committed, or bench mark. 

4.8.2.1- Initial.  An initial baseline shall be established to track the progress of a design 
project. Initial baselines should be created prior to any progress being entered into the schedule.  
4.8.2.2- Committed.  A committed baseline shall be established prior to the end of the 
calendar year preceding the project let date. Projects that contain a committed baseline are those 
that are part of PennDOT’s committed program and have a locked down let date. 
4.8.2.3- Benchmark.  A benchmark baseline or snap shot can be created at any time 
throughout the project life cycle. These baselines may be used as a documentation of task status 
at a particular time or phase of a project. When a project is selected to be a part of PennDOT’s 
yearly committed program, a committed baseline is established. 

4.8.3- Baseline Target Completion Date.  In the process of establishing a baseline schedule, a 
target date shall be set. This target date shall coincide with the date recorded in PennDOT’s ECMS 
system. 

4.9- LEAD/GROUPED PROJECT 

When there are several small like projects  (e.g., roadway striping, guide rail replacement) which will be 
occurring county or district wide, these small projects may be combined into a single project.  The 
following shall define, as it pertains to design projects, what a lead project is and what comprises a 
grouped project. 

 

 



Chapter 4: Design Policy  Publication 615 

4-7   

4.9.1- Lead Project.  A lead project is described as one ECMS number that encompasses multiple 
MPMS numbers.  The schedule of the lead project is required to have the detail and work 
requirements associated with the entire project scope of work. This project scope of work will include 
the individual scope of work required to execute all the individual MPMS work requirements. 

4.9.2- Grouped Projects.  A grouped project does not require its own project schedule; they will 
be encompassed under the lead project schedule.  Grouped projects must be called out and identified 
for reporting purposes so that the accurate project information is pulled from the lead project.  

4.9.3- Breakout Project.  When an individual project is pulled out from the group and is to be let 
on its own, a stand-alone project schedule now must to be created. The stand-alone project can no 
longer be tracked under the lead project schedule.  All activities that are associated with the stand-
alone project must be included in the breakout project schedule. 

4.10- PROJECT TYPES 

Each project schedule will be identified by a project type (Table 4.2)  

Table 4.2 - Project Type 
 

Code Description Code ID 
Bridge Alignment ALI.BRG 
Environmental Assessment Project ALI.EA 
Environmental Impact Study Project ALI.EIS 
Roadway Alignment ALI.RDW 
Bridge Preservation / Design-Build BRG.PRE.DB 
Bridge Preservation / Design-Bid-Build BRG.PRE.DBB 
Bridge Rehabilitation / Design-Build BRG.REH.DB 
Bridge Rehabilitation / Design-Bid-Build BRG.REH.DBB 
Bridge Replacement / Design-Build BRG.REP.DB 
Bridge Replacement / Design-Bid-Build BRG.REP.DBB 
Interstate Maintenance MAT.IM 
Maintenance Betterment MAT.MB 
Intersection Improvement RDW.INT 
Roadway Reconstruction RDW.REC 
Roadway Rehabilitation RDW.REH 
Roadway Resurfacing RDW.RES 
Other OTR 
Information Transportation System OTR.ITS 
Culvert OTR.CVT 
Traffic Signals OTR.TFS 
Transportation Alternative Project OTR.TAP 
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To coincide with the project type, a second level of type is used. This will identify the project as Design-
Bid-Build or Design-Build.  

4.10.1- Design-Bid-Build Project.  A Design-Bid-Build project is the customary design project 
type where all documents required for the construction of a project are complete prior to the 
advertisement and letting of the project.  

4.10.2- Design-Build Project.  A design-build (D-B) project is a project where the design 
requirements are partially completed by either PennDOT or a consultant design team and the 
continuation of design work and final construction will be awarded to a contractor.  The design-build 
project will transfer the responsibility of design work to a design and construction team (D-B team) 
which may include but are not limited to the following items: 

• Design of Highway Item(s) 

• Design of Structure Item(s) 

When a design-build project is executed (let), PennDOT will retain responsibility for specific 
approvals and/or the transfer of information for review and approval before certain construction 
activities may commence or continue. The specific work that PennDOT will facilitate coordination of 
will be defined within the design-build special provision included in the bid documents of the design-
build contract. 

Work that a D-B team will be required to perform, that PennDOT will coordinate and or approve,  
will be included in the D-B team’s design-build schedule and will identify a duration that is 
considered appropriate for the work to be complete.  

To accommodate the PennDOT coordination of work, the design-build schedule will contain the task 
descriptions that are contained in the current PennDOT template. 

4.11- PROJECT COMPLEXITY 

Each project schedule will be identified by complexity, Table 4.3 - Project Complexity will coincide with 
PennDOT’s definitions: 

Table 4.3 - Project Complexity 
 

Code Description Code ID 
Most Complex (Major) PLX.MAJ 
Moderately Complex PLX.MOD 
Non-Complex (Minor) PLX.MIN 
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4.12- SCHEDULE MONITORING 

PennDOT requires that all schedules are updated a minimum of once every month with a progress period 
(data date) of the first of the month. The progress period is defined as the day that project work will 
continue after recording progress. 

4.12.1- Task Progress.  Progress is to be entered monthly and is to document the status or amount 
of work realized on or before the progress period. All progress must be entered by the tenth of every 
month. 

For reporting purposes, work shall be progressed in increments of 5% and not to exceed 95% 
complete until the work is actually complete and any necessary documentation is transferred to the 
responsible party. 

4.12.2- Project Delay.  As part of project schedule documentation, if a delay is identified in 
scheduled work, information as to the reason or purpose of delay should be recorded. Refer to Section 
4.3.C - Documentation. 

4.12.3- Project Time Recovery.  If a delay in a project task results in the project being forecasted 
as being delivered greater than 15 working days beyond the scheduled delivery date, a plan to recover 
this lost time must be identified and implemented. The course of action will be defined as the 
schedule recovery plan. 

4.13- PROJECT SCOPE CHANGE 

Any change in scope of work will be applied to the current schedule status prior to the next scheduled 
update so that the effect of the change in scope can be relayed to the project team.  

4.13.1- Increased Scope of Work.  When the scope of work is increased in a project, the project 
schedule will be updated to reflect the change in scope and the increase in scope of work will be 
documented. 

PennDOT’s master template contains activities commonly found in a design project. When additional 
work is required to be inserted into a schedule, the master template shall be the source of identifying 
the additional work. When the additional work is not identified in the master template, Central Office 
shall be contacted for guidance. 

4.13.2- Decreased Scope of Work.  During the life of the project, when the scope of work is 
decreased, the project schedule will be updated to reflect the change in scope and the decrease in 
scope of work will be documented.  Activities that pertain to the scope reduction should not be 
deleted from the schedule.  These activities may be closed out as follows: 

Record the date of task modification by inputting Actual Start and Actual Finish dates from the task. 

Record the reason of task modification within the task Note field. 

The reason shall contain persons contacted, date of contact, and other relative information.  Project 
logic shall be addressed as necessary to retain the schedule’s integrity. 
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If a task must be deleted from the project schedule, documentation is required as per Section 4.3.C – 
Documentation.  The reason as to why it was deleted shall contain persons contacted, date of contact, 
and other relative information. 

PennDOT’s Central Office shall be contacted for guidance in updating the project schedule to reflect 
the scope change. 

The decrease in scope of work will be documented as required. 

4.14- YEARLY COMMITTED AND POTENTIAL PROJECTS 

Each year the Districts are responsible for submitting a list of committed and potential projects.  Each 
project shall have a project schedule planning the scope of work and identifying when the project can be 
delivered. 

4.14.1- Committed Projects.  A committed project is defined as a project that the District 
obligates to letting during the calendar year and gives a forecasted completion date and open bid date.  
The open bid date that is provided by the District is placed in the Committed Date field of ECMS and 
is then locked. 

4.14.2- Potential Projects.  A potential project is defined as a project that the District anticipates 
to completing within the calendar year. Potential projects require a target finish date and a baseline 
schedule as previously defined. 

The District provides a list of projects that it believes can be delivered during the calendar year. For 
these projects a forecasted let date is in ECMS. 

4.15- PROJECT SCHEDULE CLOSEOUT 

Once a project is let, the project schedule shall be updated to reflect the overall project status of complete. 

4.15.1- Project Closeout.  A project schedule shall be considered complete when all activities in 
the schedule record actual start and finish dates. No task shall be deleted from the schedule. Refer to 
Section 4.13.2. 

4.16- PROJECT SUSPENSION OR CANCELLATION 

The following sections define the procedure to follow when a project is suspended or cancelled. 

4.16.1- Project Suspension.  A project suspension may occur for various reasons including, but 
not limited to, the following events: 

• Loss or lack of funding 
• A delay in work execution by a project sponsor 
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In the event of a project suspension the project schedule will be retained. The project schedule shall 
contain information as to the date of suspension as well as factors or events that result in the 
suspension. A milestone task will be added to the schedule within the project management group with 
the description Project Suspension. The task will provide the date of suspension. 

If the project is part of a yearly program, Central Office shall be made aware of the suspension so that 
any necessary action can be taken. 

Upon the startup of a suspended project, the original schedule shall be updated at the resumption of 
work. The update shall follow the policy set for a change in scope, in that activities may be required 
to be added or removed. 

4.16.2- Project Cancellation.  In the event of a project cancellation, the project schedule shall 
contain information as to the date of cancellation as well as factors or events that result in the 
cancellation.  A milestone task will be added to the schedule within the project management group 
with the description Project Cancelled. The task will provide the date of cancellation. 

Cancellation of the project shall be communicated to Central Office so that necessary action may take 
place. 

The project schedule will be archived. 

4.17- PROJECT RE-BID 

When PennDOT determines that a project award will not occur and a repackaging or re-advertising of a 
project will occur, the project schedule will be updated to account for the project re-bid. Activities 
addressing the repackaging or other work required to be performed before a re-advertising will be 
included in the project schedule and monitored and progressed as defined in Section 4.12 Schedule 
Monitoring. 

4.18- SCHEDULING ARCHIVING 

Once a project is let and the overall status of the project schedule shows complete, the project schedule 
should be archived. Central Office staff and the Server Farm will be responsible for schedule archiving.  
For the purpose of project reporting, project archiving will not be performed until the month of February 
after the end of the previous calendar year. 
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CHAPTER 5 - PRE-BID POLICY 

5.0- INTRODUCTION 

The duration required to complete a construction job is dependent upon many factors. These factors may 
include size, location, type of construction, as well as the season(s) that the job will span. The 
Constructability, or Pre-bid, Schedule is the initial schedule developed by the Department.  The purpose 
of the Pre-bid schedule is to show that the project can be constructed by a reasonably competent 
contractor within the time frame when utilizing standard construction practices and production rates. The 
Pre-bid schedule will be used to identify both the Contract Completion Date (CCD) and any milestone 
dates that will be included in the contract along with serving as a baseline against which the Contractor’s 
actual construction schedule is measured.  Also Note that any milestone date that is not contractually 
enforceable (i.e., road user liquidated damages) should not be used.  Construction activities, linked in a 
logical sequence (CPM), form a “picture” of the way a project can be accomplished. 
 
The development of a Pre-bid schedule starts with Design Field View Approval and moves to the Project 
Manager (PM), who develops a tentative list of activities. At this point the PM creates the first, rough-cut 
version of a Pre-bid schedule and if necessary coordinates the first review with Design, Traffic, 
Maintenance, Construction and Utilities personnel. Taken into consideration at those stages are type, size 
and location (TS&L) of any structures, letting date, initial quantity estimates, agreed upon method of 
construction, and any initial design changes. Periodic constructability reviews continue until plans and 
specifications are complete and the project designer creates a schedule. Next, a team from Design and 
Construction develops a Pre-bid schedule.  Pre-bid schedules are required to be created in Elecosoft 
Powerproject utilizing the PennDOT Pre-bid Template. 

At this point District Contract Management incorporates milestones and a contract completion date into 
the bid package. A plans, specifications and estimates (PS&E) package is submitted to the Contract 
Management Unit for review.  The Department advertises for bids and requires contractors to submit their 
schedule if they are awarded the project.  

After a project is awarded the contractor has the opportunity to propose design changes. The PM and the 
constructability team are responsible for assessing any potential impacts of design changes on the 
schedule and contract completion date. 

Implementing Pre-bid construction scheduling statewide will have some impacts on the Department’s 
traditional methods. Here are some of those impacts. 

• All projects will be completion date contracts and the completion date will be 
determined by a Pre-bid construction schedule. 

• The Project Manager is responsible for the Pre-bid construction schedule. 
• The development of a Pre-bid construction schedule is undertaken as part of the 

constructability review. 
• The Pre-bid construction schedule will provide the Department with a realistic 

completion date for each project. 
• The development of a Pre-bid construction schedule requires a joint effort by 

Design and Construction to complete. 
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• The development of Pre-bid construction schedules require management support 
of the required staff effort and training. 

The tools and techniques included in this manual should be utilized in order to produce reasonable, 
realistic, and supportable Pre-bid schedules. Pre-bid schedules should follow the same format that is 
required for Construction Schedule submissions including activity numbers and logic ties.  The Pre-bid 
schedule is available for the contractor to review as part of the bidding process and will be provided in a 
PDF format at the time of advertisement.   

5.0.1- Pre-bid Schedule Considerations.  Throughout the design and scheduling process, 
communication among the design team, estimator, specification writer, and scheduler is required to 
reduce the omission of important information. Construction personnel should also become involved 
to provide valuable input regarding the standard processes, production rates, and material availability.   
For construction projects, the best way to create a Pre-bid schedule is to use the team approach.  
Designer(s), PennDOT personnel, Construction personnel, Assistant Construction Engineer (ACE), 
Inspector-in-Charge (IIC), Utilities, and other stakeholders in the project (municipalities, railroads, 
ROW parties, etc.) can improve the project by participating in the process.  Each district must develop 
a condensed reference to key frequently used dates from Publication 408, Specifications as well as 
district restrictive dates.   

5.0.1.1- Calendar Days.  Quantities derived from plan takeoffs will determine the duration 
of the activities based on production rates. The unit for activity durations is working days that 
will require conversion to calendar days for the schedule development. Work quantities may be 
reported as the total quantity required for a project. The schedule, though, will require the 
calculation of total quantity "required" to be transformed to total quantity "required per location," 
stage, etc. before setting duration requirements.   

A standard work week can be used when creating a Pre-bid schedule and any activities that span 
calendar days (i.e., concrete curing or submission approvals) can be converted to work week 
schedule for presentation purpose.  Consideration must also be given to the occurrence of leap 
years, holidays, as well as the actual number of calendar days in a given month. 

5.0.1.2-  Activities and Task Pools.  Activities are the building blocks of the schedule. An 
activity will be an item of work that will require a time assignment (duration), and dependent on 
what is required to track, may also include resources such as labor, equipment and cost (budget). 
Activities should be assigned duration based on common construction production rates. As with 
estimating construction cost, activity task pools can simplify schedule development in reducing 
the number of items or groups to track, adjust or update. 

The use of task pools will decrease the time required to develop a project schedule by allowing 
the scheduler to repeat repetitive activity groups or copy them into a new schedule. The three 
activities (set forms, set reinforcing, and pour concrete) is a simple repetitive activity group that 
may be put together as a task pool and repeated several times in a schedule. Minor adjustments 
can be made to the separate activity durations to accommodate site conditions or length, but the 
logic (i.e., sequencing) will not change. 
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5.0.1.3- Concurrence.  When establishing the logic of a project's schedule, the scheduler will 
investigate the concurrence of activities to determine whether activities can be performed 
independent of one another or need to be performed sequentially. Concurrence allows two or 
more activities to be worked on simultaneously. 

If a scheduler arbitrarily places activities end to end and does not consider concurrence, the 
project is needlessly extended. In other words, if Activity B does not depend on the completion of 
Activity A before it may begin and it is reasonable to assume that Activities A and B can be 
worked on at the same time (Activities A and B do not require the same resource, work area, 
etc.), then to compress the project schedule, Activity A and Activity B may be concurrent. The 
figure below illustrates the time effect of activity concurrence with respect to Activity C which 
depends on the completion of both Activities A and B. 

Example of Overlap/Concurrence 

 

A project's site condition and scope of work will dictate concurrence of groups and activities. 
When obtaining the global picture of a project, concurrence should be investigated to determine if 
a time saving opportunity exists. 
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5.0.1.4-  Level of Detail.  A level of detail must be established for each project. This level 
may be set by the following considerations. 

• Project size or complexity 

• Expected duration 

• Project reporting requirements 

• Project oversight budget 

• Project funding sources 

5.0.1.5- Coordination.  Project coordination must be maintained during the development of 
the project schedule. All too often, last minute changes in design can affect the approach that can 
be taken in the construction process. Thus, continuous communication among the project design 
team, estimator, specifications writer and scheduler is required. 

The scheduler should pay particular attention to the specifications to identify any of the following 
project requirements: 

• Phasing 

• Intermediate completion targets (milestones) 

• Limits of work 

• Critical utility interfaces 

• Work restrictions 

Additional concern should be given to other construction projects within the vicinity of the 
Department's project.  Site access and material hauling can be greatly affected if a concurrent 
road or commercial project is underway. 

5.0.1.6- Schedule Restrictions, Submittals, and Approvals.  The scheduler must also 
consider activities that involve the use of materials with specification restrictions governing their 
usage. For example, bituminous paving operations should not be shown being performed outside 
of the specified time frames. Additionally, seeding and planting operations should be scheduled 
such that specified grass and/or plant establishment periods fall within the growing season. The 
scheduler must also consider the time necessary for submittals and approvals when required as 
part of an activity. Additional examples of typical schedule restrictions, submittals, and approvals 
include, but are not limited to, the following: 

• Stream encroachment restrictions 

• Construction sequencing restrictions 

• Utility relocations/coordinated work 

• Traffic control 

• Commitments to school districts 
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• Commitments to municipalities 

• Special events 

• Time needed for Contractor to obtain permits for non-designated waste / borrow 

areas 

• Railroad involvement 

• Environmental and archeological restrictions 

• Traffic signal system testing periods 

5.0.1.7- Project Parameters.  The development of a schedule is a combination of many 
factors that are the parameters of the project in question. The following provides some insight to 
the various parameters of a project schedule and how they may impact the final project schedule: 

• Location. For the same type of project the schedule may be impacted by 
specification restrictions for placing materials such as hot-mix asphalt paving. 

Beyond county related location, specific physical accessibility to the work site 
can be a major factor in work productivity that equates to duration. If a 
temporary road is required to provide an access to a job site, the construction and 
maintenance of this road will set limitations on work progress. Limitations will 
include the delivery of material to the construction site and the actual start date of 
construction on the specific project (e.g., bridge structure). 

• Type. A project's type will affect production and job duration. New construction 
verses rehabilitation work affects a project's schedule. When the contract requires 
maintenance and protection of traffic on a highway or bridge during 
rehabilitation, this situation usually translates into longer construction time. 
Tolerance of existing structures and right-of-way places direct restraints on space 
availability that equates to material storage space availability and material 
delivery and handling requirements. 

For highway projects, more flexibility is apparent when a project encompasses 
several miles of highway because several types of work may be concurrent. 
Excavation and subbase preparation may be in progress at an extreme location of 
the roadway while paving operations may begin staging at the other extreme. 

In viewing a bridge project, an approach must be taken that is step sensitive. 
Superstructure work activities cannot begin until the bridge's substructure is 
complete. 
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5.0.1.8- Documentation and Reporting Requirements.  During the production of a Pre-
bid schedule, assumptions and rationale for activity groupings and duration assignments shall be 
documented including any assumption that does not use standard construction practices or 
production rates (i.e., 6-day work week rather than a 5-day work week, multiple structure crews) 
should be documented and attached to the Pre-bid schedule. This documentation will facilitate 
comparison while the project is active and a source of data for development of other similar 
project schedules. The degree of documentation is dependent on the project size and general 
project requirements. 

5.1- PRE-BID SCHEDULE MEETING 

A Pre-bid schedule meeting should be held for every project regardless of size. Factors that come into 
play include: 

5.1.1- Attendees.  The following positions must attend the Pre-bid schedule meeting: 

• Scheduler/Facilitator 

• Roadway/Bridge PMs 

• Consultant PM (if applicable) 

• Assistant Construction Engineer and/or a representative (i.e., Inspector-in-

Charge) 

The following positions may attend the Pre-bid schedule meeting (or should attend as needed): 

• Contract Management Representative 

• Environmental Personnel 

• Traffic Personnel 

• Structural Control Engineer 

• Utility Coordinator 

• Right-of-Way Administrator 

• Railroad Grade Crossing Engineer 

• Permits Administrator 

5.1.2-  Timeframe.  All projects shall have the following guidelines: 

• Timeframe for the meeting: A Pre-bid schedule meeting should be held no less 
than 1 month prior to the PS&E submission date. For more complex projects, an 
initial Pre-bid meeting should be held by the PM more than one month prior to 
the PS&E submission date. If a Final Design Office Meeting (FDOM) is 
warranted, schedule the Pre-bid schedule meeting prior to the FDOM and submit 
the preliminary Pre-bid schedule with the FDOM submission. Additional, follow-
up Pre-bid schedule meetings may be necessary. 
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5.1.3- Meeting Agenda.  The following topics should be discussed during the Pre-bid scheduling 
meetings: 

• Roadway/Bridge PM should review scope of work. 

• Scheduler should review the Schedule Setup Checklist (Appendix B). 

• Development of Pre-bid schedule. 

• Scheduler will review to determine if all items on the Schedule Setup Checklist 
(Appendix B) have been addressed and meet Publication 408, Specifications. 

• Determine all restrictive and milestone dates from the developed Pre-bid 

schedule. 

• All restrictive dates and restrictions should be compiled by the Contract 
Management representative and placed in the contract proposal. 

5.2- CONSTRUCTION SCHEDULE ITEM 

Every proposal is to include a bid item for a Narrative, CPM with Updates, CPM without Updates, or 
Resource Loaded CPM Construction Schedule associated with it in the contract.  

PennDOT identifies projects as: 

• Most Complex (Major) 

• Moderately Complex 

• Non-Complex (Minor) 

For the purpose of this construction schedule item, any project that is defined as Most Complex (Major) 
or Moderately Complex is required to have a CPM with Updates, CPM  without Updates or Resource 
Loaded CPM Schedule created and monitored for the life of the project. For those projects that are within 
the definition of Non-Complex (Minor), Table 5.1 specifies the requirements for a construction schedule. 
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Table 5.1 – Non-Complex (Minor) – Construction Schedule Requirements 

 
Project  Schedule 

Bridge Replacement CPM with Updates 

Bridge Rehab/Repair  CPM with Updates 

Micro-Surfacing Projects  
Narrative or CPM without 
Updates 

Betterments (no ROW/no permits/no utilities)  
Narrative or CPM without 
Updates 

Betterments (ROW/permits/utilities needed)  CPM with Updates 

Transportation Alternative Projects (excluding Transit) CPM with Updates 

District-Wide Program Projects (RPMs, Guide rail, Line painting, etc.) Narrative Schedule 

Grade Crossing (when not part of a highway project) Narrative Schedule 

ITS only (camera and/or VMS/DMS installation) Narrative Schedule 

Maintenance Funded Paving or Pavement Preservation Projects Narrative Schedule 

Department Force Bridge/Boxes/Culverts Narrative or CPM without 
Updates 

Any project that  all construction phases can be completed within one 
construction season CPM without Updates 

 

The ACE is responsible to ensure that project schedules are created and maintained as defined within this 
policy. 

A listing of the scheduling assumptions (work days per week, utility impacts, restrictions, etc.) used in the 
development of the Pre-bid Schedule will also be provided. CPM and Resource Loaded CPM 
construction Pre-bid schedules are required to be created in Elecosoft Powerproject with a pdf provided at 
time of advertisement. 

The CPM schedule format requires the contractor to provide the construction schedule in the precedence 
format and the schedule must be developed using Elecosoft Powerproject or an Elecosoft Powerproject 
compatible format, but must be submitted as an Elecosoft Powerproject (.pp) file electronically.  The 
contractor is responsible for uploading and submitting the Elecosoft Powerproject (.pp) schedule thru the 
PPCC.  The Department will then review the Contractor’s submitted schedule and will either accept, 
accept as noted, or reject the schedule.  Once the schedule is accepted by the Department, the Elecosoft 
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Powerproject (.pp) file will be the governing schedule on record. After the schedule is accepted, the 
Department will upload the accepted schedule to the Elecosoft Powerproject Web Portal and a baseline 
must be created.  Any subsequent changes to the baseline schedule through the submission of any 
updates, revisions or recovery schedules through PPCC shall also be uploaded to the project within the 
Elecosoft Powerproject Web Portal in the same way in order to maintain a record of schedule versions.  



Chapter 6: Construction Policy  Publication 615 

6-1   
   

CHAPTER 6 - CONSTRUCTION POLICY 

6.0- CONTRACTOR’S POLICY 

6.0.1- The CPM schedule and Network Diagram – Project Planning and Scheduling.  
It is the discretion of the contractor as to which scheduling software the construction CPM schedule is 
developed in, as long as it is compatible with Elecosoft Powerproject and submitted to the 
Department in Elecosoft Powerproject.  The development of the schedule must adhere to all 
scheduling specifications outlined in Publication 408.  The following information will give the 
contractor a brief outline of how to put a CPM schedule together. 

6.0.1.1- Project Planning and Scheduling.  A network diagram within the CPM schedule 
is a graphical view of all the project’s activities presented in such a way as to show the logical 
and necessary sequence of activities from beginning to end. This will reflect the experience and 
judgment of those who are responsible for executing the work. 

6.0.1.2-   Steps to Construct a CPM schedule.  To construct a CPM schedule, complete the 
following steps: 

Step 1:  Determine the project start date.  The project start date should be the anticipated 
Notice to Proceed Date. 

Step 2. Determine the workday calendar/calendars.  At a minimum one calendar has to be 
created for the project, but there are instances that more than one calendar may be used on 
one project.  Within the scheduling software, create all applicable calendars for the project 
(such as 5 day, 6 day, 7 day, etc).  In the created calendars, make sure to assign exceptions to 
any day that is a non-working day (such as weekends, holidays, etc. and identify them as 
such).  Ensure all exceptions are created to span the life of the project or thereafter.  There are 
standard calendars already created with the Elecosoft Powerproject PennDOT Construction 
Template. 

Step 3. Obtain the engineering work plans.  Develop a list of tasks and their durations. 
Gather this information by reviewing historical records from similar projects and 
interviewing knowledgeable personnel who can be relied on to give accurate and useful 
estimates of the work involved.  Input all of the activities and durations into the scheduling 
software and make sure to assign the appropriate work day calendar to each activity. 

Step 4. Determine activity logic.  Determine what must be done first (predecessor), what 
must be done next (successor), and what can be done at the same time (concurrent). To begin 
the process of determining interdependencies between activities, define the logical flow of the 
activities. Determine predecessor logic by asking what must be done before this activity can 
begin. Determine successor logic by asking what must be done after this activity finishes. 
Determine concurrence logic by asking if any other activities can occur at the same time. 
Enter all activity logic into the schedule.  Every activity should have a predecessor and a 
successor; the exceptions being the first activity will not have a predecessor and the last 
activity will not have a successor. 
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Step 5. Input any date constraints.   To manage the completion of a project, date constraints 
shall be set for the required completion date as well as any specified milestone date(s). Date 
constraints shall be set based on the project specifications.  The number of date constraints 
will be minimal to facilitate flexibility but sufficient to provide on time completion of the 
project. 

Step 6. Calculate the Forward Pass, Backward Pass, and Critical Path.  The scheduling 
software will calculate the forward pass, backward pass, and critical path for you.  All 
calculations shall be based off of the anticipated notice to proceed date.  These calculations 
will determine early and late dates along with float and the critical path.    

Float is defined as the amount of time that a non-critical activity has before its completion 
affects the successor activity. The Forward and Backward Passes define total float and free 
float. 

Total float exist for a non-critical network path and does not belong to any single activity 
along that path. Total float represents the amount of time along a non-critical network path 
that the starts and finishes of the activities on that path can be delayed without affecting the 
overall duration. Total float is then calculated for each activity. 

Total Float (TF) = LS – ES or LF – EF or LF – ES – Duration 

Float Note: There is no float in any activities on the Critical Path. 

Free Float is expressed as the amount of time an activity’s start can be delayed without 
affecting the early start date of its successor. It is also referred to as activity float, because it 
is a property of an activity. 

Free Float (FF) = Time available before effecting the Early Start of any Successor Activity 

The critical path is the longest string or route of interdependent or connected activities that 
establishes the overall project duration. It is only on the critical path that savings in project 
time units can be made. An activity is critical when the early dates equal the late dates, 
meaning there is no float. 

6.0.1.3- Logic errors.  The completed CPM schedule is a construction manager’s technique 
that reflects the experience and judgment of those who are responsible for executing the work. 
Even the best-laid plans can suffer if the scheduler has not taken into account the following 
potential pitfalls: 

• Incorrect logic.  Activity logic must be correct to accurately reflect the 
construction process. Linking unrelated activities may extend the project duration 
and reduce the effectiveness of the CPM schedule as a planning and management 
tool. 
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• Redundant logic.  Make sure that all activity relationships are necessary to move 
the project toward completion. Redundancy unnecessarily complicates the 
project schedule. 

6.0.1.4- Contractor’s Schedule Submission.  The contractor’s schedule submission must 
meet all Publication 408 Specifications and contract documents. 

It is the contractor’s responsibility to convert the native compatible schedule format to Elecosoft 
Powerproject.  Depending on which compatible file format the contractor is using will depend on 
the steps necessary to convert that native format to Elecosoft Powerproject.  See Chapter 8, 
Section 2.3 of this manual with detailed guidance on How to Convert a Compatible Format to 
Elecosoft Powerproject. 
After the contractor reviews the Elecosoft Powerproject file, the schedule can then be submitted 
to PennDOT.  The Elecosoft Powerproject Project (.pp) schedules will always be submitted 
through the  PennDOT Project Collaboration Center (PPCC). 

6.1- CONSTRUCTION SCHEDULE ACCEPTANCE POLICY 

6.1.1- Overview.  Once the contractor has submitted the schedule through the PPCC, it is now up 
to the ACE to review and accept or reject the contractor’s schedule.  If a contractor’s schedule meets 
the necessary criteria – including all milestones and Contract Completion Date (CCD), as well as all 
other aspects of the Publication 408 Specifications and contract documents, it must be deemed 
acceptable.  Even when the schedule is accepted, it is possible – and reasonable to document and 
express concern over any questionable items.  Detailed policy and checklists for accepting the 
contractor’s schedule is available in the Project Office Manual (POM). 
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The following chart lists differences between schedule types and what is required for each type of 
schedule.   

SUBMISSION REQUIREMENTS NARRATIVE CPM 
Activity Number  X 
Activity Description X X 
Duration of each activity (in working days) X X 
Start and Finish calendar dates of each activity X X 
A Workday Calendar containing: 
Work days 
Non-work days 
Number of shifts per day 
Number of hours per shift 

X X 

Earliest start date of each activity by: 
Calendar date 
Work day 

 X 

Earliest finish date of each activity by: 
Calendar date 
Work day 

 X 

Interdependence of Activities X X 
Latest start date of each activity by: 
Calendar date 
Work day 

 X 

Latest finish date of each activity by: 
Calendar date 
Work day 

 X 

Activity float  X 
Written Narrative X  
Electronic .pp file  X 

 

Schedule activities must satisfy the CCD, milestone dates, all Specifications, Publication 408, and 
contract documents, including restrictions such as paving blackout dates, environmental restrictions, 
etc. “Acceptance of the Contractor’s Schedule or any revision(s) thereto, by the Department, will not 
constitute the Department’s approval of or agreement with the sequence of operations, the durations 
of activities, the adequacy or propriety of resources, the identity of controlling operations, nor the 
feasibility or any other characteristics of the Schedule or its revisions.” (Publication 408, 108.03(b)) 

6.1.2- Analyzing a Construction Schedule.  When analyzing the construction schedule, it is 
important to be proactive. Prepare for potential delays and claims by looking ahead and thinking 
ahead. You are not looking for reasons to reject the schedule (if it contains all the required elements), 
but you are looking for ways to ensure that the schedule makes sense and can be followed during 
construction. 

The items listed below should be analyzed throughout the construction process. By identifying 
potential problem areas promptly by analyzing the schedule, you can avoid many long-term problems. 
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• Durations that are too short, too long, or concurrent with incompatible activities 

• Activities that seem out of sequence 

• Redundant activities 

• Anticipated completion date sooner or later than Contract Completion Date 

• Anticipated milestone dates that indicate accelerated or lagging activities 

• Adequately addressing long-lead items 

• Adequately addressing PennDOT review and turn-around times 

• Negative float 

• Start or finish date that is not schedule-driven (may be contractor-imposed date) 

• “Floating” activities (Activities not linked to schedule by logic) 

Acceleration on a schedule is sometimes overlooked as a potential problem. A contractor who 
accelerates may expect compensation for the acceleration. Failing to alert the contractor to an 
accelerated schedule may imply PennDOT complicity with the acceleration. 

• If the contractor submits an initial schedule with a completion date that is earlier 
than the CCD, notify the contractor in writing immediately. 
 

• Ask how he wants to proceed; there are several options. 

o He could add float to extend the schedule to meet the CCD. 

o He could submit a new schedule with the correct CCD. 

o He could ask to have the CCD amended. (This requires the District 
Executive’s approval.) 

 
• Reinforce to him that he is not being accelerated and that the expected 

completion date is the Contract Completion Date. 

6.2-  MONITORING POLICY 

6.2.1- Monitoring Chart.  With the CPM schedule complete, the contractor must submit the 
Elecosoft Powerproject (.pp) file to the Department.  Once the Department accepts the contractor’s 
CPM schedule, the Department can prepare a method to monitor and document the actual progress of 
the project as daily work is completed. All projects that require a CPM or CPM with Resource 
Loaded Schedule must be monitored. Before the monitoring chart can be plotted, a baseline should be 
created within the Elecosoft Powerproject file. 

The Monitoring Chart is a modified bar chart that displays the network logic. The monitoring chart is 
a tool for monitoring construction projects on a daily basis.  The monitoring chart is a view that is 
already created within the PennDOT Construction Template.   

6.2.1.1- Project Monitoring and Documenting using the Monitoring Chart.  With 
the contractor’s schedule completed and accepted, the monitoring chart can now be plotted and it 
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can be used to document periods of work and non-work.  This method of monitoring will take 
place on a hard copy of the plotted out Monitoring Chart that shall be placed in the field office.  
The documentation should be documented daily.   

6.2.1.2- Keys to Monitoring Contractor’s Schedule.  The most important thing is to 
monitor the schedule. Since the Contractors have to justify and support any Time Extension 
request that they submit, it is important that the Inspector-In-Charge and/or ACE know whether 
the request is accurate or not. Project Schedules are dynamic and during the course of the project, 
issues can affect work such that one or more Activities that were not critical at the beginning of 
the project become the most critical Activities in the schedule. Knowing what caused these 
changes, no matter how minor, can be important when trying to resolve disputes or working with 
FHWA. 

Collect important information regarding Activities. The information that is most important to 
collect for an Activity is what date it was started, any issues or events that affected the progress 
(such as rain, equipment breakdowns, equipment/labor changes, changes made by the 
Department, removal and replacement of material, etc.) and the date that it was finished. 

Constantly document progress. Don’t wait until there is a need to review the schedule. 

Once the need arises, the Department has a limited period in which to respond to requests by the 
Contractor. The schedule should never be more than a week behind in being documented against. 
It is also very helpful when documenting the progress of an Activity, that once it has started, it be 
monitored daily until it is completed. This maintains continuity in the documentation and 
minimizes the questions that may arise later. 

Keep schedule information daily. Whether you are using a monitoring chart or another means to 
monitor the schedule, it is inevitable that there will be times that keeping information up to date 
will fall behind. That is why it is a good idea to assign someone to keep the data on a daily basis 
and in a consistent manner. For instance, if one of the project staff is assigned to document the 
schedule in their PSA, they should: 

• List each Activity that is in progress that day 

• Whether the Activity started that day 

• Whether there was work done on that Activity that day 

• Any issues that may have arisen 

• Whether the work was completed 

• It may also be helpful to list any Pay Items associated with the Activity 

It’s not as much work as it may seem. It may seem like a lot of work and effort to monitor a 
schedule, but it really isn’t. Even on the largest project, there should only be a handful of 
Activities progressing at any one time. There are already inspectors covering the operations to 
document against pay items. Even marking up the chart should only take a minute or two each 
day if the data is collected in one or two PSAs in a clear and consistent format. 
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6.2.1.3- Actual vs. Planned.  The start of every activity should be marked on the day when 
it started, and for every subsequent day as that activity progresses. Likewise, if no work is 
performed during a day that should also be indicated on the chart, but only if that activity has 
already started. Finally, a separate mark should be indicated on the time unit that the activity 
completes. 

Most importantly, any project delay must also be documented, stating the reason for the delay. 
Having a simple graphical representation of project delay allows the project manager to more 
quickly respond to possible impacts on the schedule. 

Impacts cause changes to the plan, altering the contractor’s ability to follow the original schedule. 
Impacts may shorten or lengthen activity durations, and the lengthened durations may or may not 
change the critical path. Impacts may include delays to the Notice to Proceed, awards, 
submissions, approvals, rejections, and production. Delays could also be caused by incomplete 
plans and drawings, changed conditions, and additional or unforeseen work. 

The Monitoring Chart will document any production delays and gains throughout the project, as 
well as start delays and gains. A production delay occurs when an activity takes longer than 
scheduled, possibly pushing any successor activities past their scheduled starts. A start delay 
occurs when an activity can start on its scheduled start, but for some reason does not. This 
assumes that its predecessor activities have been completed. Gains occur when production takes 
less time than scheduled, or when an activity starts earlier than scheduled. 

Note: A start delay can only occur when the delay is not attributed to the finish of its predecessor. 

Documenting the who, what, when, where, why, and how the impact occurred on the Monitoring 
Chart will bring attention to delays before they can be allowed to start a chain reaction. This will 
help determine what must be done to get the project back on schedule. 

6.2.1.4- Recommended Notations for Use on the Monitoring Chart: 

 

Start of Activity 

End of Activity 

Standard Work Day 

Rain Day (No Work) 

No Work (No Limitation) 

Out of Sequence Activity 

Make-Up Day (Sat/Sun) 

If no work was done, make sure to Note the following information directly onto the monitoring 
chart or as an activity Note as to any Notes associated with the activity and references to PSAs. 
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6.2.1.5- Monitoring Guidelines and Tips.  Below are some basic pieces of information 
that you should gather at the beginning of each project.  Then, keep them in mind as you review 
and monitor progress daily. 

• Read the contract thoroughly. 

• What are all the submission requirements, timelines, application due dates, and 
start dates? 

• What has the Department agreed to, in terms of a turn-around time for items such 
as design approval? Check that the schedule accurately reflects those dates. 

• Do any overlapping activities require adjustment? For example, does a review 
time overlap with an activity’s construction schedule? 

• Do any items require exceptionally short or long lead times? 

• Scour the schedule for unreasonable durations. Note where the contractor may 
have shortened or lengthened standard durations. 

• Does any concurrent work seem questionable? 

• Are all specs being met in order to ensure good work and a safe project for 
employees and travelers? 

• Always ask yourself, and know the answer to, these three questions: 

o What activity is first? 

o What activity is next? 

o What activities are concurrent? 

• Use the chart and its Notes to support quick decision making based on timely and 
factual data. 

• Does the schedule include time for shop drawing review? 

6.2.2- Monitoring Progress 

6.2.2.1- Progress Tracking.  Progress tracking is the process of using the monitoring chart 
to determine what activities were delayed and why they were delayed. 

Monitoring occurs on the activity level and the project level. 

• Was the project started on the planned project start date? 

• Was the activity started on the planned start date? 

• Was the planned progress for the activity met? 

By monitoring these elements, you will identify any delays in the process 

6.2.2.2- What to Monitor on the Project Level.  The following dates matter most at the 
project level. 

• Notice to Proceed (NTP) 
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o There are two NTP dates involved in a construction project—Planned and 
Actual dates. 

 
o However, the project you are monitoring reflects the schedule by which the 

project operates. This schedule is based on the Actual NTP date. 
 

o For the purpose of monitoring, the Actual Notice to Proceed date is the only 
one of concern. 

• Actual Start Date 

• Contract Completion Date (CCD) 

• Milestones 

6.2.2.3- What to Monitor on the Activity Level.  Every schedule is comprised of various 
construction activities; in turn, the activities are comprised of various payment items, or contract 
items. All the activities, when placed in a logical manner, form the basis of a CPM schedule from 
which a monitoring chart is developed. 

• On the schedule, each of the activities is listed separately. 

• Monitor each day that the activity was worked or not worked. 

• Mark notations on the chart to indicate all worked activities or reasons for not 
working on each activity. 

• Start date and end date of activity. 

6.2.2.4- Critical vs. Non-Critical Activities 

• A delay in a critical activity will delay the entire project. 

• A non-critical activity has float. 

• A delay in a non-critical activity may not delay the project until its float is used. 

6.2.2.5- Delays.  Delays to an activity can occur for two reasons. 

• The activity did not start on time. 

• The production rate for that activity was not achieved. 

If a delay occurs in a critical activity, the delay will impact the project. 

If a delay occurs in a non-critical activity, available float time may be used and, if not exceeded, 
it is possible that the project will not be delayed.
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CHAPTER 7 - ELECOSOFT POWERPROJECT WEB PORTAL 

7.0- ELECOSOFT POWERPROJECT WEB PORTAL OVERVIEW 

The Elecosoft Powerproject Web Portal is a web-based collaboration portal that allows users to create, 
view, and update Elecosoft Powerproject schedules over the Web. The primary benefit of the Elecosoft 
Powerproject Web Portal for PennDOT is the ability to allow business partners to submit and update 
project schedules in Elecosoft Powerproject without having to send in a schedule via electronic or paper 
means. The purpose of this chapter is to provide users with the information to quickly get started in the 
Elecosoft Powerproject Web Portal and start taking advantage of the benefits of the tool. 

7.1- PURPOSE 

The Web Portal serves several functions within the PennDOT environment: 

• Provides user level security to projects 

• Allows users to manage multiple projects 

• Allows check in / check out of projects 

• Allows progression of activities via a simple web interface 

• Allows submission of projects into the PennDOT environment 

• Allows Department staff to accept / reject inputs to their projects 

• Allows easy reporting at both a project and portfolio level 

• Allows users to view the schedule via the Gantt Chart 

• Provides Electronic Record Retention of schedule changes throught the life of the 

project 

• Handles loaned Elecosoft Powerproject licenses to Business Partners 

7.2- LOGGING INTO THE ELECOSOFT POWERPROJECT WEB PORTAL 

This section will explain how to log into the Elecosoft Powerproject Web Portal.  To access the Elecosoft 
Powerproject Web Portal, a user must have access to the Pennsylvania Project Collaboration Center 
(PPCC) website. To access PPCC, PennDOT users must have a CWOPA Username and Password; 
Business partners must have an ECMS Username and Password. 
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7.2.1- To Log on to the Pennsylvania Project Collaboration Center Website (PPCC) 

1. Go to https://ppcc.penndot.gov/  

 

 
2. If you are a Business Partner, sign in under the Business Partner section with your 

ECMS Username and Password.   
 

 
 

3. Select Login. 

-Or- 

 

https://ppcc.penndot.gov/


Chapter 7: Powerproject Web Portal  Publication 615 

 7-3  

1. If you are a PennDOT employee, or anyone acting on behalf of the Department, sign 
in under the PennDOT Employees section, by clicking PennDOT Employees Click 
here to login. 

 

If you are on the PennDOT network, it will take you right into the PPCC, if you are off the 
PennDOT network a login page will appear where you will have to enter your CWOPA 
Username and Password. 

7.2.2- To Log on to the Elecosoft Powerproject Web Portal 

Once you are logged into PPCC: 

1. Under the Useful Links Area, select either ELECOSOFT POWERPROJECT for 
Business Partners or ELECOSOFT POWERPROJECT for PennDOT Users, 
depending on how you logged onto PPCC. 

 
Under the Useful Links Area, if a user cannot access the Elecosoft Powerproject Web 
Portal, there is a form they can fill out by selecting the ELECOSOFT 
POWERPROJECT ACCESS REQUEST FORM.  This form will be used for 
internal personnel who do not have Elecosoft Powerproject installed on their computer 
or who do not have access to the Elecosoft Powerproject Web Portal.  For external 
personnel, this form is only used to gain access to the Elecosoft Powerproject Web 
Portal if they already have an ECMS User ID and Password.   
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Once the link is selected, the Elecosoft Powerproject Web Portal Login Page will appear. 

 

2. If you are a Business Partner, log in with your ECMS Username and Password. 

-Or- 

 
2. If you are a PennDOT employee, or anyone acting on behalf of the Department, log 

in with your CWOPA Username and Password. 
 

3. Select Login. 
 

Click Here 
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This will take the user to the Elecosoft Powerproject Web Portal Homepage.  Users 
are assigned different security levels via the Web Portal.  Users will only be able to 
access information pertinent to their level of access.   
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7.3- ELECOSOFT POWERPROJECT WEB PORTAL HOMEPAGE 

Please Note that all screen shots shown are based on the highest level of security.  A user may not see the 
exact screen that is shown throughout this section for that reason.  Some options will not be available 
based on what type of user you are. 
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7.3.1-  Title Bar.  All windows of the Web Portal contain the Title Bar, the purpose of which is 
to provide continuity throughout the portal.  Depending on permissions, users may or may not see all 
available items. 

 

The Title Bar contains the following menu items: 

• PennDOT Portal – will return a user back to the Home Page 
 

• Projects – Takes a user to “Show All Projects” which is a listing of all projects 
within the tool.  Users will only be able to view projects that they have access to. 
 

• Users – Users is a link to the section of the Web Portal for adding / removing portal 
users.   
 

• Business Partners – is a link to the section of the Web Portal for adding / removing 
Business partners/contractors.  This is only available to Portal Administrators. 
 

• Reporting – is a link to the section of the Web Portal for creating / editing / running 
reports. 
 

• Service Status – is a link to determine Server level services are running 
 

• About – versioning of the tool 
 

7.3.2- Projects.  Show All Projects is a way for users to view all projects whether they have 
progress or not.  Users can create, progress, and remove projects. 

 

For convenience, Projects lists the number of projects a user is associated with, how many projects 
are awaiting approval, how many projects are currently checked out, and how many projects are in 
the Recycle Bin.  The title to the right of the number is a hyperlink that will take users to the Projects 
page with a pre-defined filter applied to the list of All Projects.   
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7.3.3- Progress.  Show In-Progress Projects is a way for users to view projects that have been 
submitted and accepted by PennDOT.  

 

For convenience, the Progress window gives counts of projects awaiting progress entry and projects 
awaiting progress acceptance.  The title to the right of the number is a hyperlink that will take users to 
the Progress page with a pre-defined filter applied to the list of all In-Progress Projects.   

7.3.4- Manage Users.  Manage Users gives administrators the ability to add, modify and remove 
Web Portal users.   

 

 

For convenience, the Users window gives counts of total users, Portfolio Managers, Project 
Managers, Business Partners, Team Members, Project ACE Users, and Inspector In Charge Users.  
The title to the right of the number is a hyperlink that will take users to the Users page with a pre-
defined filter applied to the list of all Users.   

User Types.  When creating users, the following security types may be used: 
• Admin – Highest level of access within the PennDOT Environment.  These users 

have complete access to all functionality within the Web Portal. 
 

• Portfolio Manager – Administrative access at the District level to all Design and 
Construction with Design project areas.  These users have administrative full 
access at their district level. 
 



Chapter 7: Powerproject Web Portal  Publication 615 

 7-9  

• Project Manager – Used to give project access to an individual Project 
Manager.  These users are able to create projects, accept/reject changes and 
progress as needed.  Project Managers will only have access to projects they are 
assigned to. 
 

• Project ACE –  Administrative access at the District level to all Construction 
and Construction with Design project areas.  These users have administrative full 
access at their district level. 
 

• Inspector in Charge (IIC) – Used to give project access to an individual 
Inspector in Charge.  These users are able to create projects, accept/reject 
changes and progress as needed.  IICs will only have access to projects they are 
assigned to. 
 

• Business Partner – Allows for the updating of projects via the portal.  This is 
limited access security. 
 

• Team Member – Allows access to all projects, but in read-only mode.  This 
access only allows download capabilities of the projects. 

 
7.3.5- Manage Business Partners.  Available to Web Portal Admins, Manage Business 
Partners gives administrators the ability to add, remove and edit Business partners/contractors. 

 

For convenience, the Business Partners window gives counts of Total Business Partner Companies.  
The title to the right of the number is a hyperlink that will take users to the Manager Business 
Partners page.   

7.3.6- Manage Licenses.  Available to Web Portal Admins, Manage Licenses gives 
administrators the ability manage license keys, view currently assigned licenses and to reserve 
licenses.   
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For convenience, the Manage Licenses window gives counts of Total Allocated Licenses and Total 
Reserved Licenses.  The title to the right of the number is a hyperlink that will take users to the 
Manage License page with a pre-defined filter applied to the list of all Licenses.   

7.3.7- Elecosoft Powerproject Executables.  The icon will direct 
users to another site where a zip file is located.  This zip file will contain Elecosoft Powerproject, 
Elecosoft Powerproject Project Comparison, Elecosoft Powerproject Project Viewer, PennDOT 
Templates and border files, and a PDF file that has step by step instructions on how to download all 
of the files within the zip file.  These executable files are for external users only, internal PennDOT 
users should not be downloading these files. 

7.3.8- Projects Summary.  At a high level, Admins, Portfolio Managers, and ACEs are able to 
view their entire portfolio of projects at a glance.  The Projects Summary will give a summary of all 
the projects at a high level.  The following information is provided: 

• Total number of projects 
• The number of  projects that have been submitted 
• The number of projects that are ‘checked out’ 
• The number of projects that are ‘in progress’ 
• The number of projects ‘awaiting acceptance’ 
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To View the Projects Summary: 

1. Go to the Portal Homepage within the Elecosoft Powerproject Web Portal. 
 

2. Select Projects Summary.  
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The high level summary box will appear for the district the user is associated with.  Admins are the only 
people whom will see all districts. 

 

 

7.4- ELECOSOFT POWERPROJECT WEB PORTAL PROJECTS PAGE 

All projects are created and maintained via the Elecosoft Powerproject Web Portal.  As projects are 
created, progressed, and ultimately completed, they are kept in a flat file system much like what is 
seen in Windows Explorer.  When a project is created, it is placed into a folder as revision one.  As 
the projects are progressed, each progression equals one revision so projects are never overwritten.  

Note that users will only be able to see projects they have access to within the confines of their 
security level. 

To get to the Elecosoft Powerproject Web Portal Projects Page:  

1. Select Show All Projects Under Projects or select one of the hyperlinks to the right. 

 

The Projects Homepage will appear.  

 



Chapter 7: Powerproject Web Portal  Publication 615 

 7-13  

This page will have all the projects that a user has access to based on the users security permissions. 

7.4.1- Menus .  Across the top, there are several options available to users: 

 

• Create New – used to create a new Project. 
 

• Showing Projects – A selection criteria to view projects by Status (All, In-
Progress Projects, Awaiting Acceptance, Checked Out, Awaiting Progress Entry, 
or Awaiting Progress Acceptance). 
 

• Showing District – A selection criteria to view projects by District (Any, Central 
Office, District 1, District 2, District 3, District 4, District 5, District 6, District 8, 
District 9, District 10, District 11, or District 12). 
 

• Project Type – A selection criteria to either view projects by Project Type (Any, 
Bridge Alignment, Bridge Preservation / Design-Bid-Build, Bridge Preservation / 
Design-Build, Bridge Rehabilitation / Design-Bid-Build, Bridge Rehabilitation / 
Design-Build, Bridge Replacement / Design-Bid-Build, Bridge Replacement / 
Design-Build, Culvert, Environmental Assessment Project, Environmental 
Impact Study Project, Information Transportation System, Intersection 
Improvement, Interstate Maintenance, Maintenance Betterment, Other, Roadway 
Alignment, Roadway Reconstruction, Roadway Rehabilitation, Roadway 
Resurfacing, or Traffic Signals, Transportation Alternative Project.. 
 

• Project Area – A selection criteria to view projects by Project Area (Any, 
Design, Construction, Construction with Design). 
 

• Filter For Manager – A filter to view projects by  Manager 

7.4.2- Available Columns.  The following columns headings will appear on the Elecosoft 
Powerproject Web Portal Projects Homepage: 

 

• Project Name – the list of Project Names.  Clicking on the column heading will 
sort the Project Names either ascending or descending.  The filter icon will also 
allow a user to filter on the Project Names. 

 
• Status – Shows the status of all the projects listed.  Clicking on the column 

heading will sort the Project Status either ascending or descending.  The filter 
icon will also allow a user to filter on the Project Status.  The following is a list 
of the available statuses: 
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o New – When a project is first created prior to the Projects Page being 
refreshed, the project will show a status of New.  Once F5 is selected to 
refresh the page, the status will change to Checked In. 

o Checked In – The project is Checked In and is currently not being updated. 
o Checked Out – The project is Checked Out and is currently being updated. 
o Submitted – The project has been submitted. 
o Editing Progress – The project is currently being progressed. 
o Awaiting Acceptance - Progress has been submitted and is now awaiting 

acceptance from PennDOT. 
o Accepted – The progress has been accepted by PennDOT. 
o Completed – All tasks on the project have been completed. 
o Archived – The project no longer needs to be monitored. 
o On Hold – Delays have put the project on hold and it is assumed the project 

will restart at a later date. 
 

• Project Start – The start date of the Project.  Clicking on the column heading 
will sort the Project Start Date either ascending or descending.  The filter icon 
will also allow a user to filter on the Project Start Date.   
 

• Project Finish – The finish date of the Project.  Clicking on the column heading 
will sort the Project Finish Date either ascending or descending.  The filter icon 
will also allow a user to filter on the Project Finish Date. 
 

• Float – The Total Float of the Project on the longest path.  Clicking on the 
column heading will sort the Float either ascending or descending.  The filter 
icon will also allow a user to filter on the Float. 
 

• Required Attention – This column will notify a user what type of attention is 
required for the Project.  The following is a list of the available types of Required 
Attention: 

 
o Accept Project – This allows PennDOT to Accept, Accept as NNoted or 

Reject a project that was submitted. 
o Enter Progress – Allows a user to enter progress for the project. 
o Accept Progress – Allows PennDOT to Accept, Accept as NNoted or Reject 

the progress that was submitted. 
o Resolve Error – Allows the user to Recreate, Upload, or View the Logs for 

the project. 
 Recreate – Attempts to recreate the project when an error occurs. 
 Upload – Allows the user to try to re-upload the project. 
 View Logs – Shows a log of errors. 

 
• Available Operations – This column will allow a user to Select Operation.  The 

following is a list of available operations: 
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o Check Out – Allows the user to check out the project in order to make 
revisions. 

o Check In – Allows the user to upload a ‘checked out’ project back into the 
Elecosoft Powerproject Web Portal. 

o Cancel Check Out – This will override the checked out status to allow the 
user to re-checkout the projects.  If this action is performed, the previously 
checked out version of the project will no longer be allowed to be checked in. 

o Submit – Allows the user to submit the project for review. 
o Download Latest – This option will download the latest version of the 

project.  This version cannot be checked back into the Elecosoft 
Powerproject Web Portal. 

o Download… – This allows the user to choose which version of the project to 
download and which baseline to download with it.  Just like Download 
Latest, the downloaded project cannot be checked back into the Elecosoft 
Powerproject Web Portal. 

o Change Status – This is an Admin function which allows the user to forcibly 
overwrite the status of a project to one of the following: 

 
 Checked in – Project is checked in / not being updated 
 Editing Progress – The project is currently checked out and progress is 

being edited 
 Completed – All activities on the project have been completed 
 Archived – The project no longer needs to be monitored  
 On Hold – Delays have put the project on hold and it is assumed the 

project will restart 
 

o Delete Project – Allows the user to delete the project from the Elecosoft 
Powerproject Web Portal if the user has permissions to do so. 

o Failed to Create – This is a warning to the user that the project failed to 
create. 

7.4.3- Using Filters.  There are filters available using the filter icon throughout the Web Portal.  
For projects, users can filter on the following: 

• Project Name – users can select a value equal to, contains, starts with, or ends 
with a specific value. 

 
• Status  - Users can select a Value of New, Checked In, Checked Out, Submitted, 

Editing Progress, Awaiting Acceptance, Accepted, Accepted as Noted, 
Completed, Archived, or On Hold for the project status. 

 
• Project Start – users can select equals, greater than, less than, greater than or 

equals, or less than or equals to and an exact date. 
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• Project Finish– users can select equals, greater than, less than, greater than or 
equals, or less than or equals to and an exact date. 

 
• Float – users can select equals, greater than, or less than to a specific value. 

Any column that has the filter icon on the right hand side of the column can be filtered on. 

1. To Apply a Filter on the Projects Homepage:Go to the Projects Homepage within 
the Elecosoft Powerproject Web Portal. 
 

2. Select the Filter icon next to the column that the filter will be run against. 
 

 
 

3. Select the Filter Criteria. 
 

Depending on which column the user is filtering on, will depend on what filter options are available.  
In some cases, the user may have to click Apply. 

Once the filter is applied, the filter will bring back all the projects that meet the filter criteria. 
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To Cancel a Filter: 

1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 
 

2. Select the Filter   icon next to the column that the filter was applied to 
(notice the icon is now red to let the user know a filter has been applied). 
 

3. Select Clear Filter  

7.4.4- Creating a New Project 

1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 
 

2. Select Create New. 
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The Create Project page will appear. 
 

 
 
 
 
 

3. Fill out the following fields: 
 
• Name – The name of the project in the Web Portal 

 
o For Design projects, this should be the MPMS Number (for example, 99999). 
o For Pre-bid schedules, this should be the MPMS Number followed by prebid 

(for example, 99999 prebid). 
o For Construction projects, this should be the MPMS Number followed by 

CON (for example, 99999 CON). 
o For internal monitoring of Construction projects, this should be the MPMS 

Number followed by MON (for example, 99999 MON). 
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• District – Select a District from the dropdown box that the project is located in.   
 

o This option is only available with a security level of Admin.  Users creating 
new projects, other than Admins, will not have this option, the project will 
automatically be tied to the district they are set up in. 
 

• Project Area – Select which project area the project pertains to (Design, 
Construction with Design, or Construction) 
 

• Business Partner Company or Prime Contractor – Depending on what Project 
Area was selected above will depend on whether the user sees Business Partner 
Company (Design) or Prime Contractor (Construction with Design or 
Construction).  Select a Business Partner Company or Prime Contractor that 
should be associated with the project from the list by selecting Change.  This 
will be the Business Partner Firm or Prime Contractor that is working on the 
project.   Only one Business Partner Company or Prime Contractor can be 
selected, once selected, select OK.  The default is None, if it is an in-house job, 
leave as is. 

 

 
 

• Business Partner Project Manager(s) or Prime Contractor Project 
Manager(s) – All the Business Partner Project Managers from the selected 
Business Partner Firm will be within the drop down box.  Multiple people can be 
selected at one time by holding down the CTRL key.  
 

• Additional Business Partner Project Manager(s) or Subcontractor Project 
Manager(s) - Depending on what Project Area was selected above will depend 
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on whether the user sees Additional Business Partner Project Manager(s) 
(Design) or Subcontractor Project Manager(s) (Construction with Design or 
Construction).  Select an Additional Business Partner Project Manager or 
Subcontractor Project Manager that should be associated with the project from 
the list by selecting Add Manager.  A Dialogue box will pop up to select the 
Company or Subcontractor then select the invidual to add from the populated 
list.  Multiple people from the same company can be selected by holding down 
the CTRL key. 

 

 
 
• Progress Method – Select how the schedule will be progressed, either through 

Elecosoft Powerproject Client or Site Progress using the Elecosoft Powerproject 
Web Portal.   If you selected a Business Partner it will automatically default to 
Site Progress.   If it is an in-house project you have the ability to choose either.   

 
o For Design schedules, if a Business Partner is selected, Site Progress is 

selected.  If it is an in-house project (meaning None was selected under 
Business Partner Company) the user can choose either Site Progress or 
Elecosoft Powerproject Client. 
 

o For Construction with Design schedules, the user selects Elecosoft 
Powerproject Client even if a Prime Contractor was selected.   
 

o For Construction schedules, the user selects Elecosoft Powerproject Client 
even if a Prime Contractor was selected.   
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• Project Manager – List of the Department Project Managers.  Select Add 

Manager to add Project Managers to the project.  A dialog box will pop up to 
select Project Managers based off of their district.  Multiple Project Managers 
can be added at one time by holding down the CTRL key and selecting the 
Project Managers, then select Add.  Additonal Project managers can be added by 
reselecting Add Manager. 

 
 
• Template – List of the all PennDOT and District specific templates along with 

the standard Elecosoft Powerproject Templates. 
 

• Notes – Any comments or Notes about the project can be entered here. 
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4. Click Create. 
 

 

Once the project is created within the Elecosoft Powerproject Web Portal, this is just the ‘shell’ of a 
project.  The actual schedule still has to be created within the Elecosoft Powerproject Client software in 
order to add tasks, durations, logic, coding, and constraint dates.  In order to do that, the newly created 
project has to be ‘checked out’.   

Note:  There are instances where the project will not be created immediately.  If the status reads NOT 
CREATED YET, refresh the screen (F5) and the project should now be created. 

7.4.5- Checking Out a Project 

1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 
 

2. Find the Project that you want to ‘check out’ from the Project List. 
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3. Select Select Operation button. 
 

 

 
 

4. Select Check Out. 
 

 
Once a project is ‘Checked Out’, the user that checked out the project is the only person that has the 
ability to make changes to the schedule.   

 
5. Once ‘Check Out’ is selected, a ribbon will appear at the bottom of the screen.  Select 

the down arrow on the icon.  
 

 
 

6. Select Save As. 

 
 

7. Browse to where the .pp file should be saved. 
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8. Select Save. 
 

 
 

9. The ribbon at the bottom should now say the download has completed.  If the user is 
ready to work on the schedule right away, select Open, if not click the icon. 

 

 
If ‘Open’ was selected, Elecosoft Powerproject Client will open and the schedule can start to be 
developed.  Depending on which template that was selected during the creation of the project in the 
Elecosoft Powerproject Web Portal will depend on which task pools are listed, which predefined 
calendars, codes, resources, progress periods, views, filters, sorts, etc will already be created.  The task 
pools can be a starting point to develop the schedule by dragging and dropping tasks into the schedule.  
See Chapter 8 – Elecosoft Powerproject Client on how to use the software. 

 
Note: Once modifications are made to the project, save the project, do not do a ‘Save As’.  The 
location of the .pp file should never be moved from the folder that it originally was saved to during 
the checkout process.  Doing a ‘Save As’ or moving the .pp file will break the connection between 
the .pp file and the Elecosoft Powerproject Web Portal. 

7.4.6- Checking In a Project.  Once a project has been ‘checked out’ and the schedule has been 
created and finalized in Elecosoft Powerproject Client, the project needs to be uploaded (Checked In) 
into the Elecosoft Powerproject Web Portal. 

 
To Check In a Project: 

 
1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 

 
2. Find the Project that you want to ‘check in’ from the Project List. 
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3. Select Select Operation button. 

 

 
 

4. Select Check In. 
 

 
5. Select Browse to go to the file location of the .pp file to be Checked In.   
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6. Browse to the file location and select the file and click Open  

 
 

7. Select OK. 

 

The project is now checked back into the Elecosoft Powerproject Web Portal.   
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7.4.7- Submitting a Project.  Once the project is checked back into the Elecosoft Powerproject 
Web Portal, it must be submitted to PennDOT. 

To Submit a Project: 

1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 
2. Find the Project that you want to ‘submit’ from the Project List. 
3. Select Select Operation button. 

 

 
 

4. Select Submit.  

 

7.4.8- Accepting/Accepting As Noted/Rejecting a Project.  The project still is not ‘live’ 
until it is accepted by PennDOT.  Even if it is PennDOT that submits a project, the project still needs 
to be accepted.  Prior to accepting the schedule a review of the submitted schedule should be done.  
Construction with Design and Construction projects have the option to be Accepted, Accepted as 
Noted or Rejected.  Design projects can only be Accepted or Rejected, Accepted as Noted is not an 
option for Design. 

To Accept a Submitted Project: 

1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 
 

2. Find the Project that you want to ‘accept’ from the Project List. 
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3. Select Accept Project button. 

 
 

4. Select Accept.  
 

 
 
Once ‘Accept’ is selected, a dialog box will pop up. 
 

5. Provide a Baseline Name, and a Baseline Description then select OK. 
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If a project is using Site Progress (the Elecosoft Powerproject Web Portal) to progress a schedule, 
after that project is accepted, the ability to ‘check out’ or ‘check in’ the project will be gone, unless 
the status of the project is changed backed to ‘checked in’.  If changes need to be made to that 
schedule (other than progress) this needs to be coordinated with PennDOT in order for the status of 
the project to be changed to ‘checked in’ to allow access for the project to be ‘checked out’ and 
changes to be made. 

Once the project has been accepted, a copy is placed into the flat file system and “Version 2” will be 
created.  This will be the initial baseline of the project.  Now that the project is accepted, progress can 
now be input into the schedule via the Elecosoft Powerproject Client or Site Progress (Elecosoft 
Powerproject Web Portal) depending on how the project was originally set up during the creation of 
the project.  As progress is entered throughout the lifecycle of the project, matching versions are 
created as well.   

 
Note:  If a project is setup to use Elecosoft Powerproject Client to progress the schedule, every 
month the project will need to be Checked Out, progressed via Elecosoft Powerproject Client, 
saved, Checked In, Submitted, and Accepted. 

To Accept a Submitted Project as Noted: 

1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 
 

2. Find the Project that you want to  reject from the Project List. 
 

3. Select Accept Project button. 
 

 
 

4. Select Accept as Noted 
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5. Enter a reason for Accepted As Noted, supply a BaselineName and Baseline 

Description, and then select OK. 
 

 

 

To Reject a Submitted Project:  

1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 
 

2. Find the Project that you want to  reject from the Project List. 
 

3. Select Accept Project button. 
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4. Select Reject.  
 

 
 

5. Enter a reason for rejection and then select OK. 
 

 
 
Once a project is rejected, it must be ‘checked out’ again, reconfigured in Elecosoft Powerproject 
Client, ‘checked in’ and resubmitted. 

7.4.9- Downloading a Project.  A project schedule can be downloaded at any time.  When a 
project is downloaded, it creates a copy of the project that is stored in the Elecosoft Powerproject 
Web Portal.  A downloaded copy cannot be directly checked back into the Elecosoft Powerproject 
Web Portal.  

The difference between Downloading and Checkout a schedule is.   

• Downloading a schedule can be used while running what if scenarios or for the review of 
the schedule.   

 
• Checkout of a schedule should be done while updating or modifying the actual schedule 

to be accepted within the Web Portal.   

There are two options to downloading a project: 

• Download Latest – This option will download the latest version of the project.   
 

• Download… – This option allows the user to choose which version of the project to 
download and which baseline to download with it.   
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To Download the Latest of a Project: 
 

1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 
 

2. Find the Project that you want to ‘Download Latest’ from the Project List. 
 

3. Select Select Operation button. 
 

 

 
 

4. Select Download Latest. 

 

 

5. A ribbon will appear at the bottom of the screen.  Select either Open, Save, or 
Cancel. 

 

If ‘Open’ is selected, the project will automatically open in Elecosoft Powerproject Client. 
 
Note:  As a business partner, if you do not have a licensed copy of Elecosoft Powerproject, a 
project can still be downloaded and viewed in Elecosoft Powerproject Viewer as a read only 
copy. 
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To Download a Project: 
 

1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 
2. Find the Project that you want to ‘Download ’ from the Project List. 
3. Select Select Operation button. 

 
 

 
 

4. Select Download…. 

 

 

The Download Project Screen will appear. 
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5. Select the Download Version from the dropdown box, select With Baseline from the 
dropdown box, then click Download. 

 
 

 
 

6. A ribbon will appear at the bottom of the screen.  Select either Open, Save, or 
Cancel. 

 

7. If ‘Open’ is selected, a zip file will open.  Double-Click the name of the file to open 
and the project will open in Elecosoft Powerproject Client. 

 
Note:  As a business partner, if you do not have a licensed copy of Elecosoft Powerproject, a 
project can still be downloaded and viewed in Elecosoft Powerproject Viewer as a read only 
copy. 
 
The schedule can also be viewed from inside the Web Portal, which does not require Elecosoft 
Powerproject or Elecosoft Powerproject Viewer, it is a read-only version that displays the Gantt 
Chart. 
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7.4.10- Gantt Chart within the Web Portal.  The read-only version of the schedule can be 
viewed within the Web Portal using the Gantt Chart.  Users can customize which columns are shown 
within the Gantt Chart and scale the date zone to their liking.   

To View the Gantt Chart: 

1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 
 

2. Find the Project that the user wants to view the Gantt Chart. 
 

3. Select the icon on the left-hand side of the Project Name. 
 

 
 
The Gantt Chart will display. 
 

 

Additional columns can be added by right-clicking on a column heading, select Add column,, and 
choose which field to display in the column.  Columns can also be changed as to which field is being 
displayed by right-clicking on a column heading, selecting Fields, and changing the Field to display.  
Similarly, columns can also be removed by right-clicking on a column heading and selecting Remove 
column.  The splitter that separates the spreadsheet and the bar chart can be moved to show more of 
the spreadsheet or more of the bar chart by left-clicking and dragging.  The date zone can also be 
expanded or contracted by left-clicking and dragging on the red tick marks within the date zone. 
Changes to the columns and the splitter position between the spreadsheet and bar chart can be saved 
for the current user by pressing the Save Columns button.  These settings will be used for that user for 
all projects when they show the Gantt Chart. 
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7.4.11- Changing the Status of a Project.  Admin, Portfolio Managers, ACEs, and IICs have 
the ability to change the status of a project.   

To Change the Status of a Project: 

1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 
 

2. Find the Project that you want to ‘Change the Status’ from the Project List. 
 

3. Select Select Operation button. 
 

 
4. Select Change Status. 

 

 

A Status Change Dialog Box will appear.  
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5. Select what the New Status should be changed to from the dropdown box and add an 
Optional Comment if desired.  Click OK. 

 

The options available for the new status are as follows: 

• Checked in – If changes to an approved schedule have to be made, the status of 
the project must be changed to Checked In in order for a Project Manager or 
Business Partner to be able to ‘check out’ the project and make modifications. 
 

• Editing Progress – If progress needs to be entered into the schedule, and the 
Enter Progress button is not available, change the status of the project to ‘editing 
progress’. 
 

• Completed – This should be selected when the project has been completed. 
 

• Archived – This should be selected when the project no longer needs to be 
monitored. 
 

• On Hold – This should be selected when delays have put the project on hold and 
it is assumed the project will restart. 
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7.4.12- Cancel Check Out of a Project.  This will override the checked out status to allow the 
user to re-checkout the projects.  If this action is performed, the previous checked out version of the 
project will no longer be allowed to be checked in. 

To Cancel Check Out of a Project: 

1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 
 

2. Find the Project that you want to ‘Change the Status’ from the Project List. 
 

3. Select Select Operation button. 
 

 

 
 

4. Select Cancel Check Out. 

 

 

5. A dialog box will pop up, select Yes to cancel the ‘check out’, or Cancel. 
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7.4.13- Deleting a Project from the Elecosoft Powerproject Web Portal 

1. Go to the Projects Homepage within the Elecosoft Powerproject Web Portal. 
2. Find the Project that you want to ‘Delete’ from the Project List. 
3. Select Select Operation button. 
 

 
 

4. Select Delete Project. 

.

  

5. A dialog box will pop up, select Yes to delete the project, or Cancel. 

 

If Yes is selected, the project will be removed from the project list, but will be placed in the recycle 
bin of the Web Portal.  From the recycle bin, the project can be permanently deleted or can be 
restored to the project list. 
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7.5- ELECOSOFT POWERPROJECT WEB PORTAL PROGRESS PAGE 

The purpose of this section is to allow users to see their respective projects that require progressing via the 
Elecosoft Powerproject Web Portal.  The Progress section shows projects that are in the queue to be 
progressed via Site Progress. 

Projects can be progressed in two ways:  

• By checking out the project and updating progress within the individual project file. 
 

• By updating progress through the Elecosoft Powerproject Web Portal Site Progress. 

This section will walk through the process of progressing via Site Progress.  Progressing through the 
individual project file is explained in Chapter 8 - Elecosoft Powerproject Client. 

To get to the Elecosoft Powerproject Web Portal Progress Page: 

1. Select Show In-Progress Projects Under Progress. 

 

The In-Progress Projects Homepage will appear. 

 

7.5.1- Entering Progress 

1. On the In-Progress Projects Homepage, navigate to the Project Name that you want 
to enter progress for. 
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2. Select Enter Progress, under Required Attention.  
 

 
 
 
 
 
The Turnaround Tasks Homepage will appear. 
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3. Under Look ahead, select the date range of activities to view and enter progress on.  
Options are 30 days, 60 days, 90 days, or All Tasks.  

 

 
 

4. If this is a milestone task, Enter an Actual Start Date.   
 

The box beside Milestone Complete will automatically become checked and an Actual Finish Date 
will also automatically be input matching the Actual Start Date that was entered. 
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-Or- 
 

4. If this is not a milestone task, Enter an Actual Start Date, slide the bar across to the 
appropriate Percent Complete value or type in a Percent Complete.  If the activity is 
100% complete, an Actual Finish Date must be entered. 

As the percent complete increases, the days remaining value will decrease automatically. 
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5. Notes can be added to a task by selecting the  icon next to the task.  A dialog box 
will appear to type the Note in.  Once the Note is entered click OK. 

 

 
 

6. Once all progress and / or Notes are entered for the task or tasks, either select the Save 
or Submit button.   

 
• Save should be selected if you have more progress to enter on the project. 

 
• Submit should only be selected once all progress has been entered.   

Note:  Once progress is submitted, users cannot enter more progress until it is accepted or rejected 
by PennDOT.  Every time progress is submitted and accepted, a new progress date must be 
supplied by the user accepting the progress. 

7. If additional progress needs to be entered into the schedule, repeat steps 3, 4, and 5. 
8. Once Submit is selected, a dialog box will appear. 

 

 
9. Select Yes. 

7.5.2- Accepting Progress.  Once a Business Partner submits their updates, PennDOT must 
accept /accept as noted/ reject the updates as required.  Construction with Design and Construction 
projects have the option to be Accepted, Accepted as Noted or Rejected.  Design projects can only be 
Accepted or Rejected, Accepted as Noted is not an option for Design.  Only Project Managers and 
IICs or anyone above those roles may accept updates.  Before accepting updates, reviewers are 
encouraged to download the latest version of the project so they can see what exactly has been 
updated.   

1. On the In-Progress Projects Homepage, navigate to the Project Name that you want 
to accept progress for.  The project will be in “Awaiting Acceptance” status. 
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2. Select Accept Progress, under Required Attention. 
 

 
 

The Accept Progress Homepage will appear. 

 
 

3. Review the progress that was submitted. The Accept Progress window is set up such 
that the user can compare “Old” versus “New”.  Review the progress. 
 

4. If all the progress looks good, click Accept All. 
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5. A pop up window will appear to select a progress period date.  A date can manually be 
typed in or a date can be selected from the calendar, the default date is the last day of 
the current month.   

 

 
 

6. Once a date is selected, click OK.   

Once PennDOT selects “Accept All”, a new version is created with the updates applied to the project.  
The project is now rescheduled based on the date that was selected including all the current progress 
that was accepted.   
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7.5.3- Rejecting Progress 

1. On the In-Progress Projects Homepage, navigate to the Project Name that you want 
to accept/reject progress for.  The project will be in “Awaiting Acceptance” status. 

2. Select Accept Progress, under Required Attention.  

 

The Accept Progress Homepage will appear. 

 
 

3. Review the progress that was submitted.  The Accept Progress window is set up such 
that the user can compare “Old” versus “New”.  Review the progress. 
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4. If all progress needs rejected, select the Reject Everything checkbox. 

 
 

-Or- 
 

4. If individual progress entries need rejected, select the task(s) progress that is rejected 
(the activity will be shaded in red). 
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5. If progress is rejected (any or all), an overall reject comment must be entered.  A task 
comment is recommended, but not required. 

 

6. Select Reject.  

7.6- ELECOSOFT POWERPROJECT WEB PORTAL USERS PAGE 

To get to the Elecosoft Powerproject Web Portal Users Page, select Manage Users, under Users. 
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The Users Homepage will appear.  
 

 
 

This feature allows Portal Admins to add or delete users within the Elecosoft Powerproject Web Portal.  It 
also allows Portal Admins to change user  credentials, such as first or last name, what type of user they 
are, which District or Business Partner they belong to, add or change their email address, and also add a 
description to that user. 
 
 
 
 
 
 
 
 

7.6.1- Adding Users 

1. On the Users Homepage, select Create User. 
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The Create User screen will appear. 

 
 

2. Name – CWOPA Username or ECMS Username. 
 

3. User Type – Select which type of user this will be.  
 
• If Admin or Team Member is selected, the District automatically goes to Central 

Office, and cannot be changed.  Also, the Business Partner will be grayed out. 
 

BP0001 
XYZ Consultants 
ABC123 Engineering 
Engineering Firm 12 
Business Partner 5 
Firm #1 
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• If Business Partner is selected, the District dropdown box gets grayed out.   
 

4. District – Select which District the user is associated with.   
 
• This option is only available if Portfolio Manager, Project Manager, ACE, or 

Inspector in Charge is selected as a User Type. 
 

5. Business Partner Company – Select which Business Partner the user is associated 
with. 

 
• This option is only available if Business Partner is selected as a User Type. 

 
6. First Name – Enter the user’s first name. 

 
7. Last Name – Enter the user’s last name. 

 
8. Email – Enter the user’s email address. 

 
9. Description – Enter a description for the user, such as phone number, but this field is 

not required. 
 

10. Click Save. 

7.6.2- Deleting Users 

1. On the Users Homepage, find the user that needs to be deleted. 
 

2. Select Delete next to the User’s Name, under Action. 

 

 

 

 

 



Chapter 7: Powerproject Web Portal  Publication 615 

 7-53  

3. A dialog box will appear with a warning.  Select OK or Cancel. 

 

7.6.3- Modifying Users 

1. On the Users Homepage, find the user that needs to be modified. 
 

2. Select Name of the user, under the Name column. 
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The Edit User page will appear. 

 
 

3. Modify the fields that are necessary.  Note that, the fields available for modification 
depend on the User Type (see above under Creating Users). 
 

4. Click Save. 
 

 

 

 

BP0001 
XYZ Consultants 
ABC123 Engineering 
Engineering Firm 12 
Business Partner 5 
Firm #1 
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7.7- ELECOSOFT POWERPROJECT WEB PORTAL BUSINESS PARTNERS PAGE 

To get to the Elecosoft Powerproject Web Portal Business Partners Page, select Manage Business 
Partners, under Business Partners. 

 

 
 

The Business Partner Companies Homepage will appear.  
 

 
 

This feature allows Portal Admins to add or delete Business Partner Companies within the Elecosoft 
Powerproject Web Portal.  It also allows Portal Admins to change Business Partner Company credentials, 
such as Business Partner Company names or change their email address. 

7.7.1- Adding Business Partner Company 

1. On the Business Partner Companies Homepage, select Create New. 
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The Create Business Partner Company screen will appear. 
 

 
 

2. Enter the name of the Business Partner Company. 
 

3. Enter the Business Partner Company’s Admin’s Email Address. 
 

4. Click Create. 
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7.7.2- Deleting Business Partner Company 

1. On the Business Partner Companies Homepage, find the Business Partner Company 
that needs to be deleted. 
 

2. Select Delete next to the Business Partner Company’s Name, under Action. 

 

3. A dialog box will appear with a warning.  Select OK or Cancel. 
 

 

7.7.3- Modifying Business Partner Company 

1. On the Business Partner Companies Homepage, find the Business Partner Company 
that needs to be modified. 
 

2. Select Name of the Business Partner Company, under the Name column. 

 

 

 



Chapter 7: Powerproject Web Portal  Publication 615 

 7-58  

The Edit Business Partner page will appear. 

 

3. Modify the fields that are necessary.   
 

4. Click Save. 

 
 

7.8- REPORTING IN THE WEB PORTAL 

All users can create, save, edit and run reports directly in the Web Portal.  There are two types of reports 
that can be created: 

• Matrix reports are a series of sections, where each section represents a project.  The sections 
are divided into several columns and rows that show information about each project and tasks 
within that project. 
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• Linear reports are a series of rows, with each single row representing a project, which will 
show information about each project and tasks within that project. 

The reporting functionality can be accessed via the main Portal page: 

 

 

Clicking on the Reporting link will take the user to the Reports Page. 

 

Users can create a new report by either clicking on the Create Linear Report or Create Matrix Report 

 

7.8.1- Creating Linear Reports 

1. On the Reports Page, select Create Linear Report 
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The Create Linear Report Page will display. 
 

 
 

2. Give the report a Name 
 

3. OPTIONAL Select which Project Fields to add by selecting Add Project Field 
 

 
 

4. OPTIONAL Use the dropdown box to select which Project Field(s) to add.   
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• If additional Project Fields need to be added, continue to select Add Project Field 
and select another Project Field.   

 
• Project Fields can be reordered by using the to drag and drop to new 

locations.  
 
•  A Project Field can be removed by selecting the button. 

 
5. Select which Key Tasks to add by selecting Add Key Task. 

 

 
 

6. Use the dropdown box to select which Key Task(s) to add or manually type in a Key 
Task name to report on, select which attribute to show for the key task, and type in a 
Column name. 
 

 
 
• If additional Key Tasks need to be added, continue to select Add Key Task and 

select another Key Task from the list, or manually type in a Key Task name.   
 

• Project Fields can be reordered by using the to drag and drop to new 
locations.  
 

•  A Project Field can be removed by selecting the button. 
 

• If no column name is provided, the report will default to “key task name – 
attribute name”, for example “Advertise Project – Late Start/Actual Start”. 

 
7. OPTIONAL Select which District projects to include on the report by selecting Add 

District. 
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8. OPTIONAL Use the dropdown box to select which District(s). 
 

 

 
• If additional Districts need to be added, continue to select Add District.   

 
• A District can be removed by selecting the button. 

 
• Admins and Team Members are the only users who can filter on districts, all 

other users only see projects specific to their district. 
 

9. OPTIONAL Select which Manager to Filter by selecting Add Manager. 
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10. OPTIONAL Use the dropdown box to select which District and select a Manager 
from the list. 

 

 
 

11. OPTIONAL Click Ok 

 
 
• If additional Project Managers need to be added, continue to select add manager 

and select a District and a Manager from the list.   
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•  A Manager can be removed by selecting the button. 
• Project Managers, Inspector in Charge, and Business Partners will not be able to 

filter on Managers, they will only see their own project information. 
 

12. OPTIONAL Select which Project Type to Filter by selecting Add Project Type. 

 

13. OPTIONAL Use the dropdown box to select which Project Type(s). 
 

 

 
• If additional Project Types need to be added, continue to select Add Project 

Type.   
 

• A Project Type can be removed by selecting the button. 
 

14. OPTIONAL Select which Role to Share with by selecting Add Role to Share. 

  

15. OPTIONAL Use the dropdown box to select which Project Type(s). 
 

 

 
• If additional Roles to Share need to be added, continue to select Add Role to 

Share.   
 

• A Role can be removed by selecting the button. 
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16. OPTIONAL Select which field to Sort the report by selecting Add Sort Field. 
 

 
 

17. OPTIONAL Use the dropdown box to select which Field to Sort on and which way 
to sort. 

 

 
 

• If additional Sorts need to be added, continue to select Add Sort Field.   
 

• A Sort can be removed by selecting the button. 
 
 

18. OPTIONAL Select the Task look-ahead or Project Range by using the dropdown 
box next to Range.  Use the dropdown box to select the Task lookahead in days or 
the Project lookahead year or manually type in a range. 

 

 

  

19. Once the report is all set up, click Run, Run and Save, or Save. 
 

• Run will run the report right away. 
 

• Run and Save will run the report right away but will also save the report so that 
it appears in the list of reports on the Reports Page. 
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• Save will just save the report so that it appears in the list of reports on the 
Reports Page, but will not run. 

 

 

7.8.2- Creating Matrix Reports 

1. On the Reports Page, select Create Matrix Report. 
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The Create Matrix Report Page will display. 
 

 
 

2. Give the report a Name. 
 

3. OPTIONAL Select which Project Fields to add by selecting Add Project Field. 
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4. OPTIONAL Use the dropdown box to select which Project Field(s) to add.   
 

 
 
• If additional Project Fields need to be added, continue to select Add Project Field 

and select another Project Field.   
 

• Project Fields can be reordered by using the to drag and drop to new 
locations.  
 

•  A Project Field can be removed by selecting the button. 
 

5. Select Task Field to add by selecting Add Task Field. 
 

 
 

6. Use the dropdown box to select which attribute to show for the task and type in a 
Field name alias. 

 

 
• If additional Task Fields need to be added, continue to select Add Task Field and 

select another attribute from the list.   
 

• Task Fields can be reordered by using the to drag and drop to new 
locations.  
 

•  A Task Field can be removed by selecting the button. 
 

• If no Field name alias is provided, the report output will default to using the text 
shown in the combo boxes. 

 

 
 
 
 

 



Chapter 7: Powerproject Web Portal  Publication 615 

 7-69  

7. Select which Tasks to add by selecting Add Task. 
 

 
 

8. Use the dropdown box to select which Key Task(s) to add or manually type in a Key 
Task name to report on and type in a Column name. 

 

 
 

• If additional Key Tasks need to be added, continue to select Add Task and select 
another Key Task from the list, or manually type in a Key Task name.   
 

• Key Tasks can be reordered by using the to drag and drop to new 
locations.  
 

• Key Tasks be removed by selecting the button. 
 

• If no column name is provided, the report output will default to using the text 
shown in the combo boxes. 

 
9. OPTIONAL Select which District projects to include on the report by selecting Add 

District. 

 

10. OPTIONAL Use the dropdown box to select which District(s). 
 

 

• If additional Districts need to be added, continue to select Add District.   
 

• A District can be removed by selecting the button. 
 



Chapter 7: Powerproject Web Portal  Publication 615 

 7-70  

• Admins and Team Members are the only users who can filter on districts, all 
other users only see projects specific to their district. 

 
11. OPTIONAL Select which Manager to Filter by selecting Add Manager. 

 

12. OPTIONAL Use the dropdown box to select which District and select a Manager 
from the list. 
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13. OPTIONAL Click OK. 

 
 
• If additional Project Managers need to be added, continue to select Add Manager 

and select a District and a Manager from the list.   
 

•  A Manager can be removed by selecting the button. 
• Project Managers, Inspector in Charge, and Business Partners will not be able to 

filter on Managers, they will only see their own project information. 
 

14. OPTIONAL Select which Project Type to Filter by selecting Add Project Type. 

 

15. OPTIONAL Use the dropdown box to select which Project Type(s). 
 

 

• If additional Project Types need to be added, continue to select Add Project 
Type.   
 

• A Project Type can be removed by selecting the button. 
 

16. OPTIONAL Select which field to Sort the report by selecting Add Sort Field. 
 

 
 

17. OPTIONAL Use the dropdown box to select which Field to Sort on and which way 
to sort. 
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• If additional Sorts need to be added, continue to select Add Sort Field.   
 

• A Sort can be removed by selecting the button. 
 

18. OPTIONAL Select which Role to Share with by selecting Add role to Share. 

  

 

19. OPTIONAL Use the dropdown box to select which Project Type(s). 
 

 

 
• If additional Roles to Share need to be added, continue to select Add Role to 

Share.   
 

• A Role can be removed by selecting the button. 
 

20. OPTIONAL Select the Task look-ahead or Project Range by using the dropdown 
box next to Range.  Use the dropdown box to select the Task lookahead in days or 
the Project lookahead year or manually type in a range. 

  

21. Once the report is all set up, click Run, Run and Save, or Save. 
 

• Run will run the report right away. 
 

• Run and Save will run the report right away but will also save the report so that 
it appears in the list of reports on the Reports Page. 
 

• Save will just save the report so that it appears in the list of reports on the 
Reports Page, but will not run. 
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7.8.3- Running Reports.  Running reports can be done when the report is created, as shown 
above, or can be done on the Reports Page.  Once a report is created and saved, it can be run at any 
time.   

1. On Report Page, find the name of the report to run, and select Run. 
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The report will display. 

 

7.8.4- Printing Reports.  Once the report has been generated it can be printed, by selecting the 
Print icon.   

 

7.8.5- Exporting Reports.  A list of available export options are available, select the format to 
export the report to.. 
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Once the format is selected, click the Export Report icon. 

 

The report will export and open in a new window. 
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7.8.6- Editing an Existing Report.  A report can be edited at any time depending on access 
rights.   

1. Go to the Reports Page and select the report name.   

The Edit Report Page will open. 

 

2. Any of the Fields can be modified, once modifications are made, select Run, Run 
and Save, or Save. 
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7.8.7- Copying a Report.  If you do not wish to overwrite an existing report, users can copy an 
existing report and modify the copy. 

1. On the Report Page, find the report you wish to copy and modify.  Under Available 
Operations, click Select Operation.   

 

2. Select Copy. 

 

3. Once the report is copied, select the report name – copy, which will open the Edit 
Report Page.  Modifications can then be made to the report, including changing the 
report name.  Once all modifications are made, Save the report and Run.   

7.8.8- Deleting a Report.  A report can be deleted at any time, depending on access rights.   

1. On the Report Page, find the report you wish to delete.  Under Available Operations, 
click Select Operation.   
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2. Select Delete Report. 

 

3. A dialogue box pop up and warm the user that the report will be permanently deleted 
with OK and Cancel options.  

 

 

Once a report is deleted, it is permanently gone, reports do not go into the recycle bin.  
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7.9- REQUESTING A LICENSE 

Business Partners will need to download the executable file for Elecosoft Powerproject client from the 
Elecosoft Powerproject Web Portal.  Once the software is installed,the software will need to be activated.   
In order to activate the software, a license will have to be requested.  Please Note a license will only be 
given out to a business partner that has a contract that requires a schedule.  This license will only be good 
for 90 days until the schedule is created, submitted, and accepted.  The license can be renewed after the 
expiration period if deemed necessary 

7.9.1- To Request a License: 

1. Open Elecosoft Powerproject. 
 

2. Select Activation. 

 
 

 

3. Select Activate.  
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4. Select Copy in order to copy the Request Key. 
 

 
 

5. Minimize Elecosoft Powerproject and log into the Elecosoft Powerproject Web 
Portal. 

 
The Elecosoft Powerproject Web Portal Homepage will appear. 
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6. Go to the Projects Homepage by selecting Show All Projects. 
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7. Find the Project to request a license for from the Project List and click on the Project 
Name. 

 
8. Select Request License. 

 
 

 
 

9. Copy the Request key from the activation wizard in Elecosoft Powerproject. 
10. Click Generate. 
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11. A license code will generate. 

 
 

12. Copy the License Code. 
 

13. Minimize the Elecosoft Powerproject Web Portal and go back into Elecosoft 
Powerproject and select Activate if the pop up window is closed.   
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14. Select the Next > button.   
 

 
 

15. Paste the License Code from the Elecosoft Powerproject Web Portal into Elecosoft 
Powerproject. 
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16. Select Finish 
17.  Select OK 

 

 

 

 

 

 

 

 

 

 

 

For any questions or problems please contact the Elecosoft Powerproject Helpdesk at 717-775-8140 
or RA-PDASTAPWRPROJ@pa.gov 
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7.10- WEB PORTAL PROCESS FLOW 

7.10.1- Design Process Flow.  The following process map outlines the interaction and 
functionality for design of the portal and users:  
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7.10.2- Construction Process Flow.  The following process map outlines the interaction and 
functionality for construction of the portal and users:  
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CHAPTER 8 - ELECOSOFT POWERPROJECT CLIENT 

8.0- PURPOSE 

The purpose of the Elecosoft Powerproject Client software is to create the actual schedule.  The “shell” of 
the project will be created via the Elecosoft Web Portal.   Once the “shell” is created, it will have to be 
checked out and opened within Elecosoft Powerproject.  Elecosoft Powerproject is where the schedule 
will be developed.  Tasks, durations and logic tying the tasks together, along with constraint dates will 
make up the project schedule.   

This chapter will walk you through the basics of how to use the software for standalone projects.  Due to 
the use of the Elecosoft Web Portal, some steps may not apply to PennDOT.  Please Note that these 
instructions are for use within the Elecosoft Powerproject Client.  A lot of what is contained within this 
chapter is additional information on the basic use of the software. 

8.1- BASICS 

Elecosoft Powerproject is designed to provide the tools that a project manager needs to create project 
schedules, update project progress, and communicate the status of projects to the project team. 

Elecosoft Powerproject follows many of the rules for Windows: 

• Left-click will usually select an item. 
• Double-click will activate it. 
• Right-click gives you a menu to make changes. 
• Click and drag will move an item from one part of the screen to another or will 

select multiple items. 
• Shift button will allow you to select adjacent items. 
• Control button will select non-adjacent items. 
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8.1.1- Starting a New Project 

1. Select the File tab. 
2. Select New. 

 

3. Select a template on which to base your project. 
• For Design schedules, select either the PennDOT Master Template or a District 

specific Template 
• For Pre-bid schedules, select the PennDOT Pre-bid Template 
• For Construction schedules, select the PennDOT Construction Template 
• Selecting New from Existing allows users to select an existing project to create a 

new project from (similar to a save as but with the ability to delete all progress 
from the existing schedule) 
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4. Enter the details on the new project. 

 

 

 

• Filename – The name of the project.  
o Design schedules = MPMS Number. 
o Pre-bid schedules = MPMS Number followed by PREBID (99999 PREBID) 
o Construction schedules = MPMS Number followed by CON (99999 CON) 
o Monitoring of Construction schedules = MPMS Number followed by MON 

(99999 MON) 
• Title – The print title. 

o This should be the same as the Filename. 
• For – Who the project is for. 

o Engineering District X-0 (X being the District Number). 
 

• By – Who the project is by. 
o Who is creating the schedule, PennDOT (for internal projects) or the 

Business Partner Company Name. 
• Start – The start date for the whole project. 
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• Optionally you can enter a User Name and Password, but this is not 
recommended for PennDOT projects. 
 

5. Once these details have been entered, click Create. 

 

8.1.2- Opening an Existing Project 

1. Select the File tab. 
2. Select Open.  
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Choose the location the file is saved: Recent, This PC, Elecosoft Powerproject Vision, and Browse.   

 

• When Recent, This PC and Elecosoft Powerproject Vision are selected schedules 
will be displayed to the right.   

 

• If your project has not been opened recently, select Browse. 



Chapter 8: Elecosoft Powerproject Client  Publication 615 

8-6 

 

• Then select the file you wish to open. 

 

3. Select Open.  
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8.1.3- Saving 

To Save a Project: 

1. Selecting the Save button on the quick access tool bar. 

 

 

-Or- 

1. Go to the File tab and select Save. 
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To Save a Project Under a New File Name: 

1. Go to the File tab.and select Save As.  

 

2. Select where you wish to save the project, enter a New File Name, choose a File 
Type, click Save.  

 

 
 

Note:  If a project was created in the Elecosoft Powerproject Web Portal, doing a File, Save As will 
break the connection and versioning of the project and will not allow the project to be ‘checked in’ 
to the Elecosoft Powerproject Web Portal. 
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8.1.4- Closing a Project   

1. Close the project tab using the ‘X’ next to each tab. 

 

-Or- 
 
 

1. Go to the File tab and select Close. 

 

If the project has not been saved you will be prompted to do so. 

8.1.5- Existing Elecosoft Powerproject 

1. Click on the  at the top right of the screen. 
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Note:  If you try to close an individual project, or the Elecosoft Powerproject software altogether, 
without saving, Elecosoft Powerproject will ensure you do not accidentally lose changes by  asking 
if you want to save:  

 

  

 

 

8.2- ELECOSOFT POWERPROJECT SCREEN AREAS 

This section covers the general layout of the Elecosoft Powerproject working area. 
 

The Elecosoft Powerproject screen is divided into a number of areas. This may vary for existing projects 
where the layout has been changed to suit the needs of the user: 
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• Ribbon – Contains the commands for your project. 

• Project View – Shows the structure of your project and shows the list of library 

items available. 

• Bar Chart – Information on your project in graphic form, your Gantt Chart. 

• Date zone – Showing dates for years, months, weeks etc. 

• Spreadsheet – Information on your project in tabular form. 

• Properties View – Allows you to edit the properties of a selected object. 

• Object Edit Toolbar – Used to edit tasks and/or links in the bar chart. 

 

8.2.1- The Project View 

The project view shows the structure of your project and shows the list of library items available. 

Before starting any project, whether it is a design, pre-bid, or construction project, additional details and a 
description of the project should be identified such as County, State Route, Section, and Local Name. 

To Add Details to the Project View: 

1. In the Project View, right-click on the globe icon identified as Project/Program 
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2. Select Rename 
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3. Rename both the Bar Title and Task Title to include County, State Route, Section, 
and Local Name 

 
 

4. Click OK 

To Hide the Project View Area:  

1. Selecting the Format tab and clicking the  icon. 

 

-Or- 

1. Selecting the  icon on the bottom Object Edit Toolbar: 

 

To Resize the Project View Area: 
 

1. Place the cursor over the left edge of the Spreadsheet area. The cursor will become a 
double sided arrow. Drag this to the right of the screen. 

8.3- CALENDARS 

Calendars define the working and non-working time within a project. The Calendar consists of a planned 
pattern of work to which exceptions can be added. An exception is any day which does not conform to the 
planned pattern of work, e.g., holidays or overtime. 

The standard PennDOT Calendar Files are within all of the PennDOT templates.  The standard PennDOT 
Calendar Files identify holidays and weekends, unless otherwise Noted.   For design and pre-bid 
schedules, the predefined PennDOT calendars should always be used.  For construction, the predefined 
PennDOT calendars can be used, however it is the sole discreation of the contractor; the contractor is able 
to use their own calendars.   
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8.3.1- To Display a List of Available Calendars 

1. In the Project View, open the calendars folder using the + symbol. 

  

• Sub folders are opened in the same way. 

• The Default Calendar is shown with the red tick icon. 

The calendar which is set as default means that any new task you create will follow that calendars work 
pattern. 

You will need to select which calendar is the closest to your working week and set that as the default. 
 

8.3.2- Creating a New Calendar 

1. In the Project View, right-click on Calendars. 
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2. Select New Calendar. 

 
3. Select a Calendar Type, click Next. 

• Use Simple for calendars where using a single shift. 

• Use Work Patterns when multiple shifts are required within a given calendar 

day. 
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4. Provide a name for the calendar, click Next.  
 

 

5. Determine the working time for the calendar, click Next. 
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6. Define exceptions (Holidays, non-working time), click Next. 
 

 

7. Set options, click Finish. 
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Or another way to create a calendar is to do so using the Library Explorer. 

1. Select the Open Library Explorer icon. 
 

2. Select Calendars. 
 

3. Right-click in the Right Pane and select New Calendar. 
 

4. Select a Calendar Type, click Next. 
 
• Use Simple for calendars where using a single shift. 

• Use Work Patterns when multiple shifts are required within a given calendar 

day. 

• Use Work Patterns when multiple shifts are required within a given calendar 

day. 
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5. Provide a name for the calendar, click Next.  
 

 

6. Determine the working time for the calendar, click Next. 
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7. Define exceptions (Holidays, non-working time), click Next. 
 

 

8. Set options, click Finish. 
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8.3.3- To Select Which Calendar You Wish to Use as the Default 

1. Right-click on the calendar you wish to set as the default.  
2. Select Task Default from the list. 

 

3. The tick will move to the new default calendar. 

Once the default calendar has been selected, you can then edit the calendars properties to the specific 
working patterns of this project. 
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8.3.4- Editing an Existing Calendar: 

1. Right-click on the calendar you wish to edit. 
2. Select Properties.  

The Calendar Properties Dialogue Box opens. 

 

Each day in the Calendar has a working pattern assigned to it. An exception is any day which does not 
follow that working pattern.   

Each day has a period of working and non-working time assigned.  
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To View Working and Non-working Times: 
 

1. Double-click on the day you wish to view. The day will open in a separate pop up, 
showing the working and non-working time during that day.  

 

You can add additional exceptions to the calendar to show additional holidays, shut down days or 
additional weekend working.  
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To Add an Exception: 
1. Left-click on the date you wish to select. If you wish to select more than one date, 

you will need to hold the CTRL key and click on each date (the selected dates will be 
highlighted in blue). 
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2. Click Add Exception. 
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3. Choose which Exception type you wish to add. 

 

4. Choose the period of time you wish the exception to last for in the Exception period 
section. 

• Specific start and end times – allows you to set the start and finish of the time 
to the nearest 30 minutes. 

• From work pattern periods – matches the morning and afternoon to those 
already set for the calendar.  (This option will produce the best results) 

• 24 hour exception – will add the selected exception for the whole 24 hours of 
the day. 
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5. Click Add.  

 

To Remove an Exception: 
 

1. Left-click on the date you wish to select. If you wish to select more than one date, 
you will need to hold the CTRL key and click on each date (the selected dates will be 
highlighted in blue). 
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2. Click Delete Exception. 
3. A pop up will appear asking if you are sure you wish to delete the exceptions. If you 

are, select Yes, if not select No. 

 

 

8.4- CREATING A PROJECT 

A project is a series of tasks which must be completed to achieve a set of objectives. The Spreadsheet 
displays the task information and the GANTT chart (Bar Chart) shows the tasks in their date position and 
duration.  

 

A task is a unit of work with a duration.  Tasks can be created on the Spreadsheet or drawn onto the 
GANTT chart and they can be linked to show relationships between them to create the critical path.  You 
can create more than one task on the same bar to show repetitive or intermittent working.  Task names can 
be used to describe the task, and should be unique, although the program does allow task names not to be 
unique. 

8.4.1- Creating Tasks.  A task can be created by either typing the duration into the column on the 
Spreadsheet, or by using the cursor to draw onto the Bar Chart. Once created, any aspect of the task 
can be edited using either the Spreadsheet or using the mouse on the task bar. 

Once a schedule is created using a template, it will need to be modified to conform to the project. Any 
task that pertains to the project should be tracked in the schedule. Sometimes this will necessitate the 
use of duplicate activities. For example, if a project has multiple structures, each individual structure 
should be tracked separately in the schedule.  

For design schedules, if the task is not listed in the PDSMASTER, a nonstandard PennDOT task can 
be created.  Any task that is added to a schedule that is not part of the PDSMASTER template is 
considered a non-standard PennDOT task. The PDSSTANDARD code field is used to screen non-



Chapter 8: Elecosoft Powerproject Client  Publication 615 

8-29 

standard activities out of the Department’s historical data. A “1” is assigned to all standard activities – 
those found in the PDSMASTER template. Any task that is added outside of these standard activities 
should be assigned a “2.” (See Section 8.12 – Code Libraries) 

To Create Tasks in the Spreadsheet 
 

1. Left-click in the Name column of the first task of the table. 
2. Type the name of the task and press Enter. 
3. Left-click in the Duration column of the first task of the table. 
4. Type the duration you wish into the column and press Enter.  

Any duration unit can be used by adding the appropriate letter after the number, i.e. d for days and w for 
weeks. 

A task is displayed on the Bar Chart. 

 

5. Continue to add activities in the spreadsheet by typing in the name and duration of 
each activity. 

For consistency, all durations assigned to activities will be in working days.  Historic durations for many 
activities are contained in the templates. 

In regards to design schedules, for activities which are to be completed by the District, these durations 
may be changed provided the changes are made with a sound understanding of the project’s needs and 
typical review times.  For reviews involving Central Office staff or FHWA, the durations contained 
within the PDSMASTER should be considered as minimums. Generally, these review periods are 15 days 
for Bureau of Project Delivery reviews and 25 days for FHWA reviews.  
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To Create Tasks on the Bar Chart 
 

1. Place the mouse cursor in the Bar Chart on the line for the task, the cursor will now 
be a cross. 

2. Left-click and drag the mouse to the right. 
• A pop up box displays the start, finish, and duration of the task. 

3. Release the mouse button when the task is set to the desired duration. 

 

 

• After the mouse button is released, he task will remain selected (highlighted in 
black). 

4. Click away from the task to deselect it & it is displayed green again. 
• A Task Name will still need to be typed in the spreadsheet. 
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8.4.2 Moving and Editing Tasks.  Tasks can be moved and edited using either the mouse or the 
Object Edit Toolbar. 

To Edit the Tasks on the Bar Chart 
 

1. Place your cursor on the task you wish to edit.  
2. Your cursor will change to one of these shapes: 

 Select /move task: 
Place mouse cursor in the 
centre of a task. Left-click & 
drag. 
While this cursor shape is 
showing an item can be 
selected or moved.  

 
 
 
 

Adjust start date of task: 
Place mouse cursor at start of 
a task. Left-click & drag. 
While this cursor shape is 
showing the start date of a 
task can be moved without 
affecting the end date. 

 
 
 
 

Adjust end date of task: 
Place mouse cursor at the end 
of a task. Left-click & drag. 
While this cursor shape is 
showing the end date of a task 
can be moved without 
affecting the start date.  

 
To Edit Tasks on the Object Edit Toolbar: 

 
1. Select a task on the Bar Chart using the                  cursor as shown above. 
2. The Object Edit Toolbar is now displayed at the foot of the screen. 

 

 

 

 

8.4.3- Moving Tasks Vertically.  When you have listed out your task you are still able to 
change the order of those tasks at any time. 

 

To Move a Task to the Top of the Project: 

To move date 
position of selected 
tasks - earlier/later. 

To change 
start date of 
selected tasks. 

To change 
end date of 
selected tasks. 
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1. Left-click on the line number for the task you want to move (the line will be 
highlighted). Place your cursor on the task in the bar chart, you should see the                  
cursor. 

 

 

2. Click and drag the bar to the new line above. 

8.4.4- Inserting Tasks.  You can insert new lines into your project to put new tasks on or just to 
space existing tasks for formatting purposes. 

1. On the line number below where you want to insert your new line Right-click and 
select Insert Bar or press insert on your keyboard or select Insert Bar Below.  
• Insert Bar – will insert a bar above the selected line. 
• Insert Bar Below – will insert a bar below the selected line 

 

A blank bar will be inserted above or below the currently selected bar. 

8.4.5- Milestones.  Milestones are used to display key dates or events in our project and have zero 
duration. 
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To Create a Milestone 
 

1. Name the task in the normal way. 
2. Enter 0 (zero) in the duration column. The 0 will not display as the default is to not 

show zeros, but a diamond symbol will now appear in the bar chart. 

 

Milestones can be either a Start or Finish milestone. Start Milestones will show at the start of a working 
day, whereas Finish milestones will show at the end of the working day, e.g. if a task is completed on 
Friday afternoon, a Start Milestone will appear on Monday morning. A Finish Milestone will appear at 
the end of Friday afternoon. By default you will create a Start milestone. (This is set in the bar chart 
default settings) 

 
To change a Milestone into a Finish Milestone:   

 
1. Right-click on the Milestone. Select Make Into > Finish Milestone. 
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To change a Milestones Appearance: 
1. Open the Project View, select the + sign next to Milestone Appearances.   

 

2. Click the Milestone appearance that will be applied and drag it to the milestone in the 
Bar Chart.   

 

8.4.6- Task-Per-Line Mode.  In Elecosoft Powerproject it is possible to display more than one 
task on a bar. This is useful if you have several tasks of the same type or you have a process made up 
of a number of single tasks. Elecosoft Powerproject can separate tasks that exist on the same line by 
dropping them down onto separate lines. This is achievable by using Task-per-line mode. 
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To Create Multiple Tasks on the Same Line: 
 

1. Using the cross hair cursor draw more than one task onto the same line in the Bar 
chart. 

 

 
 
2. You can now drop these tasks down onto separate lines by clicking the + symbol to 

the left of the line number you have drawn them on. 

 

 

The tasks are now on separate lines, and can be renamed.  Renaming the tasks while broken down will not 
change the name of the rolled up task. 

 
 
3. Click on the - symbol to roll the tasks back up onto one line. 
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To Roll up Existing Tasks: 
 
There are also buttons which allow you to select a number of already pre-drawn tasks which are on 
separate lines and roll them up onto one line. 

 
1. Select the line numbers of the tasks you wish to place on one line. 

2. On the Home tab, click the Roll up tasks   icon. 

3. The process can be reversed using the Unroll task   icon. 

8.5- LINKING TASKS 

Once you have entered in your tasks you will need to consider the order that you wish to approach those 
tasks. It is possible at this point to move the tasks into order by selecting the start and finish dates that you 
wish to use. 

 
However, in order for the software to understand the order that you wish to work through your project, 
you will need to link your tasks to indicate how they relate to each other. 

 
8.5.1- Link Types.  Links can be drawn starting and ending anywhere along the length of a task 
and you can link tasks in many different ways.  The type of link used depends on the nature of the 
relationship between tasks. 

 
There are 4 types of link: 

In all cases, the direction of the arrow controls where the next task appears (A controls where B appears). 

 

 

 

 

 

 

Start-to-Start Finish-to-Finish Finish-to-Start Start-to-Finish 

A 

B 

A A A 

B B B 
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8.5.2- Drawing Links in the Bar Chart.  Links are drawn between tasks using the following 
cursor shapes:   

 

 

 

End link Cursor: 

This cursor shape indicates that you 
are linking from / to the end of a task 

 

 

 

Start link Cursor: 

This cursor shape indicates that you 
are linking from / to the start of a task 

 

 

 

 

Mid-link Cursor: 

This cursor shape enables you to link 
from/to any midpoint along the length 
of a task. A pop up box will indicate 
your exact position during the task, 
e.g. 3 days into a 10 day task 

 
To Draw a Finish to Start Link Between 2 Tasks: 
 

1. Place the mouse at the end and at the top or bottom corner of the first (predecessor) 
task to display the end link cursor. 

2. Left-click and drag to draw the link to the start of the corresponding (successor) task. 
3. Release the mouse when the Start Link cursor is displayed. 

• A link is made between the 2 tasks. The link arrow is green. This means that the 
link is selected. 

 
4. Click elsewhere on the bar chart to deselect the link. 

  

 
This now tells Elecosoft Powerproject that task B cannot start before task A is finished. 

 
Sometimes it is necessary to show that tasks will happen simultaneously. 
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To show a link is drawn starting or ending somewhere along the length of a task is known as a mid-link. 

 

To Draw a Mid-Link: 
1. Place the cursor at the start of the predecessor task. Without pressing move the cursor 

to the right so that the mid-link cursor is displayed. 
2. A pop up box will indicate where during the task you are linking from. 
3. Left-click at the desired position and drag to move the pointer to the desired position 

on the successor task. 
4. Release the mouse when the corresponding link cursor is displayed. 

Drawing Links With Lead/Lag Time 
 
There may be times when you need to insert a period of waiting or delay into your project, e.g. waiting 
for paint or concrete to cure: 

 

1. Draw a Finish to Start link. 
2. Right-click on the link and select Properties. 
3. Click on the Link Start tab. 
4. Enter the lead/lag time in days, e.g. 2d. 

-Or- 

4. Move the cursor to the bottom right hand corner of the predecessor task so that the 
end link icon appears, Left-click and keep the mouse button held down. 

5. Press and hold the Shift button on the keyboard and with the mouse button still held 
down drag the cursor horizontally.  A pop up box will appear displaying the lead/lag 
duration. 

 

 

Task A 

Task B 

Task A 

Task B 

Task A 

Task B 
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Once you have reached the desired duration release Shift but keep hold of your mouse button and drag it 
over to where you want to end the link and let go. 

 

 

8.5.3- Moving/Editing Links.  If you have drawn a link incorrectly, you can simply ‘drag’ the 
link to the correct position, rather than deleting and redrawing the link. 

1. Select the link (it will show as green). 
2. Hover the cursor over the end of the link you wish the move until a ‘cross’ cursor 

becomes visible. 
3. The link can now be dragged to the correct position. 

 

 

 

 

 

 

Multiple links in a sequence can be highlighted by selecting the first link in the sequence, holding the 
SHIFT key and selecting the last link in the sequence 

 
8.5.4- Block Linking.  If you have more than 2 tasks to link together e.g. a whole section of 
work, the Add/Delete Links button can be used. 

1. Select the tasks that you want to link. 
2. To link tasks that are next to each other on your chart click on the line number of the 

first bar. Left-click and drag downwards to select adjacent bars. 

 
-Or- 

 
2. To link tasks that are not next to each other on the chart hold the ctrl button on 

keyboard while clicking on line number the task you want to link. 
 

The link should have been to the start 
   

When the link is selected the 
Drag/Move Cursor can be displayed 

Pull the link to the correct 
position on the task  
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3. Click the Add/Delete Links button on the Home tab and then ‘Link Tasks’  
 

 

 
Finish to Start links are placed between each of the tasks. 

 
8.5.5- Link Tasks Mode.  You can use Link Tasks mode to link tasks automatically as they are 
created, or as you select them one-by-one in the bar chart. This saves you from having to create links 
separately by drawing them in the bar chart. 

To Link Tasks Automatically as They Are Drawn in the Bar Chart: 

1. On the Home tab, in the Schedule group, click the Add/Delete Links dropdown and 
select Link Tasks Mode. 

The cursor changes shape to to indicate that you are now in Link Tasks mode.  

2. Draw a task in the bar chart. Note that if a task was selected when you entered Link 
Tasks mode, a link is drawn automatically from the selected task to the task that you 
have just drawn. 

3. Draw another task in the bar chart. As soon as you have finished drawing the task, a 
Finish-to-Start link is drawn automatically from the first task to the second task: 

 
4. As you draw further tasks, each new task is linked to the previous task automatically 

as long as you remain in Link Tasks mode. 
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To exit Link Tasks mode, on the Home tab, in the Schedule group, click the Add/Delete Links dropdown 
and select Link Tasks Mode again, or press ESC. 

8.5.6- Linking Tasks Without Drawing on the Bar Chart.  As well as drawing links 
directly onto the Bar Chart using the mouse, you can also link tasks by selecting one or more tasks in 
the Bar Chart and specifying the task you want to link to by name.  Creating links in this way is an 
easy way to link tasks which are not close to each other in the Bar Chart. 

1. Right-click on a task or tasks on the Bar Chart. 
2. Select Linking > Add Link. 
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The Link From/To dialogue box is displayed as shown on the following page: 

 
 

3. Indicate whether you are linking from or to the selected task(s). 
4. Identify the task you are linking to. 
5. Select the type of link. 
6. Select Link and Close. 
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8.5.7- The Wild Card.  By placing an asterisk (SHIFT + ‘8’ on your keyboard) after the first few 
letters or words of the task to which you are linking. This acts as a wild card and it will search for all 
tasks that begin with those letters or words. 

 

 

If it finds more than one task beginning with these letters or words it will give you the choice of which 
task you want to link to. 
 
 

8.5.8-  Chasing Logic 

1. Right click on an activity 
2. Select Properties. 
3. Navigiate to and select Links tab. 
4. See the activities that are connected to the acitivity that was selected.  
5. Right click and select Go To Other End to see the other activities.   
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8.6- RESCHEDULE 

When you have linked your tasks you can reschedule the project. The reschedule performs a series of 
actions: 

 
• Places the start of the first task at the beginning of the project 
• Calculates the optimum start and end dates of all tasks according to the logical 

links applied 
• Calculates whether a task has any float attached 
• Shows whether a task is Critical Analysis) 
• Identifies any constraints which have been exceeded 
• Calculates the earliest project end date 

8.6.1- Rescheduling the Project 

1. On the Home tab, click the Reschedule icon. 
 

 

 
Once the project is rescheduled, the critical path of the project is shown outlined in red 

 

 



Chapter 8: Elecosoft Powerproject Client  Publication 615 

8-45 

8.6.1.1-  Reschedule All Every time the schedule is adjusted the project will auntomatically 
reschedule 

1. In the Home Tab, click the Reschedule Branch icon.  
2. Select Options.  

 

 

3. Under the Auto Reschedule dropdown select Reschedule All.   

 

4. Click Ok 
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8.6.2- Viewing the Schedule Log.  A log can be generated once the project has been 
rescheduled.  A log will give you such information as: 

• Environment – Shows the project name, short name, project file, reschedule 
date, user name, and reschedule number. 

• Statistics – Gives the number of tasks rescheduled, the number of milestones 
reschedules, number of logic links, number of tasks/milestones not started, 
number of tasks/milestones in progress, number of tasks/milestones completed, 
number of tasks/milestones changed, highest logical precedence, and elapsed 
processing time (seconds). 

• Scope and options – Shows scope, tasks with no links, tasks with outgoing only 
links, As Late As Possible (ALAP) tasks have free float, negative float held at 
end of chain, finish in, on or before flags are soft, summaries critical where 
content is, ignore link categories, move part completed links, truncate float 
within chart boundaries, relink around completed tasks, straighten progress line 
to period, and only move forward to make straight. 

• Reschedule dates – Shows the imposed start, imposed finish, progress date/data 
date, prevailing contract date for completion, calculated earliest actual start, 
calculated early start, and calculated latest early finish. 

• Errors – Shows tasks in a link loop, tasks finishing after their deadlines, tasks 
with conflicting constraints, and completely consumed buffer tasks. 

• Open ended – Shows the number of tasks/milestones with only incoming, the 
number of tasks/milestones with only outgoing, the number of tasks/milestones 
with both, and the number of tasks/milestones with no links. 

• Tasks with constraints – Shows tasks with constraint flags with gaps and tasks 
where start on new day was applied. 

• Deadlines – Shows deadlines with gaps. 
• Key milestones – Shows milestones tasks showing current and computed start 

dates. 
• Buffer tasks – Shows buffer tasks with current and original durations. 
• Interruptible tasks – Shows interruptible tasks with current and original 

durations. 
• Out of sequence progress – Shows incomplete tasks which logically precede 

completed. 
• Unsatisfied constraints – Shows tasks with unsatisfied logic and tasks with 

unsatisfied start flags. 
• Critical tasks – Lists all the critical tasks. 
• Longest path – Lists the longest path. 
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To Run and View the Schedule Log: 
 

1. On the Home Tab, Select the arrow Reschedule Branch > Options. 

  

2. The reschedule Options Dialog box will appear.In the Options window, select 
Settings. 
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The Reschedule Report Settings Dialog Box will appear. 

3. Select either Display report in browser or select Save report file and browse to the 
location that you want the log to be saved. 

  

4. Select OK. 

5. Reschedule the project, by selecting Reschedule icon on the Home Tab. 
6. A Reschedule Report Warning Dialog Box will appear.Select OK. 

  

The report will automatically generate if Display report in browser was selected.  If Save Report File was 
selected, the report will need to be opened from the file location that was specified. 
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8.6.3- Changing the Project Start Date.  The start date of the project can be changed at any 
time. This will control when the first task in your project will reschedule to. 

To Change the Start Date: 
 

1. In the File tab, select Properties. 

 

 

2. Change the Imposed Start to the new project start date. 
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3. Go back to the Home tab. 
4. Reschedule the project to see the new start date take effect. 

8.7- CONSTRAINTS 

Once the tasks have been linked and rescheduled, your project will be laid on the most logical order. 
What we have yet to take into consideration are any fixed dates that will need to be adhered to, such as a 
specific let date or a contract completion date. 

 
To show fixed dates in your project, and to show the impact they have on the rest of the tasks in your 
project you will need to use Constraints on those tasks. 

 
8.7.1- Adding a Constraint 

To Add a Constraint to a Task: 
 

1. Click and drag the task to the required position. 

  
  

2. Select the task you wish to constrain. 
3. On the Home tab click on the drop down arrow under the Constraint Flag   

icon. 
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4. Select the constraint you wish to impose on the task. 

 

Once the constraint has been added to the task, an asterisk will appear in either the start or finish column. 

 

Note:  On all design schedules, a ‘Finish On’ constraint should be set for the activity ‘Open Bids’.  
In order for early and late dates to show properly in the schedule along with total float rippling 
through the critical path, certain options have to set up with the Reschedule Branch Options Menu. 
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To Set Constraint and Float Options When Rescheduling: 
 

1. On the Home Tab, Select the arrow Reschedule Branch > Options. 

 

• The reschedule Options Dialog box will appear. 
2. In the Options window, it is recommended to have the following options selected: 

 

3. Click OK. 

4. Reschedule the project, by selecting Reschedule icon on the Home Tab. 
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8.7.2- Types of Constraint 

  

Start on or after 

A soft constraint which will not allow the task to start before the 
constraint date, however to could move to a later date  

  

Start on 

A hard constraint which will fix the start of the task to a constraint date 

 

Finish on or before 

A soft constraint that will not allow the task to end after the constraint 
date, however it could finish earlier 

 

Deadline 

A soft constraint which works as a warning but will allow the project to 
move beyond the target deadline 

 

Finish on 

A hard constraint that will fix the end date of the task to the constraint 
date 

 

Work between 

A soft constraint that will allow either the start or the end date to be 
constrained between 

 

Holding pin 

A Constraint which will move with the task if the task is manually moved 
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8.7.3- Reschedule Results (Float).  Rescheduling a project with constraints will affect the 
appearance of tasks & may result in some items showing Float. 

 
8.8- MODIFYING THE SCHEDULE 

Once a schedule is created using the PDSMASTER template, it will need to be modified to conform to 
the project. Any task that pertains to the project should be tracked in the schedule. Sometimes this will 
necessitate the use of duplicate activities. For example, if a project has multiple structures, each individual 
structure should be tracked separately in the schedule. If the task is not listed in the PDSMASTER, a 
nonstandard PennDOT task can be created. 

Any task that is added to a schedule that is not part of the PDSMASTER template is considered a non-
standard PennDOT task. The PDSSTANDARD code field is used to screen non-standard activities out of 
the Department’s historical data. A “1” is assigned to all standard activities – those found in the 
PDSMASTER template. Any task that is added outside of these standard activities should be assigned a 
“2.” 

8.8.1- Recurring Activities.  For some projects, there may be a need to track the same task or 
group of activities more than once. As with other activities, the activities should be pulled from the 
task pool following the standard PennDOT templates, so that all task descriptions and code files are 
left intact. 

For example, in design, the standard description for structures is, “Structure (S-XXXXX).” For a 
simple bridge replacement project this will be the only task needed, because the bridge is the only 
structure being tracked. But suppose a new directional interchange is to be built, entailing several 
structures. Since all of these must be tracked individually, one would copy and paste the standard 
structures task, then modify the task name accordingly, resulting in a list: 

• Structure (S-54701)  

• Structure (S-54703)  

• Structure (S-54704)  

• Structure (S-54705)  

• Structure (S-54709)  

Critical Task - displayed in red. If a critical task is delayed, it will change the 

project end date. 

Total float – the period a task can be delayed or extended without delaying the 

end of the project - however this will affect other tasks (successor tasks) 

Free float – the period a task can be delayed or extended without affecting the 

end of the project - or any other tasks. 
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8.8.2- Updating Task Detail.  As a project progresses it may be necessary to provide additional 
detail or address activities that may not be required due to a change in scope. 

8.8.2.1- Adding Task Detail.  When a change in project scope occurs there may be the 
necessity to add work detail to the existing schedule.  Section 8.8 – Modifying the Schedule and 
Section 8.8.1 – Recurring Activities provides the method for adding detail (activities) to a 
schedule. 

When activities are added to a project, the new activities need to be tied into the project and 
reschedule branch performed to verify that the original target date is still being met.  In the event 
that the project duration is extended beyond the target date, project logic and task durations may 
need to be changed.  Any change made should have the concurrence of the project team.  Upon 
concurrence, another baseline should be created. 

8.8.2.2- Task Closeout.  During the life of a project, work that is initially identified as being 
required may be determined that it is no longer needed by way of a scope change or study 
outcome.  To address this situation, activities associated with the initial scope of work should not 
be deleted from the schedule but should be closed out. 

If the project is in progress, the task that is no longer needed to be tracked must be recorded as 
complete by using the following procedure: 

1. Record the date that someone determined the task is not needed as the Actual Start 
and Actual Finish dates. 

2. Set the Progress Type as ‘Complete’ and Progress Value as ‘100%’. 
3. Do not change the plan duration of a task.  Elecosoft Powerproject will calculate the 

duration based on the task dates entered for the task. 
4. Record the reason why the task is not needed in the Task Notes.  Enter an explanation 

of why the task is not needed and by whose direction. 

For projects that do not have a baseline set, the task may be deleted and its predecessors and 
successors re-linked as needed. 

The deletion of activities should only occur during the project planning phase. After a project is 
progressed, existing activities that are affected by a change in scope should be closed out. 

Progress out of sequence occurs when a task is started or completed when its assigned 
relationship type is not honored, e.g., a finish to start relationship linking two activities is not 
being followed. Progress out of sequence must be fixed by reviewing task logic and making 
necessary task relationship edits. 

8.9- STRUCTURING THE PROJECT 

Project management is not only about defining tasks and setting up their dependencies, it is also about 
organizing the different parts of a project into a coordinated whole. 
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Elecosoft Powerproject lets you organize your project using Summary Tasks to group related tasks 
together and Expand Tasks to break down the project into greater detail.  This section explains how you 
can use charts and summary bars to structure your project in a logical format. 

8.9.1- Creating Summary Tasks.  Summary tasks are useful for grouping related activities 
together in sequential order.  A summary task takes its position and duration from the position and 
duration of the tasks within the summary group. It provides ‘rolled up’ information relating to all 
tasks within the summary and gives the user control over displaying each & every task in the project 
or displaying only the summarized information. 

To Summarize Tasks in the Project: 
 

1. Highlight the bars you wish to group together by clicking and dragging on the line 
numbers within the table. 

2. On the Home tab click the  Summarize icon.  
• A summary bar appears on the Bar chart. 

 
 
3. Enter a name for the summary bar in the table e.g. Sub Substructure. 

You can now choose to hide the tasks that are part of the summary group from the chart so that only the 
summary bar & ‘rolled up’ details are displayed. 

 
8.9.2- Opening and Closing Summary Tasks: 

1. On the Bar Chart, place the cursor over the summary task so that 
the sweet wrapper cursor is displayed and Double-click. 
• The individual tasks are hidden from view. 

 

2. Double-click again to display the tasks. 
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8.9.3- Adding & Removing tasks into Summary Groups 

1. Select the task(s) by clicking on the line number under the “Line” column. 

2. On the Home tab click on the Indent icon.   
• Tasks will be added to the summary that is above. 

3. To remove tasks from a summary group, use the Outdent icon. 

8.9.4- Removing Summary Tasks 

1. Select all of the contents of the summary group. 

2. Click the Outdent icon.  
• If there are no contents in the summary group the summary task no longer 

exists. 

 
8.9.5- Using the Project View to Navigate the Project.  The structure of our project is clearly 
displayed in the Project View. 

1. Click on the ‘+’ sign to open the contents of headings. Program is usually the top 
level. 

2. Select any of the summary groups to display only that section of work on the Bar 
Chart. 

In the example below only Design Field View has been selected therefore you are only shown the 
contents of the Design Field View summary bar: 

 

 
 

8.9.6- Summary Bar Level Formatting.  Once you have summarized your project, the 
spreadsheet cell color and font, as well as the background color for that row on the bar chart, can now 
be set for a Summary/Expanded task in the Project View. The coloring is set for each level of the 
project, so more than one summary may have the same color. 
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To Alter the Appearance of the Summary Bar/Expanded Task: 
 

1. In the Project view, Right-click on any Summary bar and select Appearance. 
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2. Choose the text color, background color, and font style and size of your choice. 

 

Once the level coloring is set, it will need to be turned on in the Bar chart. 
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To Turn the Summary Row Color On: 

 
1. On the Format tab click the Format Bar Chart command. 
2. On the General tab tick Bar chart and click Close. 

 
 
 

8.9.7- Creating Expanded Tasks.  Expanded tasks allow you to organize your plan as a 
hierarchical tree of charts, gradually breaking the project down further and further into more and 
more detail.  These new Expanded Tasks are clearly displayed in the Project View. 

Any existing task can be converted into an expanded task or a new task can be created and made into 
an expanded task. 
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To Make a Task into an Expanded Task: 
 

1. Create a task by entering a task name and duration into the table. 
2. In the bar chart, place the mouse over the task and Right-click on it. 
3. Select Make into > Expanded. 

 

The selected task becomes a new chart in the project hierarchy.  

To Access the New Chart: 

1. Left-click to select the chart from the Project View. 

-Or- 

1. Double-click on the task on the bar chart. 

Create tasks and plan your work in this new chart as normal. 
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To Return to the ‘Program’ of the Project: 

1. Select Program from the project view or select Up one level  from the Quick 
Access Toolbar at the top your screen 

• At Program level the expanded task is displayed with a critical appearance. 
The expanded task can now be linked into the project just like a normal task.  

 
8.9.8- Using the Project View to Navigate the Project.  The structure of our project is clearly 
displayed in the Project View. 

1. Click on the ‘+’ sign to open the contents of heading. ‘Program’ is usually the top 
level. 

 

2. Select any of the summary groups to display only that section of work on the bar 
chart. 
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8.9.9- Cross Chart Linking.  Sometimes it is necessary to show links between tasks held in the 
root chart of your project and tasks held in sub-charts. These links can be made by bringing the tasks 
onto one screen to enable links to be drawn between them or by using the Link From/To dialogue. 

To Display the Tasks From Different Charts on One Screen: 

1. Click on Program in the Project View. 
2. Hold down the Ctrl key on the keyboard and also click on the expanded chart in the 

Project View. 

 

 
Tasks from both charts are now displayed on the same screen, Note the links have been drawn between 
tasks as required. 

 
Alternatively the Link From/To Dialogue Can Be Used: 

 
1. Right-click on the required task in whichever chart of your project. 
2. Select Linking > Link From/To from the list. 
3. Enter the name of the task you are linking to in the ‘Task Name’ field and click Link. 

8.9.10- Hammock Tasks.  Hammocks are used to show an overview of related tasks which are not 
next to each other in the project.  Like summaries & expanded tasks, hammock tasks take their total 
duration from the tasks within them. The hammock and its contents are displayed at the foot of your 
project. 
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To Create a Hammock: 
 

1. Select an empty bar of your project by clicking on the line number. 
2. On the Home tab in the Insert section select Hammock. 

 

3. Name the Hammock task. 

To Add Tasks to a Hammock: 
 

1. Right-click on a task. 
2. Select ‘Add to Hammock’ from the list. 
3. Select the hammock if there is more than one and click OK. 

A copy of each task is shown within the hammock. 

 

 
 

To Remove Tasks From a Hammock: 
 

1. Right-click on a task. 
2. Select ‘Remove from Hammock’ from the list. 

You can change the appearance of how your hammock looks by ‘necking’ or ‘pinching’ it to show 
whereabouts the subordinate tasks are located. 

 
 



Chapter 8: Elecosoft Powerproject Client  Publication 615 

8-65 

To Change the Appearance of a Hammock: 
 
1. Right-click on the Barchart.  
2. Select Format Barchart. 
3. On the non-working tab, un-tick On tasks the check 

box under Draw non-working shading. 
4. Then tick Neck summary tasks to show where no tasks 

 
 

This will now show necking in the summary bars and your hammocks. The necked areas show where 
there aren’t any tasks on those dates. 

 
8.10- BUFFER TASKS 

Some contracts may have a period of contingency planned into the program to allow for any delays 
encountered. This could be marked but using a constraint to show the contract completion on the correct 
date, however, this could result in float showing on a large part of the project. 

 
Another way of showing your contingency is by adding a Buffer task to your project. A Buffer task is one 
that will expand or contact into the space available, filling time that may otherwise show as float on a 
project. 

 
There are two types of buffer tasks: 

 
• Feeder buffers – which sit within the project protecting key dates 
• Project buffers – usually the last task in a project protecting the project end date 

A buffer contributes to the Critical Path calculation, but when its start date is affected it will shrink (or 
expand) and protect the Critical Path. 

This technique is often referred to as Critical Chain.  
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In the example shown below Design in example B, is reduced to 1w and Set Up Site moves back, in 
example C, Set Up Site expands to 8d. 

To Create a Buffer: 
 

1. Type a task name into the spreadsheet. 
2. Create a task by either typing in the duration column or by drawing on the bar 

chart. 
3. Link the task into the project and reschedule the project (so that the task takes 

up the correct position within the project). 
4. Right-click on the task and go to Make Into > Buffer Task. 

Note: For a Feeder buffer task, a ‘start on or after’ constraint flag will be required on the 
succeeding task 

 
8.11- TASK POOLS 

Task pools will allow you to save together networks of tasks such as those for a Design Field View or 
PS&E Package or any tasks that are grouped together under summary bars to form ‘phases’ of work in a 
project. 

These can then be copied and pasted through the program or used as a starting point in new programs.  
The PennDOT templates, all have task pools already created in them with the standard PennDOT 
activities. 
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To Create a New Task Pool: 

1. Where you have a group of tasks grouped together Right-click on the relevant 
summary bar on either the bar chart or the project view. 

 

2. Select Copy to Task Pool. 

The task pool will then be displayed in the project view on the left hand side of the screen. It can be used 
again in the same project or saved into a project template for use in future projects. 

 

To Add a Task Pool into a Project: 
 

1. Move your cursor over the task pools in the project view. 
2. Click and drag the task pool to the position that you would like them to start in the 

project. 

You will then see the network of tasks copied into the project.  

8.12- CODE LIBRARIES 

Code Libraries allow us to color code tasks so that their appearance represents something relevant.  A 
project can contain many code libraries, which can be hierarchically based. 

 
The four standard PennDOT design task code folders are already created within the PDSMASTER and 
the district specific templates. These consist of the Department work breakdown structure (PDSWBS), 
organizational breakdown structure (PDSOBS), cost function folder (PDSCOST) and standard task folder 
(PDSSTANDARD).  

All of the standard activities within the PDSMASTER and district specific templates have coding 
assignments already given to them. If you add non-standard PennDOT activities to your schedule, these 
activities must also have coding values added. For non-standard activities, the PDSSTANDARD must be 
2, while the other coding values should be assigned which are appropriate for that task. 

It is the responsibility of the District Portfolio Manager to make coding assignments consistent with 
PennDOT methodology. If the Portfolio Manager has questions with regards to how these changes should 
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be applied, contact the Elecosoft Powerproject Support Group within Central Office. For standard 
activities established in the PDSMASTER template, no changes to the PDSWBS codes are permitted. 
Changes can only be approved and implemented by Central Office, in order to preserve historical data. 

There are two other codes that are standards for all PennDOT schedules (Design, Pre-bid, and 
Construction): Project Type and Project Complexity.  These code folders are also already created within 
the PDSMASTER and the district specific templates, along with the Pre-bid and Construction template.  
In Elecosoft Powerproject Client, these codes will still be utilized at the ‘program level’. 

During the project schedule setup in Elecosoft Powerproject Client, assign the appropriate Project Type 
and Project Complexity code from the Code Library.  These two codes should be assigned at the highest 
‘program’ level of the project view on the left hand side of the screen.  When assigning these two codes, 
make sure the highest program level is selected, and drag and drop the code values onto the highest level 
task.  

 

The Project Type classification is based on the primary nature of the project. For example, a 10 mile 
roadway resurfacing project which includes a bridge should be classified as “roadway resurfacing,” not 
bridge preservation. Similarly, a bridge replacement project which includes the reconstruction of 1000 
feet of approach on both sides should be classified “bridge replacement.  In addition the project type for 
design projects is further defined as either Design-Build or Design-Bid-Build. Therefore a bridge 
replacement project may be coded as “bridge replacement/design-build’ or bridge replacement/design-
bid-build”. 

 

 

 



Chapter 8: Elecosoft Powerproject Client  Publication 615 

8-69 

Additionally, all projects shall have a project code that identifies the complexity of the project. These 
consist of the following: 

• Typical Most Complex (Major) Projects 

• Typical Moderately Complex Projects 

• Typical Non-Complex (Minor) Projects 

The definitions of the above are those found in PennDOT’s Design Manual DM1 Chapter 2. 

Additional codes are created in the Library Explorer. 

 
8.12.1- Creating Code Libraries 

1. In the Project View, right-click on Code Library and select New Code Library.  

 
2. Give it a name (for example, Contractors). 
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3. In the Project View, right-click on the Contractor folder and select New Code 
Library Entry. 

 
 

4. In the Name box type in ‘ABC Construction’ to represent our first contractor. 

 

 
 

5. Change the Fill Style under Appearance to change the Foreground Fill, Background 
Fill and Pattern to select colors and patterns to identify this contractor. 
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6. Click Close. 

7. Repeat steps 2-5 until all contractors are added within the code library folder.  

8. To create other code library folders, repeat starting at step 1. 
Or another way to create codes is to do so using the Library Explorer. 

 

1. On the View tab click the  Library Explorer icon. 
2. In the left window of Library Explorer, click on the Code Library folder. 
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3. In the right window, on a blank part of the screen, Right-click and select New Code 
Library.  

 

4. Give it a name (e.g. Contractors). 

 

5. In the right window, Double-click on the Contractors folder. 
6. Right-click in the right hand pane and choose New Code Library Entry. 
7. In the Untitled box type in ‘Forest Landscaping’ to represent our first contractor. 
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8. Click under Foreground Fill, Background Fill, and Pattern to select colors and 
patterns to identify this contractor. 

 
 

9. Right-click under Forest Landscaping to create a new code entry for Janson’s 
Timber. 

10. Repeat the process until all contractors are added. The other contractors are; Acme 
Building, Goldstone Utilities and Smarts Decorators. 

11. To Return to the Project, click on the Bar Chart View Tab. 
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8.12.2- Single Select on Code Libraries.  Single select means that once you have allocated one 
code there will be no option to add further codes from the same folder to a task 

To Set the Single Select Feature: 
 

1. Right-click on a code library in the project view and select Properties. 

 

2. When the Properties box pops up choose Single select. 

 

3. If you want to specify that a code library is used only once on a task tick the box 
marked as single select. 
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8.12.3- Allocating Codes.  Now that the Code Libraries have been created we can apply these to 
tasks within the project. To do this we will use the Project View: 

 
1. To expand the list of Code Libraries in the Project 

View, click the + to the left of Code Libraries.  
2. To expand the list of Contractors codes, click the + 

to the left of Contractors.  

 

 

 

8.12.4- Single Task Allocation 

To Allocate a Code to a Task: 
 

1. Place the cursor over the Code entry in the Project View. 
2. Press the left mouse button and drag until the cursor is over the task in the Barchart 

to assign the code to, then release.  

 

3. The following message will appear. Click Yes to apply the new Code Library color. 
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8.12.5- Multiple Task Allocation 

To Allocate a Code to Multiple Tasks: 
 

1. Select multiple tasks by holding down CTRL + left-clicking the tasks in the barchart 
(tasks will be highlighted in black). 

2. Place the cursor over the code entry in the Project View. 
3. Press the left mouse button and drag the cursor to one of the highlighed tasks in the 

barchart then let go of the mouse.  

 
 

4. Click away to deselect and the bars will change color. 

8.12.6- Switching the Display Between Code Library Folders.  Elecosoft Powerproject will 
only allow one Code Library to display at a time on tasks.   

To Switch Between Folders:  

1. In the Project View, Right-click on the Code Library 
Folder to display and select Display Library.  
• The red tick indicates the code library currently on 

display. 

To Remove the Display of Code Libraries:  

1. Right-click on the folder that is on display (shows a red tick). 
2. Select Display Library to remove the display of this library. No code libraries are 

now selected to be on display. 

 
8.12.7- Simple Filters Based off of Codes.  Now that the project is coded, filters can be used to 
show only the tasks with a certain code 

To run a Filter on a Code: 

1. On View tab click on the Filter  icon.   
2. Under the Codes category, select Which Code Folder to Filter On. 
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3. Click on the + against the Code Folder and select the box next to the code to filter on. 

 
 

4. Click on Finish and run the filter. 
5. To stop a filter running, click on the Filter command and select No Filter. 

 

8.13- UNIQUE TASK ID NUMBERING 

Elecosoft Powerproject generates a unique identification number for each task in a project. The ID, which 
is created automatically each time you create a task, is a combination of an alphanumerical prefix string, 
which you can define, and a number. As each new task is created within a project, the number is 
incremented by an amount that you can specify. You can specify a minimum number of digits for the task 
ID if you wish. If you do this, Elecosoft Powerproject pads out smaller IDs with zeros to bring them up to 
the minimum width. You can use unique task IDs as a way of identifying the tasks within your project. 

If you copy bars and tasks from one project to another, unique task IDs are maintained in the copied tasks, 
unless any of the IDs conflict with IDs in the destination project. 
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8.13.1- Displaying Unique Task ID Codes.  When you draw tasks on the Bar Chart, 
unique task ID numbers are automatically generated for each task. 

To view Unique Task ID codes, you will need to set up a Spreadsheet column containing the column 
Unique Task ID (see The Spreadsheet section on how to add columns, Section 8.15.C). 

8.13.2- Renumbering Unique Task ID Codes.  Now that the Unique Task ID’s are displayed 
on the Project, you can manually change the numbers to suit or Elecosoft Powerproject can 
automatically renumber tasks for you. 

 
To Renumber All the Tasks in View: 

1. Hold down the Ctrl key and then select the letter A on your keyboard (this selects all 
of the tasks in the view).  

2. Select the Project tab, Unique ID Numbering icon.  

 
3. From the list of options that will display firstly select Unique ID Numbering. 
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4. You can the choose the start value, minimum width and increment values. 

 

5. Once you have chosen your prefered numbering options you can then close this box, 
click OK. 

6. Reselect the Unique ID Numbering, this time when the menu drops down select 
Unique ID Renumbering. 
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7. When the dialog appears just click Apply and it will perform a renumbering for you. 

 

8.14- USER DEFINED FIELDS 

Within Elecosoft Powerproject can add your own “user fields” to tables in the database.  For example you 
might want to add fields to show delay Notes, progress comments or if a task has been approved. 
 

8.14.1- Creating User Fields for Projects 

1. First the project must be saved. The User Field Manager will not be available if 
there is any unsaved information. 

2. Select Project tab and click the User Field Manager command. 
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3. Click on the drop down arrow and select Bar from the Object Type, then click Add. 
4. Select the type of field that you want to create: 

• String – a text field, e.g. for a name or comment field 
 

• Integer – a field for whole numbers 
 

• Float – a field for decimal numbers 
 

• Boolean – a True/False field, e.g. for an option that can be on or off. Boolean 
fields might be shown as check boxes or drop-down controls providing Yes/No 
or True/False options 
 

• Date – a date/time field, e.g. to record the date or time 
 

• URL – A hyperlink field 

 

 
 

5. As String is selected by default, enter the name “Comments” in the User Field Name 
box. 

6. Click OK. 
7. Click Close. 

To Add a User Field as a Column: 

1. Right-click on an existing column heading and select Add Column. 
2. Choose the User Fields category and then choose your new User Defined Field. 

 

 

 

 

 The field name doesn’t like spaces, 
and so if you want a space (e.g. QA 
Approved) then use an underscore (_) 
between the words. When the column is 
added into the table, use table definition to 
edit out the ‘_’ in the title 
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8.14.2- User Defined Fields and Task Data Display.  If you create a URL user defined field 
you can input web addresses and file locations into the column. To activate the link you have to hold 
down the Alt key and select the link with your mouse. However you can also show these hyperlinks 
on the left or right hand side of your tasks using task data display. If these hyperlinks are displayed 
next to the task, by Left-clicking on the link it will activate. 

 

 
 

 
To Switch on Task Data Display: 

 
1. Right-click on the bar chart. 
2. Select Format Barchart. 
3. On the Tasks tab, select left or right data display. 
4. It will give you a dropdown menu of column categories, you need to select your URL 

column from the user field category to display the link next to the tasks. 

8.15- EDITING THE VIEW 

The ‘view’ of your project is made up of 3 areas. Changes can be made to the appearance of each of these 
areas independently: 
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Note: Existing District specific views have already been created within the PennDOT template files 
and within the PennDOT Elecosoft Powerproject Client.   

8.15.1-  The Date Zone.  The Date Zone is the area where date information relevant to the project 
is displayed. By default the Date Zone shows 4 rulers (Date lines) running across the top of the 
project, these are the Year, Month, Week Start and Project Week Numbers (elapsed weeks). 

8.15.1.1- Adding/Editing Rulers on the Date Zone.  The Date Zone can contain up to 10 
rulers of date information across the top.  

To Control the Information that is Displayed: 
 

1. Place the cursor anywhere in the Date Zone area and Right-click. 
2. Select Properties from the list. 

The General tab controls the folding Calendar and the date ruler on display. 

 
 

3. To add a fifth ruler, click once on an Unused ruler and select from the drop down list. 
4. To remove any of the rulers first select and then choose Unused from the list. 
5. Click on Apply to see the changes on your project. 

8.15.1.2- Week Numbering.  Week 1 in the Date Zone will default to the project's start date 
when the project was first created. This is displayed in the ‘elapsed week’ line  
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To Align Week 1 to Another Date: 
 

1. Place your cursor anywhere in the Date Zone area and Right-click. 
2. Select Properties. 
3. Select the Dates/Scales tab.  

 

4. Against ‘Date Zero’ use the date picker from the drop down arrow to choose your 
new week 1. 

5. Click Close. 
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8.15.1.3- Grid Lines .  The construction template supplied with Elecosoft Powerproject 
comes with some grid lines, Year, Month, Week and Day. 

A vertical grid line that occurs at a variable date specified by you can also be added to the project, 
e.g. a line that shows at ‘Today’s Date’ or the ‘End of week’. 
 
To Add a Grid Line to a Project: 

 
1. Select the Grids tab from the Date Zone Properties dialogue. 

 

2. Click Add to add a new grid line. 
3. Enter a new Name. 
4. Left-click in the Time Unit column and change Elapsed Week to Variable date. 
5. Click on the thin black line and change the line Style to how you want your line to 

look. 
6. Then Left-click in the empty space where the Variable date will be and a date picker 

will appear, choose your date or click on Click to select variable date. 
7. Press Close. 
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8.15.1.4- Shading.  Elecosoft Powerproject can also put shading behind the tasks within the 
project, it has no effect on the project but it can be used to show certain information i.e. bad 
weather, school term times etc.  

1. Right-click in the Date Zone and select Properties. 
2. Select the Shading tab. 

 

3. Enter the Start and End dates for the shading or a ‘Variable Date’ (see grids) from 
the list and then choose a color. 

4. Click Close to close the properties dialog. This will also ‘Apply’ changes. 

8.15.1.5- Fit to Window.  When using Elecosoft Powerproject you will notice that very 
quickly there will be tasks that do not appear on the same screen. 
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1. These tasks can be repositioned so that they will all fit on to one screen by clicking 

on the View tab and then on the Fit All to Window icon.  
2. If you just want to fit the tasks that are visible in the spreadsheet to the window then 

click on the drop down arrow to the right of the “fit all to window” button and select  

Fit Visible to Window icon.  

 

8.15.2- Bar Chart 

8.15.2.1-  Show/Hide Switches.  On the Format tab, there are two rows of show/hide 
switches which will allow you to show and hide certain visual elements of the project. 

 
 

8.15.2.2- Specifying a Default Appearance of Each Different Task Type.  As an 
alternative to displaying tasks using the appearance of the codes that are assigned to them, you 
can now choose to color tasks according to the appearance of the lead resource that is assigned to 
them. 

1. Right-click on the bar chart and select format bar chart. 
 

2. On the tasks tab you need to select which code library appearance you are using. i.e 
to show code library colors and summary colors you would need to select Use on 
bars. 
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3. Select Change appearances to change the appearace of the different tasks. 
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8.15.2.3- Hiding Tasks.  Sometimes you may choose to hide certain tasks before printing. 
They can easily be put back onto display at any time.  

In order to hide specific bars or tasks, you must first mark them for hiding. 

To Mark a Task for Hiding: 

1. Right-click the bar or task and select Mark for Hiding from the menu that appears. 

 

2. Once you have marked items you can hide them from view at any 
time by clicking the Hide/Show icon on the Format tab. Clicking it 
again will unhide the tasks. 

 

To Unmark the Items: 
 

1. Right-click on the task/bar. 
• In the menu a tick indicates that they are marked. 

2. Select Mark for Hiding again to unmark the items. 
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8.15.2.4- Creating Text Annotations 

1. On the Home or Format tab, click the Text Annotation icon.  

2. Take the cursor onto the bar chart. The cursor will be a letter ‘T’.   
3. Left-click and drag the mouse downwards  and to the right to draw a box: 

 

 
4. Type the text that you want in the text box. 
5. The text color, font, style and size can all be adjusted using the Font section of the 

Home tab. 
6. Click away to deselect the box. 

 
8.15.2.5- Attaching Annotations to Tasks.  Text annotations can be created to refer to 
specific tasks in your project. In this case the text box can be attached to the task so that it stays 
with it should the task move within the project. 

1. Click on the annotation you wish to move. 
2. Hold the left mouse button down, and drag the annotation toward the task you wish 

to attach it to. 
3. The cursor will change to an arrow in a box to indicate how the text box will attach to 

the task. 

 

 

4. To detach an Annotation select the text box and select delete.   
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8.15.2.6- Formatting the Text Annotation.  The properties of the text box can be adjusted 
to control how it looks on your project e.g. whether there is a border, set the text into the 
background of the project or even make the task annotation appear only against specific tasks in 
our project. 

1. Left-click once on the annotation to select it. 
2. Right-click and select Properties. 

 

 
3. Set a background color, check Show border if an outline around the text box is 

desired, and select a Font. 
4. Select the drawing layer, whether the annotation should be displayed ‘in front’ or 

‘behind’ tasks on the chart. 
5. Under Filter, check Make Auto Annotation to make the annotation appear against 

every task or select a filter to control which tasks it appears on. 
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8.15.2.7- Inserting Fields into Text Annotations.  You may type project or task specific 
information into text annotations   e.g. end dates or percent complete.   However when the task is 
updated the annotation will not. Elecosoft Powerproject can use ‘Fields’, which update according 
to the current project data: 

1. Double-click the text annotation so that the cursor is inside ready to type.  
2. Right-click to display a list of available ‘Fields’. 
3. Select a field as required e.g. select Date > Finish.  

 

4. Click OK at the pop up box. 

When deselected, the annotation will display the end date of the task. If the task should change the 
annotation will also be updated.  
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8.15.2.8- Auto Annotation & Filter.  If you have inserted a field into an annotation you can 
tick auto annotation in the properties, select this check box to make the annotation appear 
automatically on all bars, tasks and allocations 

Once the auto annotation has been ticked above there is a filter dropdown, so for example you could auto 
annotate with the task names and then filter so they only show against milestones. 

8.15.3-  The Spreadsheet.  The spreadsheet can be customised to display whatever project 
information you choose.  Columns contain Fields which read data from your project, End date, Start 
date, Percent Complete and can be added, edited and deleted. 

The spreadsheet can be saved as a table so that it can be applied to other Bar Chart views. For 
example, you might have one table for entering new tasks and another for assigning progress. 
 
8.15.3.1- To Add New Columns 

1. Right-click on an existing column heading and select Add Column. 
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2. Choose a Field category (e.g. Identification) and then choose a field (e.g. Name). 

 

3. In the Table Definition Properties pop up changes to the settings for that column can 
be made. 

4. Click Close once you have made your changes. 

8.15.3.2- To Move the Position of Columns 

1. Place the cursor at the top of a column heading so that the select/move cursor 
is displayed. 

 

2. Left-click & drag column to desired position. 
 

8.15.3.3- Saving the Spreadsheet.  You can save the columns that have been created as a 
table, which will allow you to switch between the different tables as required. 

 
1. In the View tab, click the Table command. 
2. Select Save As. 
3. Give your table a new name. 
4. Choose a Category for the new table to be saved in if desired. 
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5. To switch between different tables, in the View tab, click the Table command and 
select from the list of saved tables. 

8.15.3.4-  Table Definition.  Table Definition is the properties box for the table you are in.  It 
can also be used to create new tables and is useful for setting more specific attributes to produce 
more advanced tables e.g. changing a column title, referencing a token to a baseline rather than to 
the live project: 

1. Right-click on a column heading and select Table Definition. 
2. In Column title change the title of your column. 

 

3. Click Close. 
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8.16- VIEWS 

Once the different areas of the view have been changed, the settings can be saved as a collective called a 
view. Each view of you project therefore can display the project with different formatting. 

8.16.1- Saving a View 

1. On the View Tab, select Save As. 

 

2. Give your View a name. 

 

3. Click Ok. 

Once a view has been opened, it will show as a tab across the top of your project area. Views can be 
changed by selecting the relevant tab: 

 

 
 
 

8.16.2- Opening Another View 

 
1. Select the View icon on either the Home or View Tab and choose the 

view you wish to open.  
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8.16.3- Copy Views From One Project to Another.  You can copy views from one project to 
another. This is useful if you have set up a view in one project that you want to use in another project 
without having to set up the view's attributes, filter, sort/group and table again in the other project. 
When you copy a view from one project to another, you can specify whether associated objects, such 
as the view's filter, sort/group and table, are copied across to the destination project along with the 
view itself. 

In order to copy a view from one project to another, both projects must be open in 
Elecosoft Powerproject. 

To Copy a View From One Project to Another: 
1. Open the project that contains the view that you want to copy, and the project to 

which you want to copy the view. 
2. Within the project that contains the view that you want to copy, on the View Tab, in 

the Views group, click the View dropdown and select More Views.  
3. The More Views dialog appears. 
4. Select the view that you want to copy and click Copy To.  
5. The Copy View to Project dialog appears. 
6. Select the project to which you want to copy the view that you selected on the More 

Views dialog in the Destination project field. 
7. Select the Copy associated filter, sort and tables check box to copy the filter, 

sort/group and table that have been applied to the view that you are copying to the 
destination project, or clear this check box to copy the view without these associated 
library objects. 

8. Select the Match missing object references by name check box to attempt to match 
any objects that are referred to by the view to objects in the destination project that 
have the same name, or clear the check box to revert any such references to default 
values. 

9. Select the Copy view annotations check box to copy any annotations that are 
attached to the view to the destination project, or clear the check box to copy the 
view without any such annotations. 

10. Select the Delete row and cell exceptions check box to delete any row and cell 
exceptions that have been applied to the view's spreadsheet table, or clear the check 
box to copy row and cell exceptions to the destination project. 

11. Click OK. 
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8.16.4- Specifying the Views to Open When a Project is Reopened.  When reopening a 
Elecosoft Powerproject file you can specify which view(s) will open, it is possible to specify that the 
project will open up either. 

• The view that was in focus the last time that the project was open. 

• All views that were open when the project was closed. 

To Specify What View is Opened When a Project is Opened: 
1. Go to File > Options > View tab. 
2. Click on the drop down arrow where it says Restore on project open.  
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3. Select Last active view, All open views, User default view, or Project default view.  

 

4. If Project Default View or User Default View was selected, click Edit . . . to select 
the Default to use. 

5. Click on Close and these settings will be saved for the next time the project is 
opened. 
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8.17- BASELINES 

Baselines are created to record the project at a particular point in time (e.g. for recording the contract 
program), this allows you to compare current information with planned information. A baseline is a 
record of all or any part of a project including bars, tasks, links, resource/cost allocations, libraries, 
histograms and annotations.  Creating a baseline allows you to forecast using what if scenarios and can be 
useful with claim situations. 
 
Once a project schedule has been reviewed, fine-tuned, and accepted, it can be considered final. At this 
point it is important to set an Initial Baseline which records the initial project plan, including scheduled 
dates, task assignments, work and costs. . The Initial Baseline should always be created prior to any 
progress being entered into the schedule. 

8.17.1- Creating Baselines 

1. In the Project tab, choose the Baseline Manager icon.  
• The Baseline Manager Dialogue Box will appear.  

 

 
2. Click New. 

• The Baseline Wizard box will pop up. 
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3. Enter a Name for your baseline (see Note below), Description, and an Issue Date. 

 
 

Note: Every project must have a baseline created once the schedule is accepted and before any 
progress is entered. This baseline should be named Initial Baseline with a description of 
Schedule on Record. Once the project is underway, if additional baselines have to be created 
they should be named the following: 

 
Name Description 
Initial Baseline Schedule on Record  
Baseline Update 1 Updated Baseline (Revision 1) 
Baseline Update 2 Updated Baseline (Revision 2) 
Baseline Update X Updated Baseline (Revision X) 

 

4. The Next button will become active once details have been completed. Click to 
continue to the next stage. 
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5. On the Destination screen, if you want to place the baseline in another location 
instead of the directory that has been specified select Browse. If not changed the 
baseline will be stored in the same location on your computer as the live project. 
Change the file name to the name of your baseline (for example XXXXX_Initial.ppb) 

 

6. Click Next to continue. 
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7. On the Scope screen, choose ‘All tasks in the current view’  If you are at the top 
level of your project this will include any tasks held within expanded tasks or sub 
charts (N.B. you can alternatively choose to baseline a selection from the program). 

 

8. Click Next to continue. 
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9. Check the information is correct on the final screen, then select Finish as shown on 
the following page. 

 

10. Once you have completed the new project wizard you will return to the 
Baseline/What If manager box. If you click on the name of the baseline you will then 
see the baseline details. 

 

Note: The baseline has a tick under ‘Current’.  If baselines are created and you want a new baseline 
to become current, you must click the ‘Set as Current’ button, which moves the tick. 
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8.17.2- Changing the Appearance of Baseline Tasks.  The Baseline will now appear as a 
second line mirroring the task above.  (Should you now make a change to your program e.g. an 
anticipated delay, the baseline will not move)   

 
 
 
 
 
 
 
 
 

 
 
 
 

 
8.17.2.1- To Change the Color of the Baseline 

1. In the Project tab, choose the Baseline Manager icon.   
2. Select the appropriate baseline. 

 

 

 

 

Live project 
matching baseline 

Live tasks showing a delay 
against the baseline project 
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3. Click the appearance color bar at the bottom left to change the appearance of the 
baseline by either changing the foreground, background, or pattern. 

 

4. Close out of the baseline manager dialogue by selecting Close. 

8.17.2.2- To Hide a Baseline From the View 

1. In the Format tab, choose the Show/hide baselines icon.   

8.17.2.3- To Choose Specific Baselines to Show or Hide 

1. Click on the Format tab on the ribbon. 

2. Click the drop down arrow beside Baselines .   
3. Tick or Un-tick the baseline that you want or do not want to be displayed. 

8.17.3-  Reverting to a Baseline.  When planning a project you might create one standard plan 
then experiment with several other ‘what if’ scenarios and baseline each scenario for your records.  If 
you decide that you want to adopt one of these scenarios as the project plan, you can revert the project 
to that baseline. 

8.17.3.1- To Revert a Project to a Baseline 

1. In the Project tab, choose the Baseline Manager icon.   
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2. Select the baseline you want to revert to and click Revert To. 

 

3. From the Revert Options group, select: Overwrite to revert the whole project to the 
baseline. 

4. Click Close. 
5. Click OK to revert to the baseline. 

All tasks will now move back to their positions recorded in that baseline. 

8.17.4- Merging.  Once a baseline has been created a function becomes available that allows you to 
merge extra data into that baseline.  

To Merge Date into a Baseline 
1. In the Project tab, choose the Baseline Manager icon.  
2. Select the baseline you wish to merge the new data in to. 
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3. Select Merge. 

 

4. The Details screen of the baseline will appear.  

You cannot change the name of the baseline but may wish to amend the description if required. 

5. Click Next. 
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6. On the Scope screen choose the data you are merging in, either All tasks in the 
current view or just Selected tasks. 

7. In the lower part of this dialogue box choose how you want the existing baseline to 
be effected by the merge, if you are only adding in additional data then choose Add 
new data only. If the original data has changed choose the 2nd option or a full update 
would include any deleted data. 

8. Click Next. 
9. If the Summary details are correct click Finish. 

Your baseline will be updated to record the changes made to your project. 

8.17.5- Embeded Baselines. Once a baseline is created, a function becomes available that allows 
you to embed that baseline to the schedule, instead of having a stand along file.   

1. In the Project tab, choose the Baseline Manager icon. 
2. Select the baseline you wish to embed into the file.  
3. Right Click on the baseline and select Embed.    

 

4. The embedded baseline will now have horizontal parallel bars next to the baseline 
name.  

 

 
8.18- UPDATING PROGRESS 

Once the project is underway and an initial baseline is created, you should record its progress at regular 
intervals.  Recording progress ensures that your project is kept up to date and lets you see if work is 
progressing as planned or if there are delays.  It also ensures that you know how much work remains to be 
done to complete the project and will also give you a projected program end date.  Updating consists of 
recording task Actual Start dates, the amount of work complete or the duration remaining, and Actual 
Finish dates when the activities are complete.  
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When you progress a task an actual start date must be entered and an actual finish date must be entered 
when the task is finished.  Once the task is complete, mark it as complete and enter the actual finish date. 

Before any progress is entered, the decision has to be made on how the schedule is going to be 
progressed.  The options to progress are to use overall percent complete or remaining duration. 

 

To progress via Overall Percent Complete, the following toggles must first be set within File, Options, 
Progress Tab: 
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To progress via remaining duration, the following toggles must first be set within File, Options, Progress 
Tab: 

 

8.18.1- Working with Single Progress Periods.  The simplest way to update progress is to use 
one progress line. This allows for changing the report date to suit whichever frequency is required for 
creating progress reports.  The following details the actions to perform when updating progress. 

 
To Displaying the Progress Table: 

Depending on how the user is going to enter progress will depend on which progress columns 
need to be displayed in thespreadsheet in order to enter the project progress.  
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1. Add the progress specific columns. 
 

The overall percent complete progress specific columns to add are: 

 

 
 
 
 
 

 
The remaining duration progress specific columns to add are: 

 
 

2. Save this table to use again in the future. Users can do this by clicking the View tab > 
Table > Save As, and then give the table a name, for example “Overall Percent 
Complete Progress Table” or “Remaining Duration Progress Table.” 

 
NOTE:  In Elecosoft Powerproject there are numerous ways to enter progress against tasks. The 
easiest way is to use the spreadsheet to enter the data as described above. 
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To Display Progress Lines: 
 

To view the progress drop line and shading on the tasks within the Bar Chart: 

 
1. On the Format tab select the Progress lines toggle switch. 

 
 

 
 

You should now see a black line showing in the bar chart, usually on the start date of new projects. 
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To Set the Report Date: 
 

To enter progress up to the correct date, the report date must first be established.   

1. Double-click the black progress line in the bar chart.  

Or 

1. In the Project View, click on the + sign next to Project Periods, then right-click on 
the Project Report Date and select Properties. 

The Progress Period Properties dialogue will appear. 

 

2. Change the Report date to what is required, for example 1 week into the program. 
3. Click Close. 

Notice how the progress line starts from the Project Report Date and ‘jags’ around the left hand 
side of the task(s). 
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To Enter Progress Using Overall Percent Complete: 
 
The Planned Percent Complete column tells users what they should have done by the report date 
selected above. 

 
1. Type the Actual Start Date in the ‘Actual Start Date’ column and the progress value 

in the ‘Overall Percent Complete’ column to see shading along the top of the task(s).  
If the task is 100% complete, type the Actual Finish Date in the ‘Actual Finish Date’ 
column. 

 
 

To Enter Progress Using Remaining Duration: 
 

1. Type the Actual Start Date in the ‘Actual Start Date’ column and the Remaining 
Duration in the ‘Duration Remaining’ column to see shading along the top of the 
task(s).  If the task is 100% complete, type the Actual Finish Date in the ‘Actual 
Finish Date’ column. 

8.18.2- Rescheduling 

1. On the Home tab, click the Reschedule Branch icon.  
2. In the Reschedule Progress Period Warning pop up, the Straighten progress entry 

period should be set to Progress Entry Period. If the user does not want to straighten 
the line, select None. 
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If “Progress entry period” is selected in the pop-up above, the effects of the progress will be visible when 
Elecosoft Powerproject straightens the progress line and moves all remaining work of incomplete and 
non-started tasks to the right of the Report Date.  

NOTE:  If the user has not baselined, then the user needs to be aware of the original start and end dates of 
the project as straightening the line may affect the end date of the project (the Undo option is available to 
rectify this). Alternatively, the user can select File > Save As before the user reschedules the project. 

 

 

Before Rescheduling 

 
After Rescheduling 

 

Notice the Finish Variance column is now populated, informing the user of the difference between the 
task(s) planned and actual finish dates. 

To display the non-rescheduled view of the project and not the straight line, select Undo. 
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8.18.3- Working with Multiple Progress Periods 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Display 
Progress Table

2. Display 
Progress Lines

3. Create Multiple 
Progress Periods

4. Set the 
report date

5. Enter your 
progress
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reasons

8. 
Baseline
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8.18.3.1- To Create Multiple Progress Periods: 

 
Progress periods allow you to display against each task when work was carried out. To create a 
progress period: 

1. In the Project View, Right-click on Progress Periods. 
2. Select New Progress Period. The Progress Period Properties Dialouge will display  

 

3. Give it a name ‘Week 1’ and ensure the date is at the end of the first week of the 
project.  The Appearance can be modified to change fill style foreground and 
background color along with pattern.   
 

4. Click Close. 
 

5. Repeat steps 1 – 3 for as many progress period that need to be created. 

Or another way to create Progress Periods is to do so using the Library Explorer. 

1. Open the Library Explorer by selecting Library Explorer  icon on the Quick 
Access Toolbar. 

2. Select the Progress Period folder on the left hand window. 
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3. Right-click underneath the Project Report Date entry and select New Progress Period. 

 

4. Name it ‘Week 1’ and ensure the date is at the end of the first week of the project. 
Then press Enter on your keyboard. 

5. On the next line, type ‘Week 2’, ensuring the date is at the end of the second week 
and Enter. On the following line type ‘Week 3’ and ensure the date is at the end of 
week three, etc. 

 

6. When you are finished close the Library Explorer by clicking on the ‘x’. 

8.18.3.2- To Set the Report Date: 

Before we enter the progress we will need to ensure we are recording the progress against the correct 
progress period 
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1. On the Home tab, ensure that the correct period is set from the Progress Period drop 
down list. 

 

Or 

1. In the Project View, click the + sign next to Progress Periods, right-click on the 
progress period that you want to use and select Progress Entry Period. 

Note: When it comes to updating progress for the following week, you will need to follow the Progress 
Cycle from the steps above, then select Week 2, and so on for the following weeks. 

 

You will notice the progress line will appear down the report date and ‘jag’ around the left hand side of 
the appropriate task(s) 

8.18.3.3- To Enter Progress Using Overall Percent Complete 

1. Entering progress for multiple progress periods is the same as entering it with one. 
Type the Actual Start Date in the ‘Actual Start Date’ column and the progress value 
in the ‘Overall Percent Complete’ column to see shading along the top of the task(s).  
If the task is 100% complete, type the Actual Finish Date in the ‘Actual Finish Date’ 
column. 

 
 

8.18.3.4- To Enter Progress Using Remaining Duration 

1. Entering progress for multiple progress periods is the same as entering it with one. 
Type the Actual Start Date in the ‘Actual Start Date’ column and the Remaining 
Duration in the ‘Duration Remaining’ column to see shading along the top of the 
task(s).  If the task is 100% complete, type the Actual Finish Date in the ‘Actual 
Finish Date’ column. 
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8.18.3.5- Rescheduling with Multiple Progress Periods.  When rescheduling the project 
with multiple progress periods, you will notice them listed in the Straighten Progress Period drop 
down list. 

 

You have 2 options – you could reschedule to the Straighten progress period as seen above or select the 
Progress entry period (this will reschedule to whichever week has been selected on the Home tab). 

8.18.4- Other Progress Tools 

 
 

8.18.4.1- Showing Tasks in Progress on the Spreadsheet.  You can configure the 
spreadsheet to highlight start and finish fields that represent actual dates. This provides you with a 
way of being able to see which dates are actual dates without having to display actual start and 
actual finish columns. 
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8.18.4.2- Displaying Specific Progress Periods in the Bar Chart 

To view the progress drop line and shading on the tasks within the Bar Chart: 
 

1. On the Format tab, select Format Bar Chart icon.   
2. Select the Progress tab. 

 
 
 

3. Put a tick in the Lines On tick box. 
4. If you tick the Progress entry line only option, the software will automatically show 

the drop line of the selected report date. 
5. If you want a specific progress drop line to show, select the progress period by 

placing a tick against that progress period. 
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8.18.5- Progress Options.  When entering progress you may want to ensure that the correct 
options are set to suit your project. 

1. In the File tab, select the Options icon.  
2. Choose the Progress tab. 

 
 
 
 

3. Under Overall Percent Entry Mode decide if you would like the progress to be 
updated according to the amount of progress done (Update duration in step) or 
whether you would like the progress to automatically fill up to the current report line, 
pushing the remaining duration to the right of the report line (Fill to progress line). 

4. Under Snapping decide if you would like the progress to snap to the nearest duration 
(e.g. Days).  If this is not ticked the progress will sit at exactly the progress position 
stated (e.g. 10 day task with 33% done will leave 6d 5.6h left.  If the snapping is 
ticked it will read 6d remaining). 

5. Click Close. 
8.18.6- Working with Baselines, Columns and Progress.  If you would like to compare 
planned and actual progress data in your columns, there are a few things of which to be aware.  
Firstly, all planned data within Elecosoft Powerproject comes from the Baselines you have created.  
All the actual data is what you have recorded against the live tasks in your project.  

 
8.18.6.1- Displaying Weekly Progress Figures (only possible with multiple progress 
periods) 

To show the progress entered against the tasks for each week you have updated on, we will add a 
number of ‘Overall Percent Complete’ or ‘Percent Complete’ columns (see the difference above 
to choose your preferred column). 
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1. In the Table Definitions Properties dialogue of the first column, rename the title to 
‘Week 1 Progress’ and change the Progress Period to retrieve the information from 
‘Week 1’: 
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2. Then highlight the second column you added and rename it to ‘Week 2 Progress’ 
and point the column to the ‘Week 2’ Progress Period, etc. 

 

Your spreadsheet will show the percentages you have entered in each week of the project (notice the 
figures are not cumulative). 
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8.18.6.2- Displaying Planned vs. Actual Start and Finish Dates 

To show planned and actual start and finish dates of the tasks in your project, add the 
following columns: 

1. Add Column > Date > Actual Start and Actual Finish. 
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2. Also under the Date category of columns, Add the Start and Finish columns (These 
will become your planned columns): 
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3. When the Table Definition Properties dialogue appears, change the Start column 
title to ‘Planned Start’. Afterwards rename the Finish column title to ‘Planned 
Finish’. Then ensure each column looks at the Current Baseline instead of the Live 
data. 

 

The spreadsheet will be populated with all the relevant data: 

 

8.18.7- Recording the Actual Start and Finish Dates for Each Progress Period.  When 
using multiple progress periods you can bring up a column that will look at the actual start and finish 
dates of each progress period. 

1. Add a column to the spreadsheet that displays either the Actual start or Actual finish 
field. 

2. On the Column Definitions tab of the Table Definition Properties dialog, select the 
field that you have added to the spreadsheet. 
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3. Select the progress period to which you want the field to refer in the Progress period 
field. 

4. Enter an appropriate description for the spreadsheet column in the Column title field 
- if you set up more than one column, with each one displaying actual start or finish 
dates for a different progress period, include the progress period name in the column 
title. 

5. Click Close. 

Recording Notes.  To record any delay reasons or important Notes from the previous week, type these in 
as notes on the activity.  

In the bar chart select the task which you want to add notes to and click the Bar & Task Properties > 
Notes tab.  If a dated note is entered, it will show the date and time the note was created.  If a regular note 
is added when hovering over an activity, the dated note will not appear.   

 

Note: If you cannot see ‘Bar & Task Properties’ at the bottom left hand side of Elecosoft Powerproject, 
select the Toggle Properties View icon.  If you cannot see the Notes tab, click the >> icon in the bottom 
left of the the Bar & Task Properties to show more tabs.  To enter activity notes, enter them in the Notes 
section.  To enter notes that have a title and time stamp, enter them in the Dated notes section.   

After each progress period you could keep a record of the week’s progress by using a Baseline. This 
makes it easier and is useful to see everything that was recorded at the end of each progress period, 
especially for potential claim situations. (Please see the ‘Creating Baselines’ for the Notes on this). 

 
 
 
 
 
 
 
 
 
 
 
 
 



Chapter 8: Elecosoft Powerproject Client  Publication 615 

8-130 

8.19- FILTERS  

Filtering allows us to access specific areas or a subset of our project, such as tasks that are critical or are 
being worked on by a certain resource. A commonly used filter is based on Code libraries that have been 
applied to tasks, but you can also filter by date, cost and many other criteria. Filters will be stored in your 
filter menu for future use. 
 

8.19.1-  Creating a New Filter Using the Filter Wizard 

1. On the View tab, select the Filter icon, then select New.  
2. Enter the name of the filter you are creating. 

 

 

 

 

 

 



Chapter 8: Elecosoft Powerproject Client  Publication 615 

8-131 

3. Choose a category for the filter (if applicable). 
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4. Click Display on Menu to add the filter to the short list of filters. 
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5. Click Subheading properties to choose to have a color sub-heading band to highlight 
which area a task has come from. 

 

6. Click OK 
7. Select Edit to create the criteria of the filter: 
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8. Choose what types of tasks or allocations you wish to find with your filter, and click 
Next: 
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9. Select the type of information that you wish to filer by, such as Code Library, Time 
Slice etc. Click Next. 

 

10. Select the specific data you wish to filter on, Click Next. 
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Note: If you select the tick box ‘Ask me which code library entries to use each time the filter is applied’ 
the filter will open this page of the filter wizard every time you run the filter. 

 

 

 

 

 

 

 

 

 



Chapter 8: Elecosoft Powerproject Client  Publication 615 

8-137 

11. Review the filter you have created, if all is correct click Finish. If not you can click 
Back to return to the previous screens. 
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12. Click OK to run the filter. 

 

13. Once you have created your filters, they can be run by selecting the Filter  
icon from the View Tab and selecting the filter name.   

8.19.2-  To Turn a Filter Off 

1. On the View Tab click on the Filter  icon and select No Filter. 

 

-Or-  

1. Click on the filter description showing at the bottom of the screen.  
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8.20- SORTING AND GROUPING A PROJECT 

Within Elecosoft Powerproject you can sort or group bars and tasks to reorder your project according to 
certain data such as start date, by code library, their amount of work, their cost, their progress and many 
other parameters. 

 
8.20.1-  Creating a Sort.  The Sort that will be shown in this section will reorder to the 
Contractors Code library. 

 
1. On the View tab, select the Sort/Group icon.   
2. Click on New. 

 

3. Enter a Name for this sort, e.g. Contractor Sort. 
4. Select a Category for this sort (if applicable). 
5. Choose Display on menu if you want to sort to show on the shortlist under 

Sort/Group. 
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6. In the Type column, select the object type that you wish to sort, the most common is 
Task. 

7. In the Attribute column, choose the specific piece of data you wish to sort by, such as 
Start, Contractor etc. 

8. You can change the direction of the sort in the Direction drop down. 
9. Tick Insert page break to have a page break at the bottom of each set of data. This 

will allow you to print each set of data on a separate page. 
10. If you have assigned multiple codes to the same task, select Show duplicate items for 

multiple assignments, which create a copy of the task in each group of tasks. 
11. The Sub-heading drop down allows you to choose how you want the summary 

heading to be displayed. Sub heading with only name column is the recommended 
option. 

12. Click OK to apply the sort. 
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8.20.2-  To Remove a Sort 

1. Click on  icon on the View tab and select Natural Order.   
• You can also use this to choose to run another sort on your 

project 

-Or- 

1. Click on the sort description showing at the bottom of the screen.  

8.21- CREATING TEMPLATES 

Templates are used to make creating a new project as quick as possible, as the template can contain 
filters, code libraries, tables and many more items that you may use.  For PennDOT design schedules, 
the templates have already been created (PDSMASTER and District specific templates). 
 
To create a template, it is best to base it on one that already exists (e.g. PDSMASTER Template) as 
this should already contain some items that may prove useful to you.   
 
Once this project has opened on the screen you can now create everything you want in the template 
(e.g. Filters, Code libraries, etc). 
 
You can even include titles and tasks within the Bar Chart. This could mean that for the first few lines 
of the project, you type in the most common titles (and include tasks if you wish) as it is quicker to 
delete something than to create it. 
8.21.1-  To Save a Project as a Template 

1. Go to the File menu, select Save As. 
• The Projects folder and contents are displayed.  
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2. Go up a level by clicking once on the yellow folder just to the right of the folder 
window. 

3. Inside this folder Double-click on the templates folder. 
• The templates folder and contents will be displayed.  

4. At the bottom in the File Name you can rename your project template if you want to.  
5. Click Save. 

8.22- RESOURCES 

Both permanent and consumable resources can be recorded on the project, however for PennDOT 
construction jobs, only permanent resources are required to be tracked if the contract dictates a resource 
loaded schedule. 

A Permanent Resource is a type of resource that is reusable (for example, labor and equipment). 
Consumable Resources are consumed by or supplied to tasks in a project (for example, materials, 
components, etc.). 

8.22.1- Creating Permanent Resources.  The resource library can be organized in a flat 
structure or users can plan in teams hierarchically (for example, putting resources in folders so that 
users can report on groups of allocations as well as individual resource allocations). 

 

 

In this example, resources will be in a folder called All Resources. 

1. Select Permenant Resources from the folders on the left-hand side. 

2. In the right-hand window, Right-click and select New Folder. 

3. Name the folder.  Once created, Double-click on top of it. 

4. Right-click on the right-hand side and select New Permenant Resource. 

5. Type “Bricklayers” in the name field and press Enter. 

6. Type in the remaining resources: Carpenters, Decorators, Electricians, Plumbers, 
Roofers, pressing Enter after each one. 
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8.22.2- Setting Permanent Resources Defaults.  Default information can be set that will 
apply each time the resource is allocated through the project. 

1. Right-click on the name Bricklayers and select Properties. 

2. On the Details tab set an Availability figure to monitor any over allocation. This 
records the maximum number of resources available to work on the project at any 
one time and Elecosoft Powerproject will recognize a requirement greater than this as 
over-allocation. In this example, there will be 4 bricklayers available for this project. 

 

3. Change the resource appearance foreground color to a color of your choice. 
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4. On the Assignment tab set the Modelling Type to Effort on Allocation and change 
the Calculated Parameter to Effort. This ensures that the resource will not affect the 
duration of the tasks. 

 

5. Finally put a tick against May be Shorter than Task if users require a resource to 
work for only part of the tasks duration. 

8.22.3- Resource Allocation.  A task can have several permanent resource allocations. In this 
example, assume that the resources will work the total duration of the task. 

8.22.3.1- Creating an Allocation Table.  First set up a table to allocate the resources and 
display the information clearly. 
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From the Default table, create a table to show: 

 

1. Right-click on the column header and select Add Column > Allocations > 
Allocation. 

2. Add a second column by clicking the Add button in the Table Definition Properties, 
select the duplicate column and from the drop down list of categories Resource > 
Effort. 

3. Close Table Definition Properties. Save this as a Resource Allocation Table. 

8.22.3.2- Showing/Hiding Resource Allocation Bars.  When users allocate a permanent 
resource, an allocation bar indicating the allocation and its position may be shown under the task. 

 

Using the Display Switch on the Format tab at the top of the screen, select Scheduled Allocations 
icon. 
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8.22.4- Allocating Permanent Resources to a Task 

1. Make sure the Project View is open. 

2. Expand the tree until you can see the Bricklayer resource. 

3. Left-click the mouse and drag the Bricklayer resource over the Brickwork to 
Abutment 1- Drive Piles task until the pop up box says “Assign Bricklayers to 
Abutment 1- Drive Piles” and let go of the mouse. 

 

4. The allocated resource is displayed in the Bar Chart and in the spreadsheet. 

 

5. Change the figure in the allocation column from 1 to 3 to show that 3 bricklayers will 
do this task. 

8.22.5- Resource Report Table.  This table allows users to make allocations by entering data 
straight into the spreadsheet so it could be used as an alternative to the ‘drag and drop’ method above. 
It is also useful for reporting on our resource allocations throughout the project. 

 

1. From the Default table, Right-click on any spreadsheet column and select Add 
Column> Resource> Resource Allocations. 
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2. The Table Definition dialogue will then appear. 

 

 

3. Additional columns can be added via this dialogue box. 

4. To add more resources columns select Add from the bottom left hand corner. Users 
can add as many of these as they want (so each resource can have its own column). 

Now to reference this to the resource we want it to display. 
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5. Right-click on the Resource Allocation field (to the left of the dialogue) and in the 
Appearance field marked ‘Column Title’. Adjust the text to read Bricklayers – this 
controls the text that is used for the column titles in the table. 
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6. To make the column token refer to a particular resource, in the Attributes section 
change the ‘Cons/Perm/All’ field to ‘Permanent Resources’ and change ‘Resource’ to 
Bricklayers. 

 

7. Repeat for any other resources, using the same ‘Resources Allocations’ token, 
renaming the column title and referring to the attributes to the relevant Permanent or 
Consumable resources. 

8. Click Close. 
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This table will now allow users to type the resource allocation for each task directly into the 
spreadsheet.  If the resource is not already assigned, then typing into the table will assign it. 

Unlike the first method, this method allows users to enter an allocation without displaying the 
allocation bars on the bar chart. 

 

8.22.6- Using Groups of Resources.  If bricklayers and laborers work together on this project, 
they could be allocated separately but this will become time consuming if the project is large.  Instead 
we can create a team using an Allocation Group. 

Creating Groups.  For example, to put bricklayers and laborers into an 
allocation group called ‘Brickie Gang.’ 

1. First create Permanent Resource libraries for each resource. 

2. Allocate both bricklayers and laborers to a task in the desired quantities. 

3. Right-click on the task and select Copy Allocations to Group. 

4. Type ‘Brickie Gang’ in the name field then click Ok. 

 

 

The allocation group appears in the project view. When this gang is needed again, drag and drop 
‘Brickie Gang’ on the appropriate task(s) and it will be assigned the resource. 

8.22.7- Using the Resource Breakdown Structure View (RBS).  Sometimes it is very useful 
to see a view of the project by a resource (or resources) (for example, to have a view of where in the 
project Bricklayers are allocated). This type of view is called a Resource Breakdown Structure or 
RBS for short. 

1. Make sure the Project View is opened and ensure that allocations are displayed on 
the Bar Chart. 

2. Right-click on Bricklayers and select Open RBS. 
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3. Hold down the Ctrl key and then select multiple resources in the Project View to 
build RBS views of more than one resource. 

4. To return the project back to how is it normally viewed, just click once on Program in 
the project view. 

8.22.8- Displaying a Resource Histogram 

1. Go to the View tab > New Histogram.  

Users will initially be presented with a thin histogram however users can resize the histogram. 

2. Move the histogram up the screen by placing the cursor over the top line of the 
histogram area and dragging this up the screen. 

3. Now move the cursor over the bottom line of the histogram and drag this down the 
screen to enlarge the histogram area. 

4. In the histogram at the bottom of the chart, Left-click in the first drop down window 
to the left of the screen and select the resource folder that the user has been using. 

 
5. In the second drop down window, select Allocation, Availability, and Over 

Allocation. 
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The graph shows the availability, allocation and over allocation of resources. 

 

8.22.9- Drilling Down.  The All Resources folder is a group made up of several individual 
resources. It is possible to create graphs for each of these individual resources from this overall graph. 

1. Right-click on the graph area and select Drill Down (All). 

2. The individual graphs are now displayed underneath the overall graph. Use the scroll 
bar on the right-hand side of the screen to see the graphs. 

 

 
 

3. Right-click on any of the lower graphs and select Drill Up to close the graphs. 

4. To close the histogram, select View > Close Histogram. 

As an alternative, users may prefer to see all the resources ‘stacked’ on one graph. 

8.22.10- Showing Tasks.  It is possible to display the tasks that contribute to the over allocation. 
1. Right-click directly over the red area on the histogram, select Show Tasks from the 

menu. 

2. A new view is displayed showing the tasks where the over allocation has occurred. 
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8.22.11- Other Histogram Tools 

8.22.11.1- Displaying/Printing off the Histogram 

1. Right-click on the left-hand side of the histogram and select Move to Histogram 
View. 

 

2. This will then take the histogram off the project and put it in its own view. Users can 
repeat this as many times as they want to have more than one histogram in the view. 

3. By closing the view users will automatically return the histogram back to the project. 

4. Or if users want to return a specific one back to the project, Right-click on the left-
hand side and select Move to Barchart to return to the project. 

8.22.11.2- Changing the Scale of the Histogram.  It is possible to adjust the scale down the 
side of the graph. 

1. Right-click on the right-hand side of the histogram and select ‘Format...’ 

2. Select the Row tab. 

3. In the middle of the dialog box put a tick against Fixed y-axis and then enter the 
range (first figure goes from 0 down and the second window from 0 up (for example, 
-3 to 7). 
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8.22.11.3- Displaying Axis Labels and Legends of the Histogram.  On the Row tab, tick 
the Axis Labels and Legends boxes at the top of this dialog box. 

 

 
8.23- HOW TO CONVERT A COMPATIBLE FORMAT TO ELECOSOFT 
POWERPROJECT 

8.23.1- Working with Elecosoft Powerproject Compatible File Formats.  Elecosoft 
Powerproject is unique in that it can open and save to other scheduling file formats.  It is compatible 
with Sure Trak, P3, P6, and Microsoft Project.   

Before a conversion can take place, the contractor must first have a licensed copy of Elecosoft 
Powerproject.  A contractor does have the ability to request a license of Elecosoft Powerproject from 
PennDOT at no cost to them.  This license will be a loaned license for 90 day increments for the life 
of the construction project.  To download Elecosoft Powerproject and request a license, see Chapter 7 
of this manual. 

Once a licensed copy of Elecosoft Powerproject is available, the following sections will walk the 
contractor through how to convert an Elecosoft Powerproject compatible format to Elecosoft 
Powerproject. 

8.23.2-  Microsoft Project File Conversions 
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8.23.2.1- To Save a Microsoft Project File in the correct compatible Microsoft 
Project format 

1. Open the Microsoft Project schedule in Microsoft Project 

2. Go to File, Save As 

3. Select the Destination where the file is to be saved (One Drive, Computer, etc.) 

4. Change the Save As Type to XML or MPP Format  
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5. Click Save 

8.23.2.2- To Convert a .XML or .MPP Microsoft Project File into Elecosoft 
Powerproject   

1. Open Elecosoft Powerproject 

2. Go to File, Import/Export  
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3. Select Import from Microsoft Project®  

 

4. Select Browse, and navigate to the Microsoft Project file.   
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5. Click Open 

6. Select the template that should be used, Use Template should be one of the 
PennDOT Templates. 

 

   
 

7. Under Options, make sure all boxes are checked.   
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8. If negative costs are built into the schedule select if they should be imported as 
Income or Negative cost 
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9. Select OK 

 

10. Once the file opens in Elecosoft Powerproject, reschedule the project 

11. Select File, Save As 
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12. Select the destination to Save the schedule and make sure the Save as type is set to 
Elecosoft Powerproject (*.pp) 

 

 
8.23.3-  Primavera File Conversions.  For the most part, Primavera file conversions do come 
into Elecosoft Powerproject one to one.  There is one aspect of Primavera that does not convert into 
Elecosoft Powerproject and that is ‘mandatory constraints’.   Before converting into Elecosoft 
Powerproject, make sure all ‘mandatory constraints’ (mandatory start or mandatory finish) are 
changed to ‘start on’ or ‘finish on’ respectively. 

Another tip before you convert a Primavera file to Elecosoft Powerproject, verify that the working 
hours per day of all the calendars are set up correctly within Primavera.  The following steps will 
walk through how to ensure working hours per day are set up: 
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8.23.3.1- How to Verify Working Hours per Day in Primavera 

1. Open calendars from the Enterprise Menu 

2. Select the calendar that is being used and click Modify 
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3. There is a box on the right where the hours per day is set, verify the value is what is 
desired for the specific calendar. 
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8.23.3.2- To Convert a Primavera File into Elecosoft Powerproject 

1. Open Elecosoft Powerproject 

2. Go to File, Import/Export 
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3. Select Import from Primavera®  
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4. Select the Import type and then select Browse, and navigate to the Primavera file.   

 

5. Click Open 
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6. Select the template that should be used, Use Template should be one of the 
PennDOT Templates. 
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7. Calendar for link lag should be set to 24 Hour.  
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8. If STX/DIR was selected as the file type check, the Permanent and Lump Sum 
Cost under Units of measurement to classify resources in SureTrak®.  

 

9. Click OK 

10. Once the file opens in Elecosoft Powerproject, reschedule the project. 

11. Select File, Save As 
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12. Select the destination to Save the schedule and make sure the Save as type is set to 
Elecosoft Powerproject (*.pp) 

 
 

 
 

13. Click Save 
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8.23.3- Opening Elecosoft Powerproject Compatible Schedule Formats 

1. Select the File tab. 

2. Select Import/Export 

 

3. Browse to the compatible file format (from the list above on the screenshot), and 
select OPEN. 

8.23.4- Saving Elecosoft Powerproject Compatible Schedule Format into Elecosoft 
Powerproject Client 

1. Once the compatible file format is open within Elecosoft Powerproject Client, select 
File. 

2. Select Save As. 

3. Give the file a name, and change the Save as Type to a .pp extension. 

4. Select Save. 
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8.23.5- Saving Elecosoft Powerproject Client schedule into an Elecosoft Powerproject 
Compatible Schedule Format 

1. Once the Elecosoft Powerproject schedule is open with Elecosoft Powerproject 
Client, select File. 

2. Select Import/Export. 

3. Select an Export Option.   

 

4. If Export to Primavera was selected, toggle on the appropriate settings for you 
project.   
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5. Give the file a name and location.   

6. Select Save. 

Note:  In order for a schedule to be uploaded into the Web Portal, at this time the schedule must be in an 
Elecosoft Powerproject (.PP) file format. 

 

8.24- THE NETWORK VIEWER 

The Network Viewer is a tool that can be used to easily view the project’s logic. It is a more compact and 
simpler way to depict tasks and the relationships between them. The Network Viewer is just another view 
within Elecosoft Powerproject that allows users to easily view and print out the layout of the project 
which can be very useful when reviewing and analyzing projects. 
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8.24.1- Accessing the Network Viewer in Elecosoft Powerproject 

1. Select the Project Tab. 

 

 

2. On the Project Tab, select Network Viewer.  

 

3. The Network Viewer is launched, displaying the current view of the project as a 
PERT chart in the main view. 
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8.24.2- Modifying the Content of the Boxes 

1. Click Manage Task Properties in the top right corner on the 

 toolbar  

The Task Property List displays. 

 

2. Fields can be added or removed depending on what the user wishes to show within 
the box. 

3. Click Ok. 
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8.24.3- Printing the Network Viewer 

1. Click the Print    icon. 

• The Printer Options will populate on the right side of the screen. 
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2. Click Printer Options to change settings for the printer. 

• The Printer Options dialog box displays.  

 
3. Select the Printer, by clicking the Printer button.  

4. Orientation can be set to either Landscape or Portrait (Landscape is recommended). 

5. Select a Page Size from the drop-down list. 

6. Select Print Layout to change the layout options.  

The Print Layout dialog box displays. 

 

7. Layout should be set to Fit to one page.  
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8. Select Border Properties to change the border properties. 

• The Border Properties dialog box displays. 

 

9. Click Print Preview to view the printout.  
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10. If the printout shows the information the user wishes to see, click Print    from 
the Print Preview. 

Other modifications can be made to the Network Viewer, which are further explained in the Help Menu, 

by selecting  on the  toolbar. 

8.25- SETTING UP THE PROJECT TO PRINT  

As a general rule what you display on the screen is what will be printed 
 
Therefore, select the ‘View’ of your choice or manually change any formatting, tables etc to customise 
the display to what you wish to print 
 
The scale of the project can be adjusted for you to allow printing to a certain number of pages 

 
8.25.1- Editing Details for Display on Borders .  When you print an Elecosoft Powerproject 
file it is printed with a border around the project. The border file enables you to display relevant 
project & company information along with your project data 

Some of this information, like the Project Name, Who the project is by & who it is for has already 
been completed and can be accessed. 
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8.25.1.1- Accessing the Project Information: 

 
1. Select the File tab, select Properties and then Advanced Properties. 

 

 
All further information, such as revision dates, program numbers etc can be found: 

 
2. Select the File Tab. 
3. Click the Print command. 
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4. Choose Full Preview  icon.   

 5. Click on the Output Fields icon.  

 

 

8.26- PRINTING THE PROJECT 

As a general rule what you display on the screen is what will be printed. Therefore select the ‘View’ of 
your choice or manually change any formatting, tables, etc.  
 

8.26.1- Customizing the Display for What to Print 

1. Select the File Tab. 
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2. Click the Print command. 
3. Choose Full Preview icon.   

 

8.26.2- Print Settings.  This function allows you to configure the settings to be used when 
printing, i.e. which printer or PDF writer to use, which border file to use and customize etc.  To 
access this, select the icon below:  
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8.26.2.1-  Output Tab 

 
 

The output tab control where the print out is going to and what file type is going to be created if 
applicable. The main output options are: 

  
• Printer – Tick Printer and choose your printer from the drop down list; from the 

properties button decide your printer orientation and size (standard printer usage) 
Press the Print button to activate Print. 

• PDF – If you have a PDF writer installed, you should see it listed in your printer 
dropdown list.  If not, consult your IT department who can install it for you. 

• Clipboard – Tick clipboard to have your print preview copied to the clipboard. 
You can then open Word, Excel etc. Right-click on the page and select paste, to 
paste your print preview into the document. Press the Print button to activate the 
copy to clipboard. 

• Picture file – Tick Picture file to have your print converted into a JPEG picture 
file, which can be inserted into Word, Excel, PowerPoint etc. Use the Browse 
button to choose where to save the new file and what filename to give it.  Press 
the Print button to activate the file creation. 

The Print Range decides which pages of the project document you wish to print this time: 
 

• All – Prints all pages 
• Selection – Prints only what you have selected in Elecosoft Powerproject  
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• Pages – Prints only the pages you specify in the available field 

8.26.2.2- Details Tab  

 
 
In Details you have the options for your border file and it lets you limit the dates of the project you wish 
to print.  When you print an Elecosoft Powerproject file it is printed with a border around the project. The 
border file enables you to display relevant project and company information/logos etc. along with your 
project data. 
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Choosing a Preferred Border File: 

 
1. Click the dropdown arrow to view all of your available border files. 

 

 
 

2. The filenames of our border files contain a name (i.e. CHT) and page size (i.e. A4) 
and the orientation of the paper (i.e. ‘L’ for landscape or ‘P’ for portrait).  A good 
default border to use would be CHT-A4L. 
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3. You can select a file from the list, or click ‘Browse’ if you have your own border 
saved elsewhere.  When you do this, it will take you to the ‘Borders’ folder as shown 
below.  An example of the border file selected will appear on the right hand side. 

 

 
4. Click Open when you have selected the appropriate border file. 

Borders are separate files on your computer or network and do not form part of your Elecosoft 
Powerproject file. This may mean that if you send your project elsewhere to be viewed or printed, such as 
via email, the border file may not be available to the recipient 

To avoid this, you are able to embed the border file which will add a compressed copy of the border file 
to the Elecosoft Powerproject file, meaning if it were to be sent, the border file would be included. 
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8.26.2.3- Embedding a Border File 

1. Click on the Embed button. 

 

The following dialogue box will appear: 

 

 

 

 

2. Choose a name for your embedded border (N.B it doesn’t have to be the same as the 
Border file). 

3. Click OK. 
4. The Embedded border shows in the Border file list and the Embed button now 

displays as Delete. 
5. Delete is active so that if you no longer need the embedded border it can be deleted 

from the .pp file. (N.B. this does not delete the main border file). 
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Note:  Once a border file has been selected, you will need to ensure the ‘Border page size’ 
matches the ‘Printer page size’, e.g. as seen below, the Printer page size needs to be changed 
to Landscape. 

 

 

In the Date Range section, you are able to select specific dates within the project that you wish to 
print. 

 
8.26.2.4- Printing a Specific Date Range: 

1. From the two drop down cells, choose a start date for the data you are printing and an 
end date to slice that period for printing 

Once you have chosen your settings, sizes and selections in the print dialogue box you can 
save all these ticks. 
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8.26.2.5- Saving a Print Profile: 

1. With all selections made click on Save As.  

 

2. Give your new profile a name, click on OK. 

Note:  The next time you then want to print, go straight to ‘Print profile’ and choose the profile that you 
want from the dropdown arrow.  All the selections you saved will be remembered 
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8.26.2.6- Customizing the Border File and Inserting a Company Logo: 

After selecting the appropriate border file in the Details tab, you can click Edit on the right hand 
side to customise it further. 
 
Customizing a Border File: 

 
• Click Edit. 

 

 
 

This will open up a separate software program called ‘Elecosoft Powerproject Powerdraw’ 
which is used solely to create and customize border files for Elecosoft Powerproject files. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Chapter 8: Elecosoft Powerproject Client  Publication 615 

8-191 

You will notice the fields of information that will be shown when this border file is printed, e.g. 
<PROJ-TITLE> as seen in the screen print below.  These can be moved around your border file 
or deleted completely until you are happy with the layout and the project data that will be visible. 
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• To insert a company logo, select the New Picture icon on the toolbar.  Then use 
your cursor to draw a square box of where you want the logo to appear.  When you 
release the cursor, the following dialogue box will appear: 

 

 
• Click ‘Filename’ as circled above to navigate to the folder which contains the 

company logo you wish to use.  
 

• Click ‘Insert’ and ‘OK’ to see the logo in your border file.  You can then reposition 
and resize the logo accordingly 
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• By default the picture(s) will snap around the faint square boxes that appear in the 
background of the border file.  In order to reposition and resize it accurately, select 
‘View’ from the toolbar and untick the ‘Snap to Grid’ option from the list:  
 

 
 
• When all the changes have been made, click ‘File’, ‘Save As’ so you can select this 

customised border file again the in future.  If you do not want it to be saved in the 
Borders folder, click ‘Browse’ and open the appropriate folder to save it in. 
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8.26.2.7- Scaling Tab 

The scaling tab is used to control the size of your print out. It can be set manually, by selecting 
the actual print size of a time unit (i.e. 1 Week to a centimeter) or by selecting the number of 
pages you would wish to have: 

 

 
 

The View Scales options allow you to control the size manually: 
 

• Override horizontal (date zone) scale – Allows you to control the scaling of the 
date zone (size of a week etc).  The default setting is set to ‘Automatic’. 

• Override vertical (Chart) scale – Allows you to control the scaling of each bar 
line, Allocation and Baseline height.  This is controlled by the settings in Format 
Bar Chart, Vertical Scale, but does not set them in the program. 
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The Scaling Type details how the border file will be used on a multi-page printout: 
 

• Fit border around output – If printing to more than one page, this setting 
allows you to apply the border around all of the pages. 

• One border per page – If printing to more than one page, applies your chosen 
border to each page printed. 
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The Horizontal & Vertical Pagination options allow Elecosoft Powerproject to adjust the size of 
the print out to fit to a chosen number of pages 

 
• True size – Prints your plan at the exact size set in the date zone or spread sheet, 

so may end up printing across a number of pages. 
• Horizontal scaling – With true size selected this will increase or decrease your 

print out by the number selected e.g. 1.5 would print at 1.5 times its normal size. 
 

• Expand to fill space – Expands the chart to the edge of the border. 
 

• Vertical scaling – Increases your vertical scale by the number entered.  E.g. 2 
would increase your vertical scale by twice the height. 
 

• Use Defined page breaks – Prints a page dictated to by the position of a page 
break.  A page break is created in the bar chart by Right-clicking in the bar chart 
where you want the page break to happen and selecting Page Break. 
 

• Fit lines per page – Gives you control of how many lines you would want 
printed on each page. 

• Fit to at most –  Will fit it to the pages you specify 1x1, 2x2 but if you choose a 
size which is beyond a reasonable printout e.g. 5x5 pages for a 10 line program it 
will keep it to a size which it regards as a best fit. 

• Try to fit to exactly – Will fit exactly to the pages requested whether it would 
look reasonable or not. 
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2.26.2.8- Appearance Tab  

The appearance tab allows you to add or remove certain elements of the printout, such as legends, 
shading and hidden columns. 

 

 

 
• Legends – this shows a key at the bottom of the print out for any of the items 

ticked. 
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• Bar Chart – ‘Show date shading’ will either show or hide shading used on a 
plan. 

 

 
 

 
 
 
 
 
 

• Spreadsheet – ‘Tick Visible columns’ only to only print the columns you can 
see on the screen. 

 

 
• Date zone – ‘Display at foot’ will show the date zone at the bottom of the page 

as well as the top. 

 

 
On the right of the dialogue box: 

 
• Legends – You can change the font of the legends which display at the base of 

the print out or just use the fonts from the spreadsheet. 
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• Spreadsheet – If a font is difficult to read you can use these options to change 
the size of the font in the spreadsheet to make it easier to read. 

8.26.3- Output Fields.  The Output fields icon (circled below) is where you can edit the display of 
relevant project and company information that may appear within your chosen border file. 

 

 
The information you can edit in these tabs include the program number, revision number, comments, 
etc. 
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• To edit the original project name, the recipient of the project and who created it, 
close the full preview screen and select File, Properties, Advanced Properties. 
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Or 
 

• Select File, Properties and edit the information under Details 

 

 
 

8.26.4- Display Switches.  Users are able to access the display switches from the Format tab in the 
Full Preview screen.  When clicking the Display Switches icon a subset of additional icons will 
appear on the right hand side of the toolbar. 

 
      

 
Users can easily toggle on and off what they wish to display or not display on their printout. 

                
8.26.5- Print.  When satisfied with the layout and data displayed, click the ‘Print’ button from the 
toolbar circled below: 
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8.26.6- Customizing for an 11 x 17 Printout 

1. Select the File Tab. 

2. Click Print. 

3. Click Print Options.  
 

 

• The Print dialog box displays. 
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4. Make sure the Printer box is selected and select the correct printer to print to. 

 

5. Select the Detail Tab. 
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6. Click Browse to locate the correct border file to use. PennDOT has several standard 
border files starting with the title “PennDOT . . .” 

7. Set Printer page size to Tabloid. Select Landscape from the drop-down box. 

 

8. If desired, set the Date Range. This is only relative to the bar chart. All activities 
within the spreadsheet will still print.  If nothing is set it, the range will include the 
entire project. 
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9. Select the Scaling Tab.  

 

10. Use the radio button to set Override horizontal (datezone) scale to Automatic.  

11. Use the radio button to set Horizontal pagination to Fit to at most . . . . Use the drop-
down box to select 1 page. This ensures that the spreadsheet and the bar chart are 
fitting horizontally on the same page. 
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12. Use the radio button to set the Vertical pagination to True size. 

 

13. Click the Appearance Tab. 
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14. Click the + next to Date zone. Make sure Locked to pages is selected. This ensures 
that when multiple pages are printed, the column headings and date zone are printed 
on all pages. 
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15. Click Close, a print preview displays. (See sample on next page.) 
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16. If the preview is legible and depicts what is wanted to print, click Print Now. 
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17. If changes need to be made (such as the date range), click Print Options to modify 
the printout. 
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8.26.7- Customizing for a 22 x 34 Printout 

1. Select the File Tab. 

2. Click Print. 

3. Click Print Options.  
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• The Print dialog box displays. 
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4. Make sure the Printer box is selected and select the correct printer to print to. 

5. Select the Detail Tab. 

 

6. Click Browse to locate the correct border file to use. PennDOT has several standard 
border files starting with the title “PennDOT . . .” 
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7. Set Printer page size to Arch D or D size sheet. Select Landscape from the drop-
down box. 

 

8. If desired, set the Date Range. This is only relative to the bar chart. All activities 
within the spreadsheet will still print.  If nothing is set it, the range will include the 
entire project. 
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9. Select the Scaling Tab.  

 

10. Use the radio button to set Override horizontal (datezone) scale to Automatic.  

11. Use the radio button to set Horizontal pagination to Fit to at most . . . . Use the drop-
down box to select 1 page. This ensures that the spreadsheet and the bar chart are 
fitting horizontally on the same page. 
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12. Use the radio button to set the Vertical pagination to True size. 
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13. Click the Appearance Tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 8: Elecosoft Powerproject Client  Publication 615 

8-218 

14. Click the + next to Date zone. Make sure Locked to pages is selected. This ensures 
that when multiple pages are printed, the column headings and date zone are printed 
on all pages. 
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15. Click Close, a print preview displays. (See sample on next page.) 
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16. If the preview is legible and depicts what is wanted to print, click Print Now. 
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17. If changes need to be made (such as the date range), click Print Options to modify 
the printout. 
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8.26.8- Creating a Custom Sized Printout 

1. Select the File Tab. 

2. Click Print. 

3. Click Print Options.  
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• The Print dialog box displays. 

 

4. Make sure the Printer box is selected and select the correct printer to print to. 

5. Select Properties.  
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The Adobe PDF Document Properties dialog box displays. 

 

6. Select the Layout Tab. 

7. Click Advanced. 
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8. Use the drop-down box to set Paper Size to PostScript Custom Page Size. 
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9. Click Edit Custom Page Size to change the page size. The following dimensions are 
recommended for large projects.  

 

10. Continue to click OK until the Print dialog box returns. 

11. Select the Detail Tab. 

 



Chapter 8: Elecosoft Powerproject Client  Publication 615 

8-227 

12. Click Browse to locate the correct border file to use. PennDOT has several standard 
border files starting with the title “PennDOT . . .” 

13. Set Printer page size to PostScript Custom Size. Select Landscape from the drop-
down box. 

14. If desired, set the Date Range. This is only relative to the bar chart. All activities 
within the spreadsheet will still be shown.  If nothing is set it, the range will include 
the entire project. 
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15. Select the Scaling Tab.  

 

16. Use the radio button to set Override horizontal (datezone) scale to Automatic.  

17. Use the radio button to set Horizontal pagination to Fit to at most . . . . Use the drop-
down box to select 1 page. This ensures that the spreadsheet and the bar chart are 
fitting horizontally on the same page. 
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18. Use the radio button to set the Vertical pagination to True size. 
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19. Click the Appearance Tab. 
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20. Click the + next to Date zone. Make sure Locked to pages is selected. This ensures 
that when multiple pages are printed, the column headings and date zone are printed 
on all pages. 
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21. Click Close, a print preview displays. (See sample on next page.) 
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22. If the preview is legible and depicts what is wanted to print, click Print Now. 
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23. If changes need to be made (such as the date range), click Print Options to modify 
the printout. 
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CHAPTER 9 - ELECOSOFT POWERPROJECT BUSINESS 
INTELLIGENCE 

9.0- PURPOSE 

The main purpose of Elecosoft Powerproject Business Intelligence is to aide in the analysis of past data in 
order to help future data become more accurate.  Business Intelligence makes it possible for Project 
Managers to create professional looking reports that can be tailored and delivered quickly to project 
demands. 

The key benefits of Business Intelligence include: 

• Reports that are customized to PennDOT 
• The continuation of existing reports via Crystal Reports 
• Status of existing activities 
• Drill down capabilities which give Portfolio Managers and Project Managers the 

ability to analyze issues and quickly provide corrective actions 

All projects that are managed by the Elecosoft Powerproject Project Web Portal will be exported to the 
portal version of Elecosoft Powerproject Business Intelligence.
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CHAPTER 10 - ELECOSOFT POWERPROJECT PROJECT 
COMPARISON 

10.0- PURPOSE 

Elecosoft Powerproject Project Comparison is an add-on utility which allows users to compare two 
different projects and see the differences between them via a report.  The Project Comparison tool is 
decentralized in that it can be installed as needed by individual users along with their local copies of 
Elecosoft Powerproject.  Several options are available for the user to select prior to executing the 
comparison report: 

10.1- WORKING WITH PROJECT COMPARISON 

In order to set the tool up and compare projects, follow the instructions below: 

1. When first opening the comparison tool, users are presented with a simple menu 
which is the basis for creating a report group. 

 

2. Selecting File / Open allows the user to create a Report Group.  Report groups are 
used to allow users the capability of differentiating between individual projects, 
districts or enterprise wide. 
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3. Once a Report Group has been created, users can create reports (project comparisons) 

within that report group.  The “General” tab allows for naming, description and the 
location of the output file. 

 
 

4. The “Options” tab allows users to determine whether time units will be in days or 
hours and how to match the tasks.  Since PennDOT is using “Unique Task ID”, this 
will generally be the setting. 
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5. The “Base Project” tab allows the user to select the original project they would like to 
compare to.  This will be the project used so as the user can see what changed in the 
live project.

 
 

6. The “Revised Project” tab allows users to select the revised project they would like to 
compare to. 
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7. The “Scope” tab allows user to be specific as to what sections of a project they would 
like to compare.  Users may select individual branches of the hierarchy.  
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8. The “Components” tab lets users determine which attributes they would like to use 
for comparison. 

 

 
9. Once a user has gone through the report tabs, they can run the project comparison 

which will execute the report and place it where the user called for on the “Options” 
tab.  Typical data looks like the information below. 
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APPENDIX A- STANDARD REPORT ACTIVITIES 
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To facilitate standard reports, Table A-1 Standard Report Activities is a tabulation of task descriptions that shall be 
used in all design schedules. Changes or alterations (abbreviations, etc.), shall not be performed. The specific text 
and spacing that appears in this table shall be used. The activities below are consistent with the current PennDOT 
Master Design Schedule Template.   
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Table A-1 – Standard Report Activities 

Task Description. 
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Start Project                         x 
Consultant Services                         x 
Environmental Analysis                         x 
Perform Threatened and Endangered Species Coordination             x             
Cultural Resources             x             
Environmental Documentation             x x         x 
Section 4(f) Evaluations             x             
Environmental Clearance x               X         
Design Field View             x x X       x 
Surveys                         x 
Line & Grade                         x 
Safety Review                         x 
Submit Plans and Authorization to Utilities     x                     
Preliminary Pavement Design       x                   
Design Exceptions             x   X         
Erosion & Sedimentation Control Plan / NPDES x       x   x x         x 
Review & Submit Erosion and Sedimentation Control Plan         x                 
Review & Submit NPDES Permit Application         x                 
E&S Plan Approved x       x                 
NPDES Permit Approved x       x                 
Final Pavement Design and Preservation             x             
Final Pavement Design        x     x             
Pavement Preservation Package        x     X             
Pavement Design Approved        x     X             
Final Right-of-Way Plan Development x x         X         x x 
Perform Final ROW Plan Check                 X         
Final ROW Plan Approved x x                   x   
Right-of-Way Appraisal & Negotiation x x         X x       x x 
Perform Right-of-Way Appraisal   x         X             
Complete Appraisal   x                       
Review Appraisal   x                   x   
Perform Right-of-Way Negotiation   x                       
DT Requests to Central Office                       x   
File DT and Notify Condemnee                       x   
Request Just Compensation Funds   x                       
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Task Description. 

PD
O

C 

R
O

W
 

U
til

ity
 

Pa
ve

m
en

t 

Pe
rm

its
 

G
ra

de
 X

’
in

g 

Pr
oj

  T
rk

’
in

g 

Si
g 

Pr
oj

ec
ts 

H
Q

A
D

 

B
Q

A
D

 

C
D

A
S 

U
R

W
S 

LO
C

A
L 

Relocations Complete – Occupants Vacated   x                       
Request R/W Certificate                       x   
Issue Interim ROW Certificate   x                       
Issue Final ROW Certificate x x         X         x   
Waterway Permit Application x           X x   x     x 
Prepare Hydrologic and Hydraulic Report                         x 
H&H Report Approved                         x 
Joint Permit Application / 401 Water Quality Certificate         x               x 
Prepare Joint Permit Application / 401 Water Quality 
Certificate         x                 

Submit Final Joint Permit Application         x   X             
Joint Permit Application Approved         x               x 
GP XXX Permit Application         x                 
Prepare GP XXX Permit Application         x               x 
Submit GP XXX Permit Application         x   X             
Review / Approve GP XXX Permit Application 
(Agencies)                         x 

GP XXX Permit Application Approved         x               x 
Exx - 9999 Permit         x                 
Prepare and Submit Exx - 9999 Permit         x                 
Exx - 9999 Permit Approved         x                 
DEP Prepare and Submit USACE Permit         x                 
USACE Permit Approved         x                 
Structures                         x 
Type, Size & Location Development             X x         x 

Final TS&L Complete x                  
X       

Structure Foundation Development             X X           
Final Structure Foundation Report Approved          X    
Final Structure Design             X x           
Final Structure Plans Approved          X    
Perform Value Engineering / VEACTT             X   X         
Develop Final Utility Plan     x                 x x 
Obtain D-419 Utility Clearance x   x       X x       x x 
Utility Agreement Package Received from Utility - Final 
Design Phase (metric)     x                     

Utility Agreement Executed and Issued to (Utility)     x                     
Issue Utility Relocation Clearance D-419 (District)     x                     
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Task Description. 
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Issue Utility Relocation Clearance Certification (Central 
Office)     x                     

Perform Public Utility Commission Coordination             X         x   
Prepare Railroad Reimbursement Agreement (CON)           x               
File PUC Application           x           x   
Submit ROW Plan to PUC           x               
Issue PUC Secretarial Letter                       x   
Issue PUC Order                       x   
Submit Construction Plans to PUC           x               
Hold Final Plan Checks (BOPD)             X   X         
Final Design Office Meeting             X   X         
PS&E Package               x         x 
Perform QA of PS&E Package (District)             X       x     
Submit PS&E to Bureau of Project Delivery                     x     
Review PS&E (BOPD)             X             
Review PS&E (FHWA)             X             
PS&E Approved x                   x   x 
Advertise Project x           X x     x   x 
Open Bids                     x   x 
Project Re-Bid x           X x           
Award Contract x                         
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B.1 -  DESIGN SCHEDULE SETUP CHECKLIST 

 Create the new project using the Elecosoft Powerproject Web Portal.  (See Page 7-16) 

 Select the Business Partner Company associated with the project, or ‘None’ if it’s an in-house 
project. 

  The MPMS project number should be used as the project name for the project design schedule. 

  Select the Business Partner Project Manager from the drop down list. 

  Select a Progress Method, must be Site Progress if a Business Partner is associated with the project. 

  Select the PennDOT Project Manager from the drop down list. 

  Select the template that will be used to create the project from. 

  Enter an anticipated start date for the project. 

  Add any Notes associated with the project at a high level.  A description of the project should be 
included here which should include county, state route, section and local name. 

  Click Create. 

 Once the project is created, you then want to select operation and ‘Checkout’ the project to be able 
to create the actual schedule. (See Page 7-21) 

  Once the project is ‘Checked Out’, the project can be opened directly or saved on a computer. 

  The newly created project will need to be opened in Elecosoft Powerproject. (See Page 8-4) 

  Add tasks into the schedule by dragging and dropping from the Task Pools (See Page 8-61) 

  Add additional nonstandard or reoccurring tasks to the schedule if necessary. (See Page 8-27) 

  Assign an appropriate duration to all of the tasks in the schedule (See Page 8-31).  The only tasks 
that can have a zero duration are flagged milestone tasks. 

 Create the logic in the schedule (See Page 8-33).  All tasks (excluding summaries) must have a 
predecessor and a successor, the exceptions being the first task does not need a predecessor and last 
task does not need a successor.   

 Once the durations and logic are established in the schedule, run Reschedule Branch (See 8-40) 
with an appropriate constraint date set (See Page 8-46) for Project Start and Open Bids and review 
the start and finish dates of all tasks.   

 Once the project is created, it needs to be saved and checked in to the Web Portal (See Page 7-23). 

 Once the Project is Checked In to the Web Portal, it must be Submitted (See Page 7-25).   



Appendix B: Schedule Checklists  Publication 615 
 

B-2 
  

 The PENNDOT PM will then Download Latest (See Page 7-30) and review the schedule.  If any 
changes are needed, they will Reject the project in the Web Portal (See Page 7-26) and have the 
Consultant/PM Check Out the Project, open the Project in Elecosoft Powerproject, make changes, 
save the project, and Check In and Submit again.  If no changes are needed, the PennDOT PM will 
approve the Project in the Web Portal.   (See Page 7-26) 

 Once the project is approved, progress can be entered into the schedule via Site Progress in the 
Elecosoft Powerproject Web Portal (See Page 7-39) or Elecosoft Powerproject for in-house jobs not 
using Site Progress (See Page 8-99).  At a minimum, schedules must be updated once a month.  The 
Progress Date should be set to the first of the month.  All schedules must be progressed by the tenth 
of the month.   

 When a task is started, an actual start date must be entered. 

 When a task is in progress, “Remaining Duration” or “Percent Complete” must be used. 

 Once a task is completed, an actual finish date must be entered. 

 After the progress is submitted thru the Elecosoft Powerproject Web Portal, the PENNDOT PM 
will need to go into Elecosoft Powerproject Web Portal to review the progress and either approve 
(See Page 7-43) or reject the progress (See Page 7-45).  Once the progress is approved, it will 
automatically go into the Elecosoft Powerproject schedule. 

 Over the life of the project, if there is negative float in the schedule greater than or equal to fifteen 
days a schedule recovery plan is required.  This should include how you plan on making up the lost 
time or if the time cannot be made up it may require the let date to be moved.  If a schedule 
recovery plan is required, the recovery plan should be input in the Elecosoft Powerproject Web 
Portal in the Notes Field on the Edit Project Page. 

 If major changes need to be made to the schedule, other than progress, the PENNDOT Portfolio 
Manager or Project Manager, must change the status of the project within the Web Portal (See Page 
7-35) to “Checked In” (Changing the status of the project is only required if Site Progress is the 
method in which a project is being progressed).  The Consultant or PennDOT Project Manager will 
then have the ability to Check Out the schedule from the Elecosoft Powerproject Web Portal, save 
the file, open the file in Elecosoft Powerproject, make the necessary changes, save the file, check 
back in the file, and submit the new schedule.  Once the PennDOT Project Manager reviews the 
new schedule, it will need to be approved again.  
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B.2 - PRE-BID SCHEDULE CHECKLIST 

Please log into PPCC (https://ppcc.penndot.gov) select the Reference tab.  Once on the Reference tab, 
select the Central Office file folder, then the Construction Schedule Review folder and select the file 
named “PreBid Schedule Checklist.” 
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C.1- INTRODUCTION 

While Elecosoft Powerproject views can facilitate a lot of the Department’s reporting needs it may be 
easier to create a Crystal Report when the reporting need requires pulling data from multiple sources.  
Crystal Reports is the Department’s official software for generating reports.  Crystal Reports pulls data 
from the Elecosoft Powerproject BI data source to create user defined reports.  There are two ways of 
using Crystal Reports:  the client software and the enterprise version. 

C.2- CLIENT SOFTWARE 

The client software is installed on a PC and used to create standalone Crystal Reports and Enterprise 
Reports.  The data structure of the Elecosoft Powerproject software can be very confusing for a user 
trying to create a report.  Therefore, if a District needs assistance creating a Crystal Report using 
Elecosoft Powerproject data they can contact Central Office.  However, if the District chooses to create 
their own reports they can reference the System Data contained in this appendix to locate the appropriate 
tables and fields within Elecosoft Powerproject to create their Crystal Reports. 

C.3- ENTERPRISE 

This intranet based system contains Crystal Reports that have already been developed by Central Office.  
These reports have various parameters that are used to refresh the reports based on current Elecosoft 
Powerproject data.  All of the Elecosoft Powerproject reports can be found in the Elecosoft Powerproject 
folder under Public Folders.  Central Office is responsible for uploading Crystal Reports to this folder but 
District users with the appropriate security level can run the reports located here at their discretion.   The 
Elecosoft Powerproject folder contains a multitude of reports and new reports are added regularly.   

C.4- ELECOSOFT POWERPROJECT REPORTS 

Central Office runs multiple reports on a regular basis.  There are two main reports that individuals within 
Central Office and the Districts are getting measured on, the Project Delivery Operation Center (PDOC) 
Wall Charts and Projects of Significance Report. 

C.4.1-  PDOC Wall Charts 

The PDOC wall charts form the basis for the Department’s weekly Project Delivery Operations 
Center meetings.  

Rather than being accessed through Crystal Reports / Business Objects, PDOC charts are 
accessed through PDIF, the PennDOT Data Integration Facility. Access to PDIF can be requested 
by contacting the ECMS help desk at 717-783-7711. Once access has been granted, the PDOC 
reports can be accessed using the following procedure. 

To Access the PDOC Wall Chart Report: 

1. Log onto PDIF at http://pdif.pdot.state.pa.us/PDIF_Home.aspx. 
 

2. Click on ARRA. 

http://pdif.pdot.state.pa.us/PDIF_Home.aspx
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3. Click on Report. 
 

4. From the dropdown menus, select Project Delivery, then Design. 
 

5. From the list of reports select ARRA045 – ARRA District Projects Timeline - Chart. 

The PDOC chart is a combination of data pulled from MPMS, ECMS, and Elecosoft 
Powerproject. PDOC charts have several color-coded columns – Let Date, Description, Milestone 
Activities, and Float – and each has a separate color coding scheme. These schemes are outlined 
in the tables below. 

Table C.1- PDOC Chart, Let Date color coding 

Let Date Column Color Description 

Green  The project was let and the ECMS Actual Bid Date is within 30 days of 
the ECMS committed Bid Date. 

Red 
This is a miss.  The Elecosoft Powerproject Open Bids Date is more than 
30 days past the ECMS committed Bid Date and the current date the 
report was run on is 30 days past the ECMS Committed Bid Date. 

Blue The Elecosoft Powerproject Open Bids Date is before the ECMS 
Committed Bid Date and the project has not been let yet. 

Yellow The Elecosoft Powerproject Open Bids Date was moved from its original 
ECMS Committed Bid Date, but is still within 30 days. 

Red/Yellow Stripes 

This is an anticipated miss.  The Elecosoft Powerproject Open Bids Date 
is more than 30 dates past the ECMS Committed Bid Date and the ECMS 
Committed Bid Date is still within 30 days of the current date that the 
report was run on. 

White The Elecosoft Powerproject Open Bids Date is equal to the ECMS 
Committed Bid Date and the date is in the future. 

 
Table C.2- PDOC Chart, Project Description color coding 

Description Column Color Description 
White The project is more than three weeks away from being advertised. 
Yellow The project is to be advertised within three weeks. 

Red The project has missed the ECMS or Elecosoft Powerproject 
Advertisement Date. 

Light Green The project is Advertised, but not Bid. 
Green The project has been Bid. 
Light Orange Notice to Proceed has been issued. 
Light Blue Physical Work is Complete 
Purple Project is not in ECMS, or is a Department Force project 

 

Table C.3- PDOC Chart, Project Milestone color coding 
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Project Milestone Color Description 
White Elecosoft Powerproject Late Start/Finish dates are in the future. 
Yellow Elecosoft Powerproject Late Start date has been missed 
Red Elecosoft Powerproject Late Finish date has been missed 
Green Elecosoft Powerproject Actual Start or Actual Finish Dates are entered 

Green w/ Red Outline Elecosoft Powerproject Actual Start or Actual Finish dates are entered, 
but the Actual Start or Actual Finish dates fall after the Baseline date. 

 
Table C.4- PDOC Chart, Float color coding 

Float Color Description 
Green Project has less than 15 days of negative float. 
Red Project has equal to or greater than 15 days of negative float. 

 

C.4.2- Projects of Significance Report 

The Projects of Significance Report is used for projects that are of high importance to the 
Department to track key milestone dates to ensure the projects are let on time.  

To Access the Projects of Significance Report: 

1. Log onto Business Objects at http://pdprodsapbi.penndot.lcl:8080/BOE/BI 
 

2. Type your CWOPA User Name and Password. 
 

3. Click on Log On. 
 

4. Click on Document List Folder. 
 

5. Click the + next to Public Folders. 
 

6. Click the + next to Elecosoft Powerproject. 
 

7. Click the + next to BOD. 
 

8. Click the + next to PSSCS Project Tracking Reports. 
 

9. Click on Significant Projects Tracking Reports Folder. 
 

10. Double-click the district report to be opened. 
 
On the report, the ECMS Committed Let Date is black, if this date is not equal to the MPMS 
Let Date and Date will show up in red.   
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The MPMS Actual Date is black, the MPMS estimated Let Date is green, and if the MPMS 
estimated Let Date is passed, the date will show up in red. 
 
The Approved Construction Cost is red if the difference is greater than 15% of the 
Construction Estimated Cost. 
 
The top dates on the report are the baseline finish dates.  The second line of dates is either the 
actual start date or the early start date.  The third line of dates is either the actual finish date or 
the early finish date.  The actual dates are black and the early dates are in green.  If the early 
dates are passed, and no actual date is entered, the early dates will show up in red. 
 
The total float is red if it is less than or equal to negative fifteen (-15) days. 
 
The data date is when the schedule was last updated.  The data date is red if the difference 
from the data run date is less than negative four (-4) weeks. 
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Bar  

Horizontal area on the spread sheet and Bar Chart containing information about a task.  

Bar Chart  

The area of the screen where tasks can be viewed graphically. 

Baseline  
 
A complete copy of the project recorded at a stage in time. Elecosoft Powerproject can record and display 
multiple baselines allowing for: tracking of major changes; production of what-if scenarios; comparison 
of information (e.g. budget cost to actual cost) 
 
Border File  

A print function which contains information to be included in printouts, including graphics such as 
company logo, project information such as the project title and relevant dates.  

Buffer  
 
A Task that is used to collect float and protect the Critical Path through the project. It achieves this by 
having its duration dynamic which increases or decreases in response to project changes. 

Code (Color)  

A facility to allow the assignment of colors to tasks to represent information about the task. 

Code Library  

This is the library (or folder) that contains Codes, allowing you to have multiple ‘categories’ of codes 

Constraint (Flags)  

These are used to enforce dates when a Task can happen (stopping a task starting before a certain date, or 
stopping a task finishing after a certain date). Using Constraint Flags within the project can have a major 
effect on your Critical Path 

Control Key (CTRL)   

A key on the key board normally found at the bottom left (and one on the right) used throughout windows 
applications for either commands (e.g. CTRL + S for saving) or for selective highlighting. (To highlight 
everything that is clicked upon whilst the key is held down) 

Critical Path  

This is shown as a red outline on Task and all Links showing red, the critical path means that this is the 
most important route through the project. If any of the items on the critical path are changed in anyway 
(durations or positions of) then the end date of the project will change, becoming earlier, or later 
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Date Zero   

Normally at the start of the project, but can be moved without affecting the project. Date Zero is the point 
where week -1 meets week 1 (so allowing you to make your project ‘start’ in week -10) 

Date Zone  

This is the area above your project that contains rulers of information (e.g. week numbers, week start). 

Exceptions  

These are time periods that are different to the usual work week, e.g. holidays, working etc. 

Expanded  
 
This type of task is very similar with Summary tasks, in that it is used to group together Tasks within the 
project, but rather than have them on screen with itself like the Summary task, the content is actually held 
off chart in its own chart (or Sub Chart as it is commonly known) 

Filter  

This is a tool that will leave on screen only those items that meet a particular criteria, for example all the 
items that a particular contractor is doing (Code based filtering) or you want to see everything but only 
during a 6 week period (time based filtering) even to show only those items that have been completed 
(Progress based filtering) 

Float  

This appears on items that are not on the Critical Path. Float is the amount of time a Task may be delayed 
or extended before the item rejoins the critical path and pushes out the end date of the project. See Total 
Float and Free Float for more information 

Free Float  

This is one of the two types of Float; Free float means that if the task is extended or delayed in anyway 
during its period of float only this item is affected, nothing else will move. 

Lag (Links)   

Waiting time that is shown as the horizontal part on a Link (e.g. Concrete curing time, paint drying time 
or just delivery times). 

Library Explorer   

This is another main area of the software, It is inside of here that certain items are created (Cost Centers, 
Calendars, Codes, Permanent Resources to name but a few) But also certain settings can be changes in 
here as well ( the exception colors, link colors, working in pounds or Euros)  
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Link  

This is an arrow going between two items, representing the logical path through the project. Where one 
Task can start before another one. If shown in red then the link is Critical. 

Mid-link  

The software supports 4 major types of Links and a mid-link is one of those four with some setting to it so 
it allows it to be drawn almost anywhere along the task rather than from (or to) the start or end of the Task 

Milestones  

Milestones are points in time; they have no duration of their own (0 days) and are used to represent key 
events within projects. (E.g. Handover) 

Progress Period 

Progress is the method used to mark up the project so it is easy to know whether the project is in front or 
behind. A progress period is the reporting date, shown as a line going down the screen, and it will bend to 
the left to show items behind time and bend to the right to show items ahead of time.  

Project View   

This white window that opens on the left hand side of the screen is used to navigate around the project, or 
to assign items into the project like Code Libraries, Cost Centers, Permanent Resources, Consumable 
Resources and Calendars. 

Shift Key (or a bold arrow pointing up)   

A key on either side of the keyboard, used for creating capital letters, to pick up any of the top row of 
symbols on the numerical keys and others. Also used to highlight a range of items, (Left-click on one 
item, then hold down shift and select another item. Everything in between becomes highlighted.) Also 
used for creating Lag links. 

Sort   
Unlike a filter that temporarily removes items off the screen, a sort will leave all Tasks on screen, but will 
reorder them according to criteria that have been set. For example, rather than the program showing the 
Tasks in time order (earliest task first as most programs are created) the project could be told to group 
together all the Tasks according to the Code that has been assigned to it  

Spreadsheet  

This is the yellow and white stripped table down the left hand side of the screen (assuming the Project 
View is closed) the Spreadsheet is made up of different columns and these columns can be removed, 
added or even moved around. The software supports a large number of these columns      
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Summary  

This is an item that groups together Tasks on screen under its own task. Items are grouped because they 
share certain information, for example, summaries could be used to group together all the Tasks on 
different floors. A Summary could also be used to show different phases or even stages within a project. 
Summaries can be placed inside of each other allowing a project structure or hierarchy to be created 
(Three different buildings, broken up into 4 different floors – so 3 main summaries each containing 4 
more summaries inside of them)    

Task  

The activities or ‘blocks’ that appear within a Bar on the Bar Chart. 

Template  

A template is a file that is used when creating a project from new. This particular file will already contain 
items needed in the project. So a template could already have Calendars, Permanent Resources, Cost 
Centers, Code Libraries it could even have titles in the Spreadsheet and Tasks in the Bar Chart.      

Total Float  

This is one of the two types of Float. Total float means that if the task is extended or delayed in anyway 
during its period of float, then all items directly after it (those containing Float) will also be affected as 
well. 

UDF 
 
User Defined Fields – the software already has a large range of columns that can be used in the 
Spreadsheet but every column has a use. UDF’s are columns created by the user for whatever purpose, 
whether it is for recording delivery Notes, delay Notes or even to have a tick box to say whether or not a 
health and safety check has been done. 

View    

A view is the method used for the software to remember screen settings. When saved the ‘view’ will 
remember if the Project View is opened or closed, it will remember the current column configuration 
within the Spreadsheet. It will also remember the current settings of the Bar Chart, also the Date Zone and 
finally whether there are any Filters or Sorts running within the program. Putting all of this together a 
view is the ability to change all of these settings to a predefined set by only doing one click of the mouse. 
The software can have unlimited number of views saved.
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